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1 Preface

1.1 About this Manual

This User Manual is a supplement to the user manual for the base unit and provides all
the information specific to the Fading Simulator. All general instrument functions and
settings common to all applications and operating modes are described in the main
R&S SMW User Manual.

The main focus in this manual is on the provided settings and the tasks required to
generate a signal. The following topics are included:
● Welcome to the Fading Simulator R&S SMW-B14/-K71/-K72/-K74/-K75

Introduction to and getting familiar with the option
● About the Fading Simulator

Background information on basic terms and principles in the context of the signal
generation

● Configuration and Settings
A concise description of all functions and settings available to configure the signal
generation with their corresponding remote control command; the description is
divided into several sections:
– Fading Settings
– Signal Routing (non-MIMO) Settings
– Multiple Input Multiple Output (MIMO)
– Summation Ratio A/B

● Remote Control Commands
Remote commands required to configure and perform signal generation in a
remote environment, sorted by tasks
(Commands required to set up the instrument or to perform common tasks on the
instrument are provided in the main R&S SMW User Manual)
Programming examples demonstrate the use of many commands and can usually
be executed directly for test purposes

● Annex
Reference material

● List of remote commands
Alphabetical list of all remote commands described in the manual

● Index

1.2 Documentation Overview

The user documentation for the R&S SMW consists of the following parts:
● Getting started, printed manual
● Online help system on the instrument, incl. tutorials

 

 

 

Documentation Overview
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● User manuals and online manual, see the product page
● Service manual, provided on the internet for registrated users
● Instrument security procedures, see the product page
● General safety instructions, printed brochure
● Release notes, see the product page (download > firmware)
● Data sheet and brochures, see the product page (download > brochures and data

sheets)
● Application notes, provided on the internet

You find the user documentation on the R&S SMW product page mainly at:
http://www.rohde-schwarz.com/product/SMW200A.html > "Downloads" > "Manuals"
Additional download paths are stated directly in the following abstracts of the docu-
mentation types.

Getting Started

Introduces the R&S SMW and describes how to set up and start working with the prod-
uct. Includes basic operations, typical measurement examples, and general informa-
tion, e.g. safety instructions, etc.

Online Help and Tutorials

The online help offers quick, context-sensitive access to the information needed for
operation and programming. It contains the description for the base unit and the soft-
ware options.

The tutorials offer guided examples and demonstrations on operating the R&S SMW.

User Manual and Online Manual

Separate manuals are provided for the base unit and the software options:
● Base unit manual

Contains the description of the graphical user interface, an introduction to remote
control, the description of all SCPI remote control commands, programming exam-
ples, and information on maintenance, instrument interfaces and error messages.
Includes the contents of the getting started manual.

● Software option manuals
Describe the specific functions of an option. Basic information on operating the
R&S SMW is not included.

The online manual provides the contents of the user manual for immediate display on
the internet.

Service Manual

Describes the performance test for checking the rated specifications, module replace-
ment and repair, firmware update, troubleshooting and fault elimination, and contains
mechanical drawings and spare part lists.

Documentation Overview

http://www.rohde-schwarz.com/product/SMW200A.html
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The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS).

Instrument Security Procedures

Deals with security issues when working with the R&S SMW in secure areas.

Data Sheets and Brochures

The data sheet contains the technical specifications of the R&S SMW. Brochures pro-
vide an overview of the instrument and deal with the specific characteristics, see http://
www.rohde-schwarz.com/product/SMW200A.html > "Download" > "Brochures and
Data Sheets".

General Safety Instructions

Contains basic safety instructions in English, Spanish, German and French.

Release Notes

Describes the firmware installation, new and modified features and fixed issues
according to the current firmware version. You find the latest version at:

http://www.rohde-schwarz.com/product/SMW200A.html > "Downloads" > "Firmware"

Application Notes, Application Cards, White Papers, etc.

These documents deal with special applications or background information on particu-
lar topics, see http://www.rohde-schwarz.com/appnotes.

1.3 Conventions Used in the Documentation

1.3.1 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as
dialog boxes, menus, options, buttons, and softkeys are enclosed by
quotation marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

 

 

Conventions Used in the Documentation
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Convention Description

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.

1.3.2 Conventions for Procedure Descriptions

When describing how to operate the instrument, several alternative methods may be
available to perform the same task. In this case, the procedure using the touchscreen
is described. Any elements that can be activated by touching can also be clicked using
an additionally connected mouse. The alternative procedure using the keys on the
instrument or the on-screen keyboard is only described if it deviates from the standard
operating procedures.

The term "select" may refer to any of the described methods, i.e. using a finger on the
touchscreen, a mouse pointer in the display, or a key on the instrument or on a key-
board.

1.3.3 Notes on Screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as much as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic test situations.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

 

 

Conventions Used in the Documentation
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2 Welcome to the Fading Simulator
The hardware option R&S SMW-B14 in combination with the firmware applications
R&S SMW-K71/-K72/-K74/-K75/-K76 add functionality to simulate fading propagation
conditions.

The most important R&S SMW-B14/-K71/-K72/-K74/-K75/-K76 features at a glance:
● Simulation of real time fading conditions in SISO and MIMO modes.
● Main characteristics in SISO mode:

– Maximal bandwidth Bmax = 160 MHz

– Up to 20 dynamic fading paths in SISO mode in two independent channels
● Support of versatile MIMO configurations, like 2x2, 2x8 and 4x4 MIMO channels

with up to 32 MIMO channels
Main characteristics of the 4x4 MIMO mode:
– 20 paths per MIMO channel
– Sampling rate in 4x4 MIMO mode fSys = 100 MHz

– Maximal bandwidth up to Bmax = 160 MHz, depending on the MIMO mode

● Simulation of multiple entity MIMO scenarios, like 4x2x2 MIMO or 8xSISO (8x1x1)
configurations

● A wide range of presets based on the test specifications of the major mobile radio
standards

● Realistic simulation of frequency hopping conditions
● Graphical presentation of the defined fading paths

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMW user manual. The latest version is available at the
R&S SMW product page >"Downloads" > "Manuals".

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMW Service Manual.

2.1 Accessing the Fading Simulator

To access and configure the "Fading Simulator" settings

► In the block diagram of the R&S SMW, select "Fading > Fading Settings".

A dialog box opens that display the provided general settings.

 

 

Accessing the Fading Simulator

http://www.rohde-schwarz.com/product/SMW200A.html
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The signal generation is not started immediately. To start signal generation with the
default settings, select "Fading > State > On".

For information, see:
● Chapter 3, "About the Fading Simulator", on page 17
● Chapter 4, "Fading Settings", on page 24
● Chapter 5, "Signal Routing (non-MIMO) Settings", on page 81
● Chapter 6, "Multiple Input Multiple Output (MIMO)", on page 84
● Chapter 7, "Summation Ratio A/B", on page 115

2.2 Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, this includes:
● Managing settings and data lists, like storing and loading settings, creating and

accessing data lists, or accessing files in a particular directory.
● Information on regular trigger, marker and clock signals, and filter settings, if appro-

priate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMW user manual.

 

Scope
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3 About the Fading Simulator
Equipped with the required options, the R&S SMW allows you to superimpose real
time fading on the baseband signal at the output of the baseband block. When fitted
with all of the possible options, available are up to 20 fading paths in SISO mode as
well as per MIMO channel in 4x4 MIMO mode.

3.1 Required Options

The equipment layout for simulating fading effects in non-MIMO configurations:
● option Baseband Generator (R&S SMW-B10) per signal path
● option Baseband main module, one/two I/Q paths to RF (R&S SMW-B13/B13T)
● option Fading Simulator (R&S SMW-B14) per signal path

(sufficient for simulation of fading paths with standard delay and paths with
enhanced resolution)

● additional options that extend the fading functionality:
– option Dynamic Fading (R&S SMW-K71) per signal path

(required for the simulation of dynamic fading conditions, like birth death propa-
gation, moving propagation, two channel interferes and high speed train condi-
tions)

– option Extended statistic functions (R&S SMW-K72) per signal path
(required for additional fading profiles and some of the predefined test scenar-
ios)

Refer to the instrument's specifications for more information.

The equipment layout for simulating fading effects in MIMO configurations:
● two options Baseband Generator (R&S SMW-B10)
● option two I/Q paths to RF (R&S SMW-B13T)
● at least two options Fading Simulator (R&S SMW-B14)
● option MIMO Fading (R&S SMW-K74)

(required for the configuration of MIMO scenarios, like 1x2x8 or 1x4x4 scenarios)
● option Higher Oreder MIMO (R&S SMW-K75)

(required for the configuration of higher order MIMO scenarios, like 4x2x2)
● option Multiple Entities (R&S SMW-K76)

(required for the configurations with more than two entities, like 8x1x1 sceanrios)

Refer to the instrument's specifications for more information.

 

 

Required Options
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3.2 Overview of the Functions Provided by the Fading
Simulator

This section summarizes the key functions of the fading simulator to emphasize the
way it is suitable for test setups during research, development, and quality assurance
involving mobile radio equipment.

Flexible configuration for support of different test scenarios

You can use the provided fading channels and configure them differently for different
test scenarios. Use the same input signal and two separate output signals, for exam-
ple, to simulate a frequency diversity. Or use separate input signals and sum them
after fading, to simulate a network handover, for instance.

See also Chapter 5, "Signal Routing (non-MIMO) Settings", on page 81.

Predefined fading scenarios

The fading simulator is equipped with a wide range of presets based on the test speci-
fications of the major mobile radio standards. For more complex tests, all of the param-
eters of the supplied fading configurations can be user-defined as required.

See also "Standard / Test Case" on page 27.

Repeatable test conditions

To ensure the repeatability of the tests, the fading process is always initiated from a
defined starting point.

See also Chapter 4.2, "Restart Settings", on page 34.

Realistic simulation of frequency hopping conditions

Frequency hopping which builds upon the prior fading process after a frequency hop
allows realistic simulation of frequency hopping conditions.

See also "Freq. Hopping Mode" on page 33

Graphical presentation

The path graph displays the current defined fading paths and supports you to configure
the desired fading channel.

See also Chapter 4.5, "Path Graph", on page 51.

Simulation of diverse fading effects

During transmission of a signal from the transmitter to the receivers, diverse fading
effects occur. In the fading simulator, you can simulate these effects separately or in
combination.

Using the provided fading configurations for example, you can define up to 20 fading
paths with different delays as they would occur on a transmission channel due to differ-
ent propagation paths.

 

Overview of the Functions Provided by the Fading Simulator
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See also Chapter 4.4, "Path Table", on page 40.

Predefined fast fading profile for different fading scenarios

The fading simulator provides a wide range of fast fading profiles. You can define the
fading conditions per generated fading path. The fast fading profiles simulate fast fluc-
tuations of the signal power level which arise due to variation between constructive and
destructive interference during multipath propagation.

See also "Configuration" on page 27 and "Profile" on page 44

Simulation of slow fading effect

"Lognormal" and "Suzuki Fading" are slow fading profiles suitable to simulate slow
level changes which can occur, due to shadowing effects (for example tunnels, build-
ings blocks, hills etc.).

See also Chapter 4.4, "Path Table", on page 40.

Simulation of dynamic configurations

Delay variations (whether sudden or slow) do not become important until we reach the
fast modulation standards, such as the 3GPP FDD or EUTRA/LTE standards. The
delay variations start to play a role if they are on the order of magnitude of the transmit-
ted symbols so that transmission errors can arise.

The provided dynamic configurations simulate dynamic propagation in conformity with
test cases defined in the 3GPP and MediaFlo specifications.

See also:
● Chapter 4.6, "Birth Death Propagation", on page 52
● Chapter 4.7, "Moving Propagation", on page 57
● Chapter 4.9, "High Speed Train", on page 72
● Chapter 4.8, "Two Channel Interferer", on page 65

Insertion loss for correct drive at the baseband level

The insertion loss is a method to provide a drive reserve and to keep the output power
constant. In the R&S SMW, the used insertion loss is not a fixed value but is dynami-
cally adjusted for different measurement tasks, i.e. you can define the way the range
for insertion loss is determined.

See also Chapter 4.3, "Insertion Loss Configuration, Coupled Parameters and Global
Fader Coupling", on page 35.

Support of versatile MIMO configurations

See also Chapter 6, "Multiple Input Multiple Output (MIMO)", on page 84.

Overview of the Functions Provided by the Fading Simulator
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3.3 Definition of Commonly Used Terms

Fading Simulator

Each option R&S SMW-B14 provides the hardware of one fading simulator, i.e. for
each installed fading simulator option, one hardware FADER board is available. One,
two or four fading simulators can be installed. The provided fading functionality, how-
ever, depends on the installed firmware options.

Fading channel

A fading channel is the term describing the signal between a transmit (Tx) and a
receive (Rx) antenna, scattered in various paths.

In a 2x2 MIMO fading configuration, there are four fading channels between the trans-
mit (Tx) and the receive (Rx) antennas. In this description, each fading channel is rep-
resent as a block with name following the naming convention "F<Tx><Rx>", where Tx and
Rx are the antennas (e.g. A and B in a 2x2 MIMO configuration).

An instrument equipped with the R&S SMW-K74 option can simulates up to 16 MIMO
fading channels, as it is for instance required for 4x4 MIMO receiver tests.

If the option R&S SMW-K75 is installed, the number of MIMO channels increases to
32.

Fading path (tap)

Each fading channel consists of up to 20 fading paths.

The Figure 3-1 illustrates an example of single-channel fading with three transmission
paths.

 

Definition of Commonly Used Terms
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Figure 3-1: Example of single-channel fading with three transmission paths (SISO configuration)

Path 1 = represents the discrete component, that is a direct line-of-sight (LOS) transmission between
the transmitter and receiver (pure Doppler fading profile)

Paths 2 and 3 = represent the distributed components, that is signals which are scattered due to obstacles
(Rayleigh fading profile)

Distributed components, like the paths 2 and 3, consists of several signal echoes and
are referred to as "taps".

The Figure 3-2 illustrates an example of two-channel fading with three transmission
paths (taps) per channel.

Figure 3-2: Example of two-channel fading with three transmission paths each

The R&S SMW supports 20 fading paths per installed fading simulator.

Path group

In this implementation, a group of paths builds a "path group".

Definition of Commonly Used Terms
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In the R&S SMW, the 20 fading paths are divided in 4 path groups. Each group con-
sists of 3 fine delay and 2 standard delay paths.

Fading Profile

The fading profile determines which transmission path or which radio hop is simulated.

The following is a list of the basic fading profiles implemented in the Fading Simulator.
● Static Path

A static path is an unfaded signal, that is a signal with constant amplitude and no
Doppler shift; though this signal can undergo attenuation (loss) or delay.

● Constant Phase
A suitable fading profile to simulate a reflection of an obstacle. Simulated is a
transmission signal with constant amplitude and no Doppler shift, but with rotating
phase.

● Pure Doppler
A fading profile that simulates a direct transmission path on which Doppler shift is
occurring due to movement of the receiver.
See Path 1 on the Figure 3-1.

● Rayleigh
A suitable fading profile to simulate a radio hop which arises as a result of scatter
caused by obstacles in the signal path, like buildings, etc.
See also the conditions of the Paths 2 and 3 on the Figure 3-1.
The resulting received amplitude varies over time. The probability density function
for the magnitude of the received amplitude is characterized by a Rayleigh distribu-
tion. This fading spectrum is "Classical".

● Rice
A fading profile that simulates a Rayleigh radio hop along with a strong direct sig-
nal, i.e. applies a combination of distributed and discrete components (see Fig-
ure 3-1).
The probability density of the magnitude of the received amplitude is characterized
by a Rice distribution. The fading spectrum of an unmodulated signal involves the
superimposition of the classic Doppler spectrum (Rayleigh) with a discrete spectral
line (pure Doppler).
The ratio of the power of the two components (Rayleigh and pure Doppler) is con-
figurable, see parameter Power Ratio.
Example: The Figure 3-3 shows a baseband signal with QPSK modulation and a
rectangular filter which was subjected to Rician fading (one path). As a result of the
luminescence setting on the oscilloscope, the variation in phase and amplitude of
the constellation points caused by the fader is clearly visible.

Definition of Commonly Used Terms
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Figure 3-3: Effect of a Rician fading on a baseband signal with QPSK modulation

MIMO correlation models

The R&S SMW supports the following ways to simulate spatial correlated MIMO chan-
nels:
● by description of transmit and receive correlation matrix with direct definition of

matrix coefficients or based on the Kronecker assumption
● by definition of clusters at the transmitter and receiver side using channel parame-

ter like angle spread, angle of arrival/departure (AoA/AoD), etc.

See Chapter 6.3, "Fading Settings in MIMO Configuration", on page 87

3.4 Further Signal Processing

During further signal routing, you can additionally offset the faded signals or apply
noise to them.

For more information, refer to sections "Adding Noise to the Signal" and "Impairing the
Signal" in the R&S SMW User Manual.

 

Further Signal Processing
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4 Fading Settings
The "Fading" dialog allows you to configure multipath fading signals. Regardless of the
current "System Configuration > Mode", to access this dialog, proceed as follows:

► Select "Block Diagram > Fading > Fading Settings".

The "Fading" dialog opens and displays the general settings.

The dialog is divided into several tabs, logically grouping the available setting.

The remote commands required to define these settings are described in Chapter 8,
"Remote-Control Commands", on page 116.

The provided settings and related background information are described in:

● General Settings..................................................................................................... 25
● Restart Settings.......................................................................................................34
● Insertion Loss Configuration, Coupled Parameters and Global Fader Coupling.... 35
● Path Table...............................................................................................................40
● Path Graph..............................................................................................................51
● Birth Death Propagation..........................................................................................52
● Moving Propagation................................................................................................ 57
● Two Channel Interferer........................................................................................... 65
● High Speed Train.................................................................................................... 72
● Custom Fading Profile.............................................................................................78
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4.1 General Settings

► To access this dialog, select the "Fading > Fading Settings".

Apart from the standard "Set to Default" and "Save/Recall" functions, the dialog
provides the settings to:
● In "System Configurations" with more than two entities, the dialog consists of

more than one side tabs; one tab per entity. The tab name indicates the fader
state the settings are related to.
See also Chapter 6.1, "Multiple Entity MxN MIMO Test Configurations",
on page 85.

● Select a predefined fading profile according to the common mobile radio stand-
ards

● In instruments with RF output, activate and configure a frequency hopping.

State
Powers the fading simulator on or off.

When powered on, the fading process is initiated for the paths which are switched on.

A selectable trigger ("Restart Event") can be used to restart the fading process. The
fading process always begins at a fixed starting point after each restart. This helps to
achieve repeatable test conditions.

Remote command: 
[:SOURce<hw>]:FSIMulator[:STATe] on page 134

Copy To / Entity
(requires option R&S SMW-K76)

In "System Configurations" with multiple entities, copies the settings of the current fad-
ing simulator to all or to the selected entities.

See also Chapter 6.1, "Multiple Entity MxN MIMO Test Configurations", on page 85.

 

General Settings
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Remote command: 
[:SOURce<hw>]:FSIMulator:SISO:COPY on page 119

Set to Default
Activates the default settings of the fading simulator.

By default, a path is activated with a Rayleigh profile and a slow speed. All the other
paths are switched off.

The following table provides an overview of the settings. The preset value is indicated
for each parameter in the description of the remote-control commands.
Table 4-1: Default values

Parameter Value

State Off

Standard User

Configuration Standard Delay

Signal Dedicated to RF Output

Speed Unit km/h

Restart Event Auto

Ignore RF Changes Off

Frequency Hop. Mode Off

Insertion Loss  

Insertion Loss Mode Normal

Coupled Parameters  

All States Off

Path Configuration  

State of path 1 On

State of all other paths Off

Profile Rayleigh

Delays 0

Speed of path 1 Slow

Speed of all other paths 0

Remote command: 
[:SOURce<hw>]:FSIMulator:PRESet on page 123

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for storing
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.

The file name and the directory, in which the settings are stored, are user-definable;
the file extension is however predefined.

General Settings
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See also, chapter "File and Data Management" in the R&S SMW user manual.

The R&S SMW stores fading configurations in files with file extension *.fad.

The dialog displays the name of a currently loaded user settings file. The file name is
displayed as long as you do not modify the settings.

Remote command: 
[:SOURce]:FSIMulator:CATalog? on page 135
[:SOURce<hw>]:FSIMulator:LOAD on page 135
[:SOURce<hw>]:FSIMulator:STORe on page 136
[:SOURce]:FSIMulator:DELETE on page 136

Standard / Test Case
Selects predefined fading settings according to the test scenarios stipulated in the
common mobile radio standards.

For an overview of the predefined standards along with the underlying test scenarios
and the enabled settings, see Chapter A, "Predefined Fading Settings", on page 188.

If one of the predefined parameters is modified, "User" is displayed. "User" is also the
default setting.

Remote command: 
[:SOURce<hw>]:FSIMulator:STANdard on page 128
[:SOURce<hw>]:FSIMulator:STANdard:REFerence on page 134

Configuration
Selects the fading configuration.

Note: The dynamic fading configurations "Birth Death Propagation", and "2 Channel
Interferer" are disabled in MIMO configurations.
Depending on which configuration is selected, the further settings the "Fading" dialog
change, particularly the path table.

Note: A separate path table is associated with each configuration, i.e. each time you
select a new configuration, the instrument changes not only the bandwidth but loads a
completely new path table.
Each changing in the configuration interrupts the fading process and restarts the calcu-
lation. If the instrument is fitted with more than one fading simulators, they are all affec-
ted.

General Settings
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"Standard/Fine Delay"
In the "Standard/Fine Delay" configuration, each group consists of
five paths, 3 fine delay and 2 standard delay paths. This means that
20 paths can be simulated for a fading channel.

The standard and fine delay configurations differ in terms of the reso-
lution of the path-specific delay:
● The resolution of the additional delay of a standard pat is 5 ns.
● The resolution of the additional delay of a fine delay pat is 2.5 ps.
The "Standard/Fine Delay" configuration is sufficient for classical fad-
ing with simulation of the level fluctuations. A delay configuration with
the provided characteristics occurs in the received signal as a result
of a typical multipath propagation and the propagation conditions,
which vary depending on the location and timing.

"Birth Death Propagation"
In the "Birth Death Propagation" configuration, the fading simulator
simulates dynamic propagation conditions in conformity with the test
case 3GPP, 25.104-320, annex B4. Two paths are simulated which
appear ("Birth") or disappear ("Death") in alternation at arbitrary
points in time (see Chapter 4.6, "Birth Death Propagation",
on page 52).

"Moving Propagation"
In the "Moving Propagation" configuration and number of "Moving
Channels" set to "One", the fading simulator simulates dynamic prop-
agation conditions in conformity with the test case 3GPP TS25.104,
annex B3. Two paths are simulated: Path 1 has fixed delay, while the
delay of path 2 varies slowly in a sinusoidal fashion.
Two additional predefined moving propagation scenarios according to
the 3GPP TS36.141, annex B.4 can configured the "ETU200Hz Mov-
ing" and the "Pure Doppler Moving". To configure one of these sce-
narios for 3GPP or LTE, select the corresponding item under "Stan-
dard > 3GPP or LTE > Moving Propagation".

Note: The moving propagation conditions enabled by selecting the
"Standard > 3GPP or LTE > Moving Propagation > Ref. + Mov. Chan-
nels" are identical to the conditions configured by enabling of "Moving
Propagation Configuration" and number of "Moving Channels" set to
"One".
See Chapter 4.7, "Moving Propagation", on page 57 for more infor-
mation.

"2 Channel Interferer"
In the "2 Channel Interferer" configuration, the fading simulator simu-
lates test case 5 and 6 from MediaFlo.
Two paths are simulated: Path 1 has fixed delay, while the delay of
path 2 varies slowly in a sinusoidal fashion or appears or disappears
in alternation at arbitrary points in time (hopping).
See Chapter 4.8, "Two Channel Interferer", on page 65 for more
information.

General Settings
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"High Speed Train"
In the High-Speed Train configuration, the fading simulator simulates
propagation conditions in conformity with the test case 3GPP 25.141,
annex D.4A and 3GPP 36.141, annex B.3.
The instrument simulates all the three scenarios as defined in the test
specification. Additionally, user-defined HST conditions can be con-
figured by selecting different profile and setting up the speed and the
initial distances.
See Chapter 4.9, "High Speed Train", on page 72 for more informa-
tion.

"User Dynamic"
The "User Dynamic" configuration is provided for future use.

Remote command: 
[:SOURce<hw>]:FSIMulator:CONFiguration on page 118
[:SOURce<hw>]:FSIMulator:BIRThdeath:STATe on page 142
[:SOURce<hw>]:FSIMulator:MDELay:STATe on page 161
[:SOURce<hw>]:FSIMulator:TCINterferer[:STATe] on page 182
[:SOURce<hw>]:FSIMulator:HSTRain:STATe on page 156

Moving Channels
This parameter determines whether only one or several moving channels are simula-
ted.

"One" In this mode, the fading simulator simulates dynamic propagation
conditions in conformity with the test case 3GPP TS25.104, annex
B3.

"All" Per default, one moving channel with Rayleigh distribution and one
tap is simulated.
Additional taps and paths can be enabled and configured in the "Path
Table".

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:CHANnel:MODE on page 157

Fading Clock Rate
Displays the clock rate used by the fading simulator for the signal processing.

The value depends on the selected "System Configuration" and influences the band-
width of the generated signal.

Remote command: 
[:SOURce<hw>]:FSIMulator:CLOCk:RATE? on page 120

Signal Dedicated To
Defines the frequency to that the signal of the whole Fader block is dedicated.

General Settings
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Example: How the R&S SMW determines the frequency used for the calculation
of the Doppler Shift
This example shows how the R&S SMW determines the fader frequency in "Signal
Dedicated To > Auto Detect Output" mode.
● In the "System Configuration > Fading/Baseband Config" dialog, enable a 2x2x2

MIMO configuration with "Baseband Sources > Coupled per Entity".
● In the "I/Q Stream Mapper":

– route "Stream A/B > RF A/B", "Stream A/D und > BBMM 2" and "Stream B/C >
BBMM 1" ("Combination > Add")

– enable a "Frequency Offset = 5 MHz" for Stream D
● Connect an R&S®SGT100A to the BBMM2 connector of the R&S SMW.

In the "External RF and IQ" dialog, configure this connection and set the frequency
of the connected instrument, e.g. "RF Frequency = 1.950 GHz".

● In the Status Bar, set "Freq A = 2.143 GHz"
The settings of your instrument should resemble the example on Figure 4-1.

Figure 4-1: Settings influencing the calculation of the Doppler Shift

1a, 1d = Routing of Stream A ("master" for "Fading 1")
1b = Routing of Stream D ("master" stream for "Fading 2" but not for "Fading 1")
1c = Routing of Stream C; an external device is not connected
2a = Frequency RF A, i.e. the frequency of Stream A
2b = Parameters influencing the frequency of Stream D

In this configuration, Stream A is the "master" stream for the "Fading 1"; Stream D is
the "master" for "Fading 2", because of the connected external device.
Note that:
● although Stream C is first stream of "Fading 2" it is not the "master" one, because

there is no external device connected to the BBMM1 or to the FAD3 connector.
● although an external device is connected to BBMM2, it is not the "master" for the

"Fading 1", because the streams are evaluated "left to right" and "up to down".
Observe the values of the parameter "Dedicated Frequency" for Fader 1 and Fader 2.
The settings of your instrument should resemble the example on Figure 4-2.

General Settings
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Figure 4-2: "Dedicated Frequency" and "Dedicated Connector": understanding the displayed infor-
mation

1 = Fader 1
2 = Fader 2
1a = "Dedicated Connector = RF A" because Stream A ("master") is routed to RF A
1b = "Dedicated Connector = BBMM 2" because Stream D is routed to BBMM 2 and an external instrument

is connected to this interface
2a = "Dedicated Frequency = Freq A = 2.143 GHz"
2b = "Dedicated Frequency = RF FrequencyExternal RF instrument + Frequency Offset = 1.95 GHz + 5 MHz =

1.955 GHz"

"Auto Detect Output"
The Doppler shift is calculated based on the actual RF frequency,
that is dynamically detected depending on:
● The current signal routing in the "Stream Mapper", in particular

the routing and the enabled "Frequency Offset" of the first ("mas-
ter") stream of each "Fader"
Note: The RF frequencies and the "Frequency Offset" of all other
streams are ignored.

● The external instrument connected to the output interface the
"master" stream is routed to
("System Configuration > External RF and I/Q")

● The "RF Frequency" of the connected instrument
("System Configuration > External RF and I/Q")

The R&S SMW continuously monitors these parameters, calculates
the frequency and displays:
● The Dedicated Frequency
● The Dedicated Connector
A warning message informs you if the detection fails; the "Dedicated
Frequency" is set to 1 GHz.

"Baseband Output"
Sets the fader frequency manually. The Doppler shift is calculated
based on a select "Virtual RF" frequency.
If you use an external I/Q modulator to upconvert the generated
faded baseband signal, set the value of the parameter Virtual RF to
the modulation frequency of the external I/Q modulator.

General Settings
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Remote command: 
[:SOURce<hw>]:FSIMulator:SDEStination on page 127

Dedicated Frequency
In Signal Dedicated To > "Auto Detect Output" mode, displays the dedicated RF fre-
quency (incl. enabled "Frequency Offset" in the "I/Q Stream Mapper"), used for the cal-
culation of the Doppler Shift.

A warning message informs you if the estimation fails; the "Dedicated Frequency" is
set to 1 GHz.

See also:
● Example "How the R&S SMW determines the frequency used for the calculation of

the Doppler Shift" on page 30
● Dedicated Connector.
Note: The "Dedicated Frequency" cannot be updated if the RF frequency varies very
fast, for example if an "RF Frequency Sweep" or a "List Mode" is active and the param-
eter Ignore RF Changes < 5PCT is disabled.
For more details, see the data sheet.

Remote command: 
[:SOURce<hw>]:FSIMulator:FREQuency on page 120

Dedicated Connector
In Signal Dedicated To > "Auto Detect Output" mode, displays the connector used to
determine the Dedicated Frequency.

See Example "How the R&S SMW determines the frequency used for the calculation of
the Doppler Shift" on page 30.

Remote command: 
[:SOURce<hw>]:FSIMulator:FREQuency:DETect? on page 127

Virtual RF
In Signal Dedicated To > "Baseband Output" mode, sets manually the frequency used
for the calculation of the Doppler shift.

This parameter is useful if:
● A user-defined Fader frequency is required
● An external I/Q modulator is used to upconvert the generated faded baseband sig-

nal.

Remote command: 
[:SOURce<hw>]:FSIMulator:FREQuency on page 120

Ignore RF Changes < 5PCT
(instruments with RF output only)

Selects whether variation in the RF frequency (also in the frequency of connected
external devices) that are smaller than 5% are to be ignored or not for the fading.

"On" Enables faster frequency hopping because small frequency changes
(which can occur e.g. in GSM hopping) do not result in a short-term
switch-off of the fader and a restart of the fading process.

General Settings
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Remote command: 
[:SOURce<hw>]:FSIMulator:IGNore:RFCHanges on page 121

Freq. Hopping Mode
Activates frequency hopping and determines the behavior of the fading simulator after
a frequency hop.

In real-world receivers, one of the reasons for frequency hopping could be that due to a
change in the location of the receiver, the original carrier is no longer accessible.

In the fading simulator, frequency hopping is implemented by switching of the carrier
frequency. The fading simulator is temporarily deactivated until the variation in the RF
frequency is completed. The fading process starts then again at the new frequency.

The instrument provides two modes for frequency hopping, that mainly differ in terms
of the behavior when hopping back to a prior frequency.

Prior to activating frequency hopping, list mode must be activated in the "List Mode"
dialog (State On). The target frequencies of the hops are determined by the frequency
values in the selected list. The time until the next frequency hop is determined by the
entered "Dwell Time". The HOP signal which marks the time point of the frequency hop
can be output on one of the USER connectors. These settings are available only for
the delay configurations.

For detailed information, refer to sections "Varying the RF Signal in List or Sweep
Mode" and "Local and Global Connectors" in the R&S SMW user manual.

"Off" Frequency hopping is deactivated.

"In Band" Frequency hopping is activated. After hopping back to a previous hop
frequency, the random process of the fading simulator is resumed as
if the fading had continued also at this frequency, i.e. the process is
not restarted.

The instrument simulates a situation in which the conditions after a
return frequency hop have not changed substantially, i.e. the receiv-
ing conditions are the same as those from before the frequency hop.
An example of a real-word situation is a pedestrian with a receiver
that has moved only a few meters.
In this mode, the number of target hop frequencies and frequency
hops is limited to four because the random processes for all of the
prior hop frequencies are computed in parallel.

General Settings
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"Out Of Band" Frequency hopping is activated. The random process of the fader is
restarted after a hop back to a previous target hop frequency and is
thus not correlated with the random process which was underway
prior to the frequency hop to this frequency.

In this mode, the number of target frequencies and frequency hops is
unlimited since the random process is computed only on the current
frequency.

Remote command: 
[:SOURce<hw>]:FSIMulator:HOPPing:MODE on page 121

4.2 Restart Settings

► To access this dialog, select "Fading > Restart".

Restart Mode
Selects the event which leads to a restart of the fading.

To achieve repeatable test conditions, after each restart the fading process starts at a
fixed starting point. The fading process then passes through identical random pro-
cesses for a particular setting.

"Auto" The modulation signal is continually faded.
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"Manual,
External"

Not supported in the current version.

Remote command: 
[:SOURce<hw>]:FSIMulator:RESTart:MODE on page 123

Execute Restart
Not supported in the current version.

Restart Source
Not supported in the current version.

Global Connector Settings
Provide a quick access to the related local and global connector settings.

For information, refer to the description R&S SMW User Manual, section "Local and
Global Connectors".

4.3 Insertion Loss Configuration, Coupled Parameters
and Global Fader Coupling

The fading process increases the crest factor of the signal, and this increase must be
considered in the drive at the baseband level. Especially when multiple paths are
superimposed or in case of statistical influences on a path, an insertion loss is required
to provide a drive reserve. If the full drive level is reached nevertheless, the I/Q signals
are limited to the maximum available level (clipping).

This section describes the setting, provided to control of the insertion loss and to sim-
plify the operation in dual-channel fading.

Impact of the Fading Simulator on the Crest Factor of the Signal

The crest factor is a figure that measures the difference in level between the peak
envelope power (PEP) and average power value (RMS) in dB. Hence, either increas-
ing the peak value or decreasing the RMS value results in a higher crest factor. In this
implementation, the instrument keeps the peak value as close as possible to the full
drive level (multiplier peak > 1) but the fading simulator reduces the RMS value by the
additional crest factor due to fading (multiplier RMS < 1). The ratio of these two multi-
pliers is a value, known as the insertion loss.

The instrument derives the crest factor of the signal at the output of the fading simula-
tor based on the crest factor of the signal at the input of the "Fading" block and the
insertion loss.
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Overview of the provided modes and the main differences between them

In the R&S SMW, the used insertion loss is not a fixed value but is dynamically adjus-
ted for different measurement tasks. For any of the predefined standards/test cases,
the instrument selects an optimal range for the insertion loss. In a user-defined fading
configuration, you define the way the range for insertion loss is determined.

From the following available modes, select the one most fitting to your application:
● "Normal"

In this mode, the instrument calculates the required insertion loss value in a way,
that a full drive is permitted, i.e the signal is not clipped at the maximum level.
The mode results in a very high signal quality, but the RMS level is lower than the
maximum possible level. Adjacent channel power (ACP) measurements, however,
require a higher dynamic range and a lower insertion loss.

● "Low ACP"
In this mode, the instrument outputs the signal with a higher level relative to the
maximum drive, i.e. greater S/N ratio. However, this mode decreases the signal
quality because of a higher percentage of clipping.
It is recommended that you enable this mode only for fading paths with Rayleigh
profile, as only this profile ensures a statistical distribution of level fluctuation. The
other fading profiles are characterized by a non-statistical level fluctuations and a
"Low ACP" mode leads to an enormous increase of clipping.
Irrespectively of the selected fading profile, you still can and have to monitor the
percentage of clipped samples.

● "User"
This mode relays on a manually defined value. Depending on you particular appli-
cation, you can find a favorable insertion loss configuration with the desired signal
dynamic range and acceptable clipping rate.

Regardless of the selected mode and the path loss settings, the instrument adjust the
insertion loss within this range to keep the output power constant. However, the maxi-
mum available output power of the R&S SMW is reduced by up to 18 dB.

Prerequisites for correct insertion loss adaptation

For correct automatic adaptation of the insertion loss, the processes involved in the
fading simulation, i.e. the paths among themselves as well as the paths relative to the
input signal, have to be statistically independent of each other. If statistically correlated
processes occur, such as the fading of modulation signals with symbol rates approxi-
mating the delay differences of the fading paths, correct automatic adaptation of the
insertion loss is not possible. A correlation requires, that you measure the level again
and manually corrected it, e.g. by enabling of a suitable level offset.

The following are two examples explaining the possible reasons for correlation.

Insertion Loss Configuration, Coupled Parameters and Global Fader Coupling
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Example: Correlated processes resulting from the used modulation signal and
the selected fading configuration
The instrument is configured to generate a QPSK signal with a symbol rate of 1
Msymb/s is generated and the PRBS 9 sequence as the data source.
Enabled is a fading configuration, consisting of two paths with a Rayleigh profile, identi-
cal speed and a resulting delay of 0 us and 1 us, respectively.
The symbol rates of the modulation signal are in the range of the delay differences of
the fading paths; the autocorrelation of the modulation data (PRBS 9) to the adjacent
symbol is not equal to 0. The fading process is therefore statistically not independent of
the process of generating the modulation signal. The automatic calculation of the inser-
tion loss is not correct.

Example: Correlated processes within the fading simulator
Enabled is a fading configuration, consisting of two paths with a pure Doppler profile
and a resulting Doppler shift of 100 Hz. The start phases of the two paths differ.
This causes super impositions, which in the worst case (e.g. with a phase setting of 0°
and 180°) may lead to the deletion of the signal; automatic calculation of the insertion
loss is not possible.

The related settings are summarized in dialog "Fading > Insertion Loss Config/Coupled
Parameters > Insertion Loss Configuration", see Chapter 4.3.1, "Insertion Loss Config-
uration Settings", on page 37.

Coupling Fading Parameters

In standard mode ("System Configuration > Mode > Standard"), you can couple certain
parameters and adjust them jointly. With enabled coupling, the setting of one of the
Fading blocks are transferred to the second fading simulator. A subsequent change in
the settings of one of the fading simulators results in settings adaptation in the other.

Logically, coupled parameters are available in instruments equipped with more than
one Fading Simulator (i.e. more than one R&S SMW-B14 options).

The related settings are summarized in dialog "Fading > Insertion Loss Config/Coupled
Parameters > Coupled Parameters", see Chapter 4.3.2, "Coupled Parameters and
Global Fader Coupling Settings", on page 39.

4.3.1 Insertion Loss Configuration Settings

► To access the dialog for defining the insertion loss, select "Fading > Insertion Loss
Config/Coupled Parameters".
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Insertion Loss Mode
Sets the mode for determining the insertion loss.

"Mode Normal" The insertion loss for a path of the fading simulator is automatically
chosen so that even when lognormal fading is switched on, overdrive
will occur only very rarely in the fading simulator. This setting is rec-
ommended for bit error rate tests (BERTs). The current insertion loss
is displayed under "Insertion Loss".

"Mode Low ACP"
The insertion loss is automatically chosen so that an overdrive will
occur with an acceptable probability. "Low ACP" mode is only recom-
mended for fading paths with Rayleigh profile as only in this case
statistical distribution of level fluctuation is ensured. For other fading
profiles, non-statistical level fluctuations occur which lead to an enor-
mous increase of clipping. However, monitoring the percentage of
clipped samples is recommended for Rayleigh paths also.
The current insertion loss is displayed under "Insertion Loss".

"Mode User" Any value for the minimum insertion loss in the range from 0 dB to 18
dB can be selected. Desired value is entered under "Insertion Loss".
This mode is provided to ensure optimization of the dynamic range
and signal quality for any application. Display of the clipping rate for
any value which is entered enables estimation of the signal quality for
the specified signal dynamic range.

Remote command: 
[:SOURce<hw>]:FSIMulator:ILOSs:MODE on page 122

Insertion Loss
Displays the current insertion loss in the "Normal" and "Low ACP" modes.

Entry of the insertion loss in "User" mode.

Insertion Loss Configuration, Coupled Parameters and Global Fader Coupling
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Remote command: 
[:SOURce<hw>]:FSIMulator:ILOSs[:LOSS] on page 122

Clipped Samples
Displays the samples whose level is clipped as a %.

If the full drive level is reached for an insertion loss which is too low, the I/Q signals are
limited to the maximum available level (clipping).

Remote command: 
[:SOURce<hw>]:FSIMulator:ILOSs:CSAMples? on page 122

0 ... 100 %
Graphically displays the samples whose level is clipped as a %. The scale resolution is
determined by entering the maximum value as a %.

4.3.2 Coupled Parameters and Global Fader Coupling Settings

► To access the dialog, select "Fading > Insertion Loss Config/Coupled Parameters".

Coupled Parameters
(available in "System Configuration > Mode > Standard")

Speed Setting Coupled ← Coupled Parameters
Sets the speed of the paths for both faders. The parameter Common Speed For All
Paths is also coupled.
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Remote command: 
[:SOURce<hw>]:FSIMulator:COUPle:SPEed on page 137

Local Constant Coupled ← Coupled Parameters
With lognormal fading, the parameter Local Constant is coupled for the paths of both
faders.

Remote command: 
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:LCONstant on page 136

Standard Deviation Coupled ← Coupled Parameters
With lognormal fading, the parameter Standard Deviation is coupled for the paths of
both faders.

Remote command: 
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:CSTD on page 136

Start Seed
Enters the start seed for random processes inside the fading simulator. The autocorre-
lation of different seeds is more than seven days apart. This value is global for the
instrument. If two instruments run with the same seed, fading processes will be identi-
cal after a retrigger of the fading simulator.

While working in MIMO mode that requires two instruments, set the start seeds of the
instruments to different values.

Remote command: 
[:SOURce<hw>]:FSIMulator:GLOBal:SEED on page 120

4.4 Path Table

The settings for configuration of the fading paths are grouped in a path table.

1. To access this dialog, select "Fading > Fading Settings > Path Table".

The path table comprises the individual path and group parameters.
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Figure 4-3: Fading Path Table: Understanding the displayed information

1a/1b = Path group number (displayed in the first row) and path number (second row in the table
header); the example shows 4 groups with different number of active paths (the first group is
marked with a blue border)

2 = Fading profile, assigned per fading path
3/3a = Common group delay of a path group ("Basic Delay" is always 0 for group 1); adjustable for the

other groups (light grey background)
4 = Resulting delay per path, calculated as the sum of the common group delay and the path-spe-

cific delay
5 = Adjustable parameter for paths with Rice, WM Rice of Gauss Doppler fading
6 = Adjustable parameter for paths with Pure Doppler and constant Phase fading
7 = For moving receivers, selected speed ν or calculated as a function of the resulting Doppler shift

fD
8 = Set resulting Doppler shift fD or calculated as fD=fRF*ν/c, where fRF is the selected RF and c the

speed of light
9 = Frequency ratio cosφt is ratio of the actual Doppler shift fA and the resulting Doppler shift fD
10 = Actual Doppler shift fA calculated as fA=fD*cosφt
10 = Pure display parameters are on a dark background
11 = Access to a "Vector" or a "MIMO Matrix" for configuration of the correlation between the chan-

nels

2. To display all five paths per each group, change the settings as follows:

a) Select "Table Settings".
b) In the "Path Table Settings" dialog, select "Path Filter > All Paths".

Cross-reference between the fading parameters

Consider the following interdependencies:
● Delay parameters

Path Table
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Resulting Delay = Basic Delay + Additional Delay
● Parameters influencing the Doppler shift calculation:

Resulting Doppler Shift fD calculated as:

fD = (ν/c)*fRF, where:

– ν is the Speed of the moving receiver
– fRF is the frequency of the RF output signal or the Virtual RF

– c=2.998*108m/s is the speed of light

For "Fading Profile > Pure Doppler, Gauss Doppler or Rice", the Actual Doppler
Shift fA calculated as:

fA = fD*cosφt, where:

– cosφt is the Frequency Ratio and φ is the angle of incidence
– fD is the Resulting Doppler Shift

4.4.1 Table Settings

► To access this dialog, select "Fading > Fading Settings > Path Table > Table Set-
tings".

The provided functions facilitate settings configuration and navigation in the path
table, like suppression of the indication of disabled paths, quick change of the
speed unit.

Path Filter
Suppresses the indication of the disabled paths.

Remote command: 
n.a.

Speed Unit
Toggles between the available units for speed. The value always remains unchanged
but the display is automatically adapted to the selected unit.
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Note: The remote control command changes only the units displayed in the graphical
user interface. While configuring the speed via remote control, the speed units must be
specified.

Remote command: 
[:SOURce<hw>]:FSIMulator:SPEed:UNIT on page 128

Keep Constant
Selects whether to keep the speed or the resulting Doppler shift constant in case of fre-
quency changes. If a constant speed is selected, the Doppler shift is calculated as
function of the speed and the frequency and vice versa.

Remote command: 
[:SOURce<hw>]:FSIMulator:KCONstant on page 123

Common Speed For All Paths
In delay configurations, activates/deactivates the same speed in all paths.

If Speed Setting Coupled is enabled, this parameter is also coupled in both faders.

"On" In this default state, a change of speed in a path automatically results
in a change of speed in all of the other paths.

"Off" When switching from "Off" to "On", the speed entry for path 1 of
group 1 is used for all of the paths.

Remote command: 
[:SOURce<hw>]:FSIMulator:CSPeed on page 137

4.4.2 Copy Path Group Settings

The provided "Copy Path Group" settings enable you to copy the settings of one to a
second fading group.

Copy Path Group
Selects a group whose settings are to be copied.

Remote command: 
[:SOURce<hw>]:FSIMulator:COPY:SOURce on page 119

To
Selects a group whose setting is to be overwritten.

Remote command: 
[:SOURce<hw>]:FSIMulator:COPY:DESTination on page 119

Copy
Triggers a copy procedure.
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Remote command: 
[:SOURce<hw>]:FSIMulator:COPY:EXECute on page 119

4.4.3 Path Table Settings

State Path
Activates a fading path.

After activating, the fading process is initiated for this path with the selected fading pro-
file. However, the fading simulator must be switched on.

Remote command: 
[:SOURce<hw>]:FSIMulator[:STATe] on page 134
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:STATe
on page 152
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:STATe
on page 152
[:SOURce<hw>]:FSIMulator:HSTRain:PATH:STATe on page 154

Profile
Determines the fading profile for the selected path. The fading profile determines which
transmission path or which radio hop is simulated.

See also "Fading Profile" on page 22.

Depending on which profile is selected, certain parameters will be available in the path
table and others will not be available.

With correlated paths, the profile setting must agree. When correlation is activated, the
setting of the path for which correlation is switched on is accepted for both paths. After-
wards, the most recent modification applies to both paths (no matter in which path it
was made).

The fading profiles Gauss1, Gauss2, Gauss DAB, WiMAX Doppler and WiMAX Rice
require the additional option R&S SMW-K72.

"Static Path" Simulated is a static transmission path which can undergo attenua-
tion (loss) or delay.

"Pure Doppler" Simulated is a transmission path with an individual direct connection
from the transmitter to the moving receiver (discrete component).
The actual Doppler shift is determined by the Speed and Frequency
Ratio parameters.
Tip: In MIMO configuration, use the Relative Gain Vector Matrix Set-
tings to configure beamforming.

"Rayleigh" Simulated is a radio hop in which many highly scattered subwaves
arrive at a moving receiver.

"Rice" Simulated is a radio hop in which a strong direct wave (discrete com-
ponent) arrives at a moving receiver in addition to many highly scat-
tered subwaves.
Use the parameter Power Ratio to set the ratio of the power of the
two components (Rayleigh and pure Doppler).
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"Const. Phase" Simulated is one transmission path with the set constant phase rota-
tion, attenuation (loss) or delay.

"Gauss1" Sum of two Gaussian functions and is used for excess delay times in
the following range:
0.5 µs to 2 µs, (0.5 µs < τI < 2 µs).
S(τI,f) = G(A, -0.8fd, 0.05fd) + G (A1, +0.4fd, 0.1fd)
where A1 is 10 dB below A.

"Gauss2" Sum of two Gaussian functions and is used for paths with delays in
excess of 2 µs, (τI > 2 µs).
S(τI,f) = G(B, +0.7fd, 0.1fd) + G (B1, -0.4fd, 0.15fd)
where B1 is 15 dB below B.

"Gauss DAB" Composed of a Gaussian function and is used for special DAB pro-
files.
S(τI,f) = G(A, ±0.7fd, 0.1fd)
where + 0.7fd applies for even path numbers and 0.7fd for odd, except
path 1.

"Gauss Doppler"
Sum of a Gaussian function and a pure Doppler component.
S(τI,f) = G(0.1A; 0; 0.08fd) + δ(f-0.5fd)

"Gauss (0.08 fd)"
Composed of a Gaussian function with a standard deviation of
0.08*fd.
S(τI,f) = G(A; f; 0.08fd)

"Gauss (0.1 fd)"
Composed of a Gaussian function with a standard deviation of 0.1*fd.
S(τI,f) = G(A; f; 0.1fd)

"Gauss (Watters)"
Gauss (Watterson) fading profile.

"WM Doppler" The WiMAX Doppler fading profile is a rounded Doppler PSD model
according to IEEE 802.16a.

"WM Rice" The WiMAX Rice fading profile is according to IEEE 802.16a.

"Bell Shape tgn Indoor/Bell Shape tgn Moving Vehicle"
Both Bell Shape fading profiles describe the indoor wireless channels
according to IEEE 802.11n and IEEE 802.11ac.
The profiles are called after the resulting Doppler power spectrum
that has a shape very similar to a "Bell". The second fading profile
includes a Doppler component that represents a reflection from a
moving vehicle.

"Custom" Customized Doppler fading profile developed by Cohda-Wirless; the
profile describes the channels for testing of IEEE 802.11p signals.
To access the required settings, select "Custom", see Chapter 4.10,
"Custom Fading Profile", on page 78.
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Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PROFile
on page 150
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:PROFile
on page 150

Path Loss
Enters the loss for the selected path.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOSS
on page 149

Basic Delay
Sets the Basic Delay.

Within a path group, all of the paths are jointly delayed by this value.

The path delay is calculates as:

Resulting Delay = Basic Delay + Additional Delay

The "Basic Delay" for group 1 is always 0. Thus, for the paths in group 1, the "Result-
ing Delay" is equal to the "Additional Delay".

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:BDELay
on page 143

Additional Delay
Sets the Additional Delay per path.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:ADELay
on page 143

Resulting Delay
Displays the Resulting Delay for the path.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:RDELay?
on page 151

Power Ratio
("Fading Profile > Rice, WM Rice, Gauss Doppler")

Enters the power ratio of the discrete component and distributed component.

The total power consisting of the two components is always constant. At a high power
ratio, the discrete (Doppler) component prevails. At a low power ratio, the distributed
(Rayleigh) component prevails.

Path Table
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Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PRATio
on page 149

Frequency Spread
("Fading Profile > Gauss Watterson")

Sets the frequency spread for the Gauss Watterson fading.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSPRead
on page 148

Frequency Shift
("Fading Profile > Gauss Watterson")

Enters the frequency shift for the Gauss Watterson fading.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSHift
on page 147

Const. Phase
Enters the phase by which the path is multiplied.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase
on page 145

Start Phase
("Fading Profile > Pure Doppler, WM Doppler")

A transmission path with the set start phase rotation is simulated which can undergo
attenuation (loss) or delay.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase
on page 145

Speed
Enters the speed ν of the moving receiver.

The Resulting Doppler Shift fD is calculated as:

fD = (ν/c)*fRF, where

fRF is the frequency of the RF output signal or the virtual RF frequency and
c=2.998*108m/s is the speed of light

Example: 
If ν = 100 km/h and fRF = 1 GHz, the fD = 92.66 Hz

Consider the following interdependencies:
● If the speed is changed, the resulting Doppler shift is automatically modified.
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● If "Path Table Settings > Common Speed in All Paths > On", a change of speed in
one path automatically results in a change of speed in all of the other paths of the
fader.

● In the "Fading Profile > Pure Doppler/Rice/Gauss Doppler", the actual Doppler
Shift fA is a function of the selected speed ν and also of the parameter Frequency
Ratio.
See also "Cross-reference between the fading parameters" on page 41

● In "System Configuration > Mode > Standard", you can couple the speed for the
paths of both faders.

● With correlated paths, the speed setting must agree. When correlation is activated,
the settings of the path for which correlation is switched on are accepted for both
paths. Afterwards, the most recent modification applies to both paths (no matter in
which path it was made). The same applies to all paths of the two faders when
coupling is activated.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:SPEed
on page 151

Resulting Doppler Shift
If "Table Settings > Keep Constant > Speed", this parameter displays the resulting
Doppler shift fD.

The value depends on the selected:
● Speed
● RF frequency fRF or the Virtual RF
● For "Fading Profile > Pure, Gauss Doppler or Rice", the "Actual Doppler Shift"

depends also on the selected Frequency Ratio.
See "Cross-reference between the fading parameters" on page 41.

To set the Doppler shift, enable "Table Settings > Keep Constant > Resulting Doppler
Shift". In this case, the "Speed" is calculated as a function of the selected "Resulting
Doppler Shift" and the RF frequency fRF.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler[:
RESulting] on page 146

Frequency Ratio
("Fading Profile > Pure, Gauss Doppler or Rice")

Sets the ratio of the actual Doppler Shift fA to the Resulting Doppler Shift fD.

The actual Doppler shift is a function of the simulated angle of incidence of the discrete
component (see Figure 4-4) and is calculated as:

fA = fD*cosφt, where:

cosφt is the "Frequency Ratio" and fD= (v/c)*fRF is the Resulting Doppler Shift.

Negative values indicate a receiver that is going away from the transmitter, and posi-
tive values a receiver that is approaching the transmitter.
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Figure 4-4: Doppler shift as a function of the angle of incidence

See also "Cross-reference between the fading parameters" on page 41

With correlated paths, the speed setting of the Frequency Ratio must agree. When cor-
relation is activated, the settings of the path for which correlation is switched on are
accepted for both paths. Afterwards, the most recent modification applies to both paths
(no matter in which path it was made).

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio
on page 147

Actual Doppler Shift
( "Fading Profile > Pure Doppler, Gauss Doppler, Rice")

Displays the actual Doppler shift fA. The value depends on Frequency Ratio and
Resulting Doppler Shift.

See also "Cross-reference between the fading parameters" on page 41.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler:
ACTual? on page 146

Correlation Path
Switches on correlation to the corresponding path of the second fader for dual-channel
fading.

Setting correlation necessitates synchronous signal processing on both channels. This
means the settings of the following parameters for the correlated fading paths must
agree:
● "Profile"
● "Speed"
● "Frequency Ratio"
● "Lognormal Parameters"
● "Resulting Doppler Shift"
● "Actual Doppler Shift"
When correlation is activated, the settings of the path for which correlation is switched
on are accepted for both paths. Afterwards, the most recent modification applies to
both paths (no matter in which path it was made).

Path Table
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Correlated paths in dual-channel fading with the same input signal simulate the receiv-
ing conditions experienced by a receiver having two antennas in which the received
signals exhibit a certain degree of correlation due to a similar environment.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:
CORRelation:STATe on page 145

Correlation Coefficient
Sets the magnitude of the complex correlation coefficient as a percentage.

The higher the entered percentage, the greater the correlation of the statistical fading
processes for the two correlated paths. Highly correlated ambient conditions for the
signal are simulated in this manner.

Each fader has a maximum of 20 paths.

With correlated paths, the coefficient setting must agree. When correlation is activated,
the setting of the path for which correlation is switched on is accepted for both paths.
Afterwards, the most recent modification applies to both paths (no matter in which path
it was made).

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:
CORRelation:COEFficient on page 144

Correlation Coefficient Phase
Sets the phase of the complex correlation coefficient in degrees.

With correlated paths, the coefficient phase setting must agree. When correlation is
activated, the setting of the path for which correlation is switched on is accepted for
both paths. Afterwards, the most recent modification applies to both paths (no matter in
which path it was made).

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:
CORRelation:PHASe on page 144

Lognormal State
Switches lognormal fading on/off (slow fading).

Simulated is an additional slow fluctuation of the received amplitude of a moving
receiver. This can occur due to peculiarities in the landscape or topography (e.g. when
driving through a depression). Lognormal fading has a multiplicative effect on the path
loss. The multiplication factor is time-variable and logarithmically normally distributed. If
a Rayleigh profile is set simultaneously, what we obtain is Suzuki fading.

Note: Since the slow level fluctuation is not taken into account statistically in the com-
putation of the insertion loss, the output power can deviate from the displayed power.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
STATe on page 149

Local Constant
Enters the Local Constant for lognormal fading.

Path Table



Fading SettingsR&S®SMW-B14/-K71/-K72/-K74/-K75

51User Manual 1175.6826.02 ─ 09

The Local Constant L and the speed v of the moving receiver determine the limit fre-
quency fL for lognormal fading:

fL = v/L.

The power density spectrum of an unmodulated carrier consists of a discrete spectral
line at fRF and a frequency-dependent continuous component for which the following
applies:

The lower setting limit is a function of the (virtual) RF frequency fRF and is calculated as
follows:

Lmin = 12*109 / fRF

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
LCONstant on page 148

Standard Deviation
Enters the standard deviation in dB for lognormal fading.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
CSTD on page 148

4.5 Path Graph

To access the graphical representation of the configured path,

► select "Fading > Path Graph".

The path graph provides a quick overview of the paths as they are configured in
the delay modes.

 

Path Graph
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The signal delay is plotted on the x-axis. The minimum value is 0 s. The maximum
value is equal to the maximum delay, determined by the sum of max. Basic Delay and
max. Additional Delay. The relative path power is plotted on the y-axis, with 0 dB corre-
sponding to the maximum power on the path (path loss = 0 dB).

Each path is represented by a bar. The color of the bar indicates the fading profile of
the path. The color coding for the individual profiles is shown right next to the graphics.
The "Path Loss" can be read off from the height of the bar. The minimum value is 0 dB,
and the maximum value is – 50 dB.

4.6 Birth Death Propagation

In the "Birth Death Propagation" configuration, the fading simulator simulates dynamic
propagation conditions in conformity with the test case 3GPP, 25.104-xxx, annex B4.
Here, the behavior of a receiver is tested when it is confronted with the sudden disap-
pearance and reappearance of a signal. This can occur, for example, when a pedes-
trian making a call walks around the corner of a building.

Two paths are simulated which appear ("Birth") or disappear ("Death") in alternation at
arbitrary points in time. The points in time fall within a grid of integer delays [-5, -4, -3,
-2, -1, 0, 1, 2, 3, 4, 5] µs. After a certain time ("Hopping Dwell"), a path disappears from
a given grid position and appears simultaneously at another randomly chosen grid
position. During this hop, the second path remains stable at its grid position. After a fur-
ther "Hopping Dwell" elapses, the second path changes its position. Now, the first path
remains at its position and so on. The two paths never appear at the same time posi-
tion at the same time (see Figure 4-5).

Figure 4-5: Example of a sequence of hops in Birth Death Propagation

Since it is not possible to generate negative time values (delays), the actual hop range
is from 0 to 10 µs.

According to annex B4, each path has the same loss and phase and no Doppler shift.
The time until the position of a path is changed is also specified (see Table 4-2).

Table 4-2: Default parameter values (Birth Death Propagation)

"Profile" Pure Doppler

"Path Loss" 0 dB

"Min. Delay" 0 μs

"Delay Grid" 1 μs

 

Birth Death Propagation
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"Positions" 11

"Max. Delay" 10 μs

"Hopping Dwell" 191 ms

"Speed" 0 m/s

"Frequency Ratio" 1.0

Path Graph

The graphical display of the fading paths in Birth Death Propagation mode shows as
an example the changing positions of the two paths within the delay grid. The dis-
played position change does not correspond to the actual delay hops of the real signal.
An arrow indicates the direction of the delay hop of the path that will next change its
position, with the head of the arrow marking the new position.

The delay grid is plotted on the x-axis. The permissible delay range and the delay off-
set are shown in the graphics (see the "Min Delay" and the "Delay Range" indication
on the graph). The path power is plotted on the y-axis, with 0 dB corresponding to the
maximum power on the path (path loss = 0 dB). The scaling of the axes and the dis-
played path power match the real settings.

The scaling of the x-axis depends on the set delay range. It always starts at 0 µs and
rages up to 40 µs at the most (= maximum for delay range). The minimum delay corre-
sponds to the start value of the delay range. The maximum delay is defined by the min-
imum delay, the delay grid and the number of possible hop positions.

Max Delay = (Positions – 1) x Delay Grid + Min. Delay

The (mean) delay offset is calculated from the minimum and maximum delay ((max.
delay - min. delay)/2).

The Table 4-2 lists the default values for Birth Death Propagation. However, these
parameters can also be set for further tests in the fading path table.

Birth Death Propagation
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Profile
Displays the fading profile for birth death propagation. The fading profile has a fixed
setting to "Pure Doppler".

A transmission path is simulated in which there is an individual direct connection from
the transmitter to the moving receiver (discrete component). The Doppler frequency
shift is determined by the "Speed" and "Frequency Ratio" parameters.

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:PROFile on page 139

Path Loss
Enters the loss for the selected path.

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:LOSS on page 139

Min Delay
Enters the minimum delay for the two fading paths.

The minimum delay corresponds to the start value of the delay range.

The delay range is defined by the minimum delay, the delay grid and the number of
possible hop positions. It can be in the range between 0 and 40 us.

0 us < (Positions – 1) x Delay Grid + Min. Delay < 40 us

The scaling of the X-axis is adapted according to the entry (see "Path Graph"
on page 53).

Invalid entries are rejected, the next possible value is entered.

Birth Death Propagation
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Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MINimum on page 138

Delay Grid
Enters the delay grid. The value defines the resolution for the possible hop positions of
the two fading paths in the delay range.

The scaling of the X-axis is adapted according to the entry (see "Path Graph"
on page 53).

Invalid entries are rejected, the next possible value is entered.

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:GRID on page 138

Positions
Enters the number of possible hop positions in the delay range.

The scaling of the X-axis is adapted according to the entry (see "Path Graph"
on page 53).

Invalid entries are rejected, the next possible value is entered.

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:POSitions on page 140

Maximum Delay
Indication of the maximum delay. The maximum delay corresponds to the stop value of
the delay range (see "Path Graph" on page 53).

The maximum delay is defined by the minimum delay, the delay grid and the number of
possible hop positions.

Max Delay = (Positions – 1) x Delay Grid + Min. Delay

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MAXimum? on page 138

Start Offset
Enters the timing offset by which the start of "Birth Death Propagation" is offset with
respect to when fading is switched on or a restart as a result of a restart trigger.

This allows the user to precisely displace birth death events with respect to one
another during two-channel fading. This is required in some 3GPP base station tests.

If the same hopping dwell time is entered in both faders, the offset will take place by a
constant value.

Birth Death Propagation
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Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:SOFFset on page 140

Hopping Dwell
Enters the time until the next change in the delay of a path (birth death event).

During two-channel fading, the dwell times of the two channels can be set independ-
ently. This causes the hop time points of the two channels to coincide repeatedly. This
is a way of simulating tough receiving conditions as arise when two receiving channels
simultaneously change frequency (see figure).

Birth Death Propagation
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Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:HOPPing:DWELl on page 139

Speed
Enters the speed v of the moving receiver.

The resulting Doppler shift is dependent on the speed v and the entered ratio of the
actual Doppler shift to the set Doppler shift fD. This ratio is determined in the "Fre-
quency Ratio" line. The resulting Doppler frequency can be read off from the "Res.
Doppler Shift" line. It may not exceed the maximum Doppler frequency.

If the speed is changed, the resulting Doppler shift is automatically modified.

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed on page 140

Resulting Doppler Shift
Displays the resulting Doppler shift.

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler? on page 141

Frequency Ratio
Enters the ratio of the actual Doppler shift to the Doppler shift set with the "Speed"
parameter.

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:FRATio on page 141

Actual Doppler Shift
Displays the actual Doppler shift.

The actual Doppler frequency is determined by the selected "Speed" and "Frequency
Ratio" (i.e. the ratio of the actual Doppler frequency to the resulting Doppler fre-
quency).

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler:ACTual?
on page 142

4.7 Moving Propagation

In the "3GPP/LTE Moving Propagation" configuration, the fading simulator simulates
dynamic propagation conditions in conformity with the test case 3GPP TS25.104,
annex B3 or 3GPP TS36.141, annex B.4.

The fading simulator enables configuration according to three predefined moving sce-
narios. The first one represents moving conditions with one reference and one moving
channel whereas in the other two all paths are moving.

The predefined scenarios are as follow:
● "Ref. + Mov. Channel" - Simulation of moving propagation conditions in accord-

ance to the 3GPP TS25.104, annex B3.

 

Moving Propagation
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(see Chapter 4.7.1, "Moving Propagation Conditions for Testing of Baseband Per-
formance", on page 58)

● "ETU200Hz Moving" - Simulation of moving propagation conditions in accordance
to the scenario 1 described in 3GPP TS36.141, annex B.4.
(see Chapter 4.7.2, "Moving Propagation Conditions for Testing the UL Timing
Adjustment Performance", on page 60)

● "Pure Doppler Moving" - Simulation of moving propagation conditions in accord-
ance to the scenario 2 described in 3GPP TS36.141, annex B.4.
(see Chapter 4.7.2, "Moving Propagation Conditions for Testing the UL Timing
Adjustment Performance", on page 60)

It is also possible to adjust some of the parameters of these predefined scenarios and
simulate user-definable moving propagation conditions.

4.7.1 Moving Propagation Conditions for Testing of Baseband Perform-
ance

Simulating moving propagation conditions for testing of baseband performance

► To simulate moving propagation conditions for testing of baseband performance in
accordance to the 3GPP TS25.104, annex B3:

a) select "Configuration > Moving Propagation" and "Moving Channels > One" or
b) select "Standard > 3GPP > Moving Propagation > Ref. + Mov. Channel".

Here, the behavior of a receiver is tested in response to slow delay variations in a sig-
nal. Two paths are simulated: Path 1 has fixed delay (Reference Path, P1), while the
delay of path 2 varies slowly in a sinusoidal fashion (Moving Path, P2). The two paths
have no fading profile. They have the same level, the same phase and no Doppler
shift.

The following figure illustrates a baseband signal with ASK modulation (only one 1 bit,
then many 0 bits) which was subjected to moving propagation. Path P1 remains still
while path P2 moves in time relative to it. As a result of the luminescence setting on
the oscilloscope, the way in which P2 wanders over time is clearly visible.

 

Moving Propagation
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The graphical display of the fading paths in Moving Propagation mode shows as an
example the changing positions of the moving path with respect to the stationary refer-
ence path. The displayed position change does not correspond to the actual delay
changes of the real signal.

The delay grid is plotted on the x-axis. The permissible delay range for the moving path
is shown in the graphics by the horizontal arrow. The grey path indicates the set start
delay for the Moving Path. The path power is plotted on the y-axis, with 0 dB corre-
sponding to the maximum power on the path (path loss = 0 dB). The scaling of the
axes and the displayed path power match the real settings.

The delay Δτone of the moving path obeys the following equation:

Moving Propagation
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Where the values relate to the values proposed in the test case 3GPP, 25.104xxx,
annex B3 as follows:
● Variation (Peak-Peak) = A
● Delay = B + A/2
● Variation Period = 2π /Δ ω

The Table 4-3 list the settings required to attain the values proposed in the test case
3GPP TS25.104, annex B3.

Table 4-3: Default parameter values (Moving Propagation)

Reference Path: "Delay" 0 us

 "Path Loss" 0 dB

 "State" On

Moving Path: "Variation (Pk Pk)" 5 us

 "Variation Period" 157 s

 "Delay" 3.5 us

 "Path Loss" 0 dB

 "State" On

These default values can be changed in the Path Table dialog.

4.7.2 Moving Propagation Conditions for Testing the UL Timing Adjust-
ment Performance

The purpose of the uplink timing adjustments testing is to verify whether the base sta-
tion sends timing advance commands and whether the base station estimates appro-
priate the uplink transmission timing.

Simulating moving propagation conditions

To simulate moving propagation conditions for testing the UL timing adjustment per-
formance in conformity with the test cases "Moving propagation conditions", as defined
in 3GPP 36.141, annex B.4:

► Select "Standard > LTE > Moving Propagation > ETU200Hz Moving or Pure Dop-
pler Moving"

The Figure 4-6 illustrates the moving propagation conditions for the test of the UL tim-
ing adjustment performance.

 

Moving Propagation
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Figure 4-6: Moving Propagation Conditions

Use the parameter "Additional Delay" to configure the relative timing among all paths.
The time difference between the reference timing and the first path is according to the
following equation:

The 3GPP specification defines the uplink timing adjustments requirements for normal
and extreme conditions. The following two scenarios for the testing of UL timing
advance are specified:
● Scenario 1: ETU200 ("ETU200Hz Moving") is the scenario for testing in normal

conditions.
This scenario considers ETU channel model and UE speed of 120km/h.

● Scenario 2: AWGN ("Pure Doppler Moving") is the extreme conditions optional sce-
nario.
The scenario corresponds to AWGN channel model and UE speed of 350km/h.

The fading simulator generates the signals for these scenarios in according to the
parameters defined in the 3GPP specification (see table Table 4-4). However, the fad-
ing simulator also allows the re-configuration of some of the predefined values.

Table 4-4: Default parameter values

Parameter Scenario 1 Scenario 2

Channel Model ETU200Hz Moving Pure Doppler

UE speed 120 km/h 350 km/h

CP length Normal Normal

"Variation (Peak-Peak)" 10 μs 10 μs

Δω 0.04 1/s 0.13 1/s

"Variation Period" = 2π/Δω 157.1 s 48.3 s

4.7.2.1 Scenario 1

Here, the behavior of a moving receiver is tested, i.e. the simulated scenario repre-
sents a moving receiver that changes its distance to the base station. The Fading Sim-
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ulator generates the signal as a sequence of complete cycles of approach towards to
the BS antenna and moving away from it.

Per default, three Rayleigh path groups with three paths each are simulated. All paths
move.

The path group 1 has a fixed delay ("Basic Delay = 0 s"); the "Basic Delay" of the other
two path groups can be configured. The relative timing among all paths is determined
by the parameter "Additional Delay".

The three path groups have the same phase and speed; the Doppler shift is calculated
as a function of the selected speed.

4.7.2.2 Scenario 2

One path without a fading profile (Pure Doppler) is simulated. The path has constant
level and constant speed.

4.7.3 Path Tables Moving Propagation

The parameters available for configuration depend on the selected number of Moving
Channels, one or all.

4.7.3.1 One Moving Channel

► To access the settings for configuring the moving and the reference path for the
moving propagation with one moving channel, perform on of the following:

a) select "Fading > Standard > 3GPP > Ref. + Mov. Channel"
b) select "Fading > Configuration > Moving Propagation" and "Moving Channels >

One".
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Reference Path Settings
The following settings are provided:

State ← Reference Path Settings
Activates reference path P1 for moving propagation.

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:STATe on page 160

Path Loss ← Reference Path Settings
Enters the loss for the reference path.

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:LOSS on page 160

Delay ← Reference Path Settings
Enters the delay for the reference path.

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:DELay on page 160

Moving Path Settings
The following settings are provided:

State ← Moving Path Settings
Activates moving fading path P2 for moving propagation.

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:STATe on page 159

Path Loss ← Moving Path Settings
Enters the loss for the moving fading path.

Moving Propagation
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Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:LOSS on page 159

Delay ← Moving Path Settings
Enters the average delay for the moving fading path.

The delay of the moving path slowly varies sinusoidal within the set variation range
around this delay.

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:MEAN on page 158

Variation (Peak-Peak) ← Moving Path Settings
Enters the range for the delay of the moving fading path for moving propagation. The
delay of the moving path slowly varies sinusoidal within this range around the set mean
delay.

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:VARiation on page 159

Variation Period ← Moving Path Settings
Period duration for delay variation. A complete variation cycle is passed through in this
time.

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:VPERiod on page 159

4.7.3.2 All Moving Channels

► To access the settings for configuring the moving path groups and their paths, per-
form one of the following:

a) select "Fading > Standard > LTE > Moving Propagation > ETU200Hz Moving"
b) select "Fading > Standard > LTE > Moving Propagation > Pure Doppler Mov-

ing"
c) select "Fading > Configuration > Moving Propagation" and "Moving Channels >

All".

The number and the parameters of the predefined paths depend on the selected
scenario.

 

Moving Propagation
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The most parameters in the "Path Table" correspond to the parameters described in
Chapter 4.4, "Path Table", on page 40.

Delay Variation (Peak-Peak)
Enters the range for the delay of the moving fading paths for moving propagation with
all moving channels. The delay of the moving path slowly varies sinusoidal within this
range around the set mean delay.

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:DELay:VARiation
on page 157

Variation Period
Period duration for delay variation. A complete variation cycle is passed through in this
time.

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:VPERiod on page 156

4.8 Two Channel Interferer

In the "2 Channel Interferer" configuration, the fading simulates dynamic propagation in
conformity with the test cases 5 and 6 from MediaFlo. Here, path 1 has a fixed delay
while the delay of path two either varies slowly in a sinusoidal way or appears in alter-
nation at arbitrary points in time. Thus, 2 channel interferer fading can be considered
as a combination of birth death propagation fading and moving propagation fading. The
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main difference is the broader range of propagation obtainable with 2 channel inter-
ferer fading.

Each of the fading profiles "Static Path", "Pure Doppler" and "Rayleigh" can be alloca-
ted to the two paths.

Predefined Setting

The Table 4-5 and Table 4-6 list the settings required to attain the values proposed in
the MediaFlo test case 5 and 6.

Table 4-5: Test Case 5

Reference Path: "Profile" Static Path

 "Relative Delay" 10 us

 "Average Power" -3 dB

 "Fading Type" Rayleigh, 60 km/h

 "Doppler Spectrum" Classic 6 dB

 "Static Delay" 40 us

Moving Path: "Profile" Hopping

 "Relative Delay" 0/110 us

 "Average Power" -3 dB

 "Fading Type" Static

 "Doppler Spectrum" N/A

 "Dwell Time" 2.9 s

Table 4-6: Test Case 6

Reference Path: "Profile" Static Path

 "Relative Delay" 100 us

 "Average Power" -3 dB

 "Fading Type" Static

 "Doppler Spectrum" N/A

Moving Path: "Profile" Sliding

 "Relative Delay" 0/200 us

 "Average Power" -3 dB

 Fading Type Rayleigh, 3 km/h

 "Doppler Spectrum" Classic 6 dB

 "Period" 160 s

Two Channel Interferer
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How to use the provides settings and configure a 2 channel interfering signal

The following are two examples on how to configure a "2 Channel Interferer" condi-
tions. See how to:
● "To enable a hopped moving mode" on page 67
● "To enable a sliding moving mode" on page 67

To enable a hopped moving mode

Enable a 2 channel interfering signal with the following settings:

1. Reference Path:

a) "Delay Min = 30 μs"
b) "Profile = Static Path"
c) "Path Loss = 0 dB"

2. Moving Path:

a) "Delay Min = 0 μs"
b) "Profile = Static Path"
c) "Path Loss = 0 dB"
d) "Delay Max = 100 μs"
e) "Moving Mode > Hopping"

3. Enable "Reference Path > State > On" and "Moving Path > State > On"

4. Open the "Fading > Path Graph" view.

The following figure shows the resulting path graph.

To enable a sliding moving mode

1. Use the settings of "To enable a hopped moving mode" on page 67.

2. Change the "Moving Mode > Sliding".

Two Channel Interferer
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3. Open the "Fading > Path Graph" view.

The moving path slides from the minimum delay (30 us) to the maximum delay
(100 us) and back. The grey bar indicates the mean delay of the moving path. The
horizontal arrow indicates the permissible delay range for the moving path.
The displayed position change does not correspond to the actual delay changes of
the real signal.

2 Channel Interferer Settings

The Table 4-5 and Table 4-6 list the default values for "2 Channel Interferer" configura-
tion. You can use these default values and/or adjust the provided settings in the fading
path table.

Two Channel Interferer
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State
Activates/deactivates either the reference path or the moving path for 2 channel inter-
ferer fading.

Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer[:STATe] on page 182
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:STATe
on page 185

Profile
Selects the fading profile either for the reference path or the moving path to be used for
2 channel interferer fading.

Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler?
on page 184

Path Loss
Sets the attenuation of either the reference path or moving path to be used for 2 chan-
nel interferer fading.

Two Channel Interferer



Fading SettingsR&S®SMW-B14/-K71/-K72/-K74/-K75

70User Manual 1175.6826.02 ─ 09

Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:LOSS
on page 185

Speed
(Rayleigh only)

Enters the speed v of the moving receiver. The unit for entering the speed under
"Speed Unit" can be chosen in the upper section of the menu.

The resulting Doppler shift is dependent on the speed v and the entered ratio of the
actual Doppler shift to the set Doppler shift fD. This ratio is determined in the "Fre-
quency Ratio" line. The resulting Doppler frequency can be read off from the "Res.
Doppler Shift" line. It may not exceed the maximum Doppler frequency.

If the speed is changed, the resulting Doppler shift is automatically modified.

Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:SPEed on page 183

Freq. Ratio
Enters the ratio of the actual Doppler shift to the Doppler shift set with the "Speed"
parameter.

Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FRATio
on page 184

Res. Doppler Shift
Displays the actual Doppler shift.

The actual Doppler frequency is determined by the entered "Speed" and the entered
ratio of the actual Doppler frequency to the set Doppler frequency ("Frequency Ratio").

Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler?
on page 184

Delay Min
Enters the minimum delay for either the reference path or the moving path.

The minimum delay of the moving path corresponds to the start value of the delay
range.

The delay range is defined by the minimum delay and the maximum delay.

The scaling of the x-axis is adapted according to the entry.

Invalid entries are rejected, the next possible value is entered.

Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:DELay:
MINimum on page 184

Delay Max (Moving Path)
Enters the maximum delay for the moving path.

Two Channel Interferer



Fading SettingsR&S®SMW-B14/-K71/-K72/-K74/-K75

71User Manual 1175.6826.02 ─ 09

The maximum delay of the moving path corresponds to the end value of the delay
range.

The delay range is defined by the minimum delay and the maximum delay.

The scaling of the x-axis is adapted according to the entry.

Invalid entries are rejected, the next possible value is entered.

Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:MOVing:DELay:MAXimum
on page 183

Moving Mode (Moving Path)
Selects the Type of moving applied to the moving path.

"Sliding" The reference path has a fix delay while the delay of the moving path
varies slowly in a sinusoidal way.

"Hopping" The reference path has a fix delay while the delay of the moving path
appears or disappears in alternation at arbitrary points in time.

Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:MOVing:MMODe on page 183

Period/Dwell
Enters either the dwell time or the period of a complete cycle for the moving path
depending on the selected Moving Mode (Moving Path).

"Moving Mode" "Period Dwell"

"Sliding" sets the period for a complete cycle of the moving path

"Hopping" sets the dwell time of the moving path

The gradient of the delay/period ratio may not fall below 6μs/s, that is, the minimum
value of the period depends on the value of the delay.

If the value for the delay is increased in a way that the value for the gradient falls below
6μs/s, the value for the period is recalculated automatically.

Example: 
"Delay Min" = 20 us, "Delay Max" = 120 us, "Moving Mode = Sliding"
[("Delay max" - "Delay min")/2]*2π)/"Period/Dwell" = 6
"Period/Dwell" = 314/6 = 52.36 s

The value cannot be decreased below this value.

Two Channel Interferer
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Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:PERiod on page 183

4.9 High Speed Train

In the "High Speed Train" configuration, the fading simulator simulates propagation
conditions in conformity with the test case "High speed train conditions", as defined in
3GPP 25.141, annex D.4A and 3GPP 36.141, annex B.3. Here, the behavior of a
receiver in high speed train conditions is tested, i.e. the simulated scenario represents
a very fast moving receiver that drives past an antenna. The fading simulator gener-
ates the signal as a sequence of complete cycles of approach towards to the BS
antenna and departure from it.

Figure 4-7: High Speed Train Propagation

Three high speed scenarios are defined:
● Scenario 1: Open Space
● Scenario 2: Tunnel with leaky cable
● Scenario 3: Tunnel for multi-antennas

4.9.1 Scenario 1 and Scenario 3

For each of the scenarios 1 and 3, one path without a fading profile is simulated (Pure
Doppler). The path has constant level, no delay and variable Doppler shift.

The Doppler shift for these scenarios is calculated as follow:

where fA(t) is the actial Doppler shift and fD is the maximum Doppler frequency.

The cosine of angle is given by:

 

 

High Speed Train
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where:
● DS/2 is the distance in meters between the train and the BS at the beginning of the

simulation
● Dmin is the minimum distance in meters between the BS and the railway track

● v is the velocity of the train in m/s
● t is time in seconds

For scenario 1 and for BS with receiver diversity, the Doppler shift variation is the same
between the antennas.

4.9.2 Scenario 2

Scenario 2 is not defined for EUTRA/LTE test cases.

For scenario 2, one Rician fading propagation channel with Rician factor K=10 dB and
with one tap is simulated. The Rician factor K is defined as the ratio between the domi-
nant signal power and the variant of the other weaker signals (see "K (Rician factor)"
on page 77).

4.9.3 High Speed Train Scenario Parameters

The Table 4-7 gives an overview of the parameters of the HST test scenarios accord-
ing to the test case "High speed train conditions".

Table 4-7: Parameters for high speed train conditions

Parameter  Value  

 Scenario 1 Scenario 2 Scenario 3

DS 1000 m Infinity 300 m

Dmin 50 m - 2 m

K - 10 dB -

v 350 km/h 300 km/h 300 km/h

fD 1340 Hz 1150 Hz 1150 Hz

The Figure 4-8 and Figure 4-9 show the trajectory of the Doppler shift for scenario 1
and 3 for the test parameters specified in the test case. For these two scenarios, the
Doppler Shift trajectories for any user-defined parameters are also displayed in the
"3GPP HST" dialog.

 

 

High Speed Train
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Figure 4-8: Doppler shift trajectory for scenario 1

Figure 4-9: Doppler shift trajectory for scenario 3

Doppler shift calculation

The HST scenarios are defined for the UE and for the BS tests. In the fading simulator,
the same standards are used for both test cases. Consider however, the following dif-
ference in the calculation of the Doppler shift:

● In HST UE tests, the resulting Doppler shift is based only on the used DL fre-
quency.

● In HST BS tests, the DL signal itself already contains a Doppler shift. The UE syn-
chronizes on this shifted DL frequency. The simulated UL signal contains a Dop-
pler shift, too.
The resulting Doppler shift is than based on both, the UL and the DL frequency.

To enable the fading simulator to consider the DL Doppler shift, use the following two
parameters:
● Consider DL RF
● Virtual DL RF

High Speed Train
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General recommendations on performing HST BS tests

The following is a list of the general steps required to enable the fading simulator to
generate the signal required for the HST BS tests

1. Set the "RF Frequency" of the instrument to the FUL, as defined in the specification.

2. Enable a high speed train scenario with extension "(DL+UL)" in its name.

3. If not enabled, activate the parameter "Fading > (HST) Path Table > Consider DL
RF > On".

4. Set the value of the parameter "Fading > (HST) Path Table > Virtual DL RF" to the
FDL, as defined in the specification.

Example: Configuring the fading simulator to generate a HST BS test signal
according to 3GPP TS36.104
For frequency Band 1 tests, the specification defines: FDL = 2.14 GHz and FUL = 1.95
GHz. The resulting Doppler shift is FD = 1140 Hz.

● In the status bar, select "Frequency = FUL = 1.95 GHz"

● Select "Fading A > Fading Settings > Standards" and navigate to the required high
speed train scenario "3GPP > High Speed Train > HST 3 Tunnel Multi Antenna (DL
+UL)"

● If not enabled, activate the parameter "Fading > Path Table > Consider DL RF >
On".

● Select "Fading > Path Table > Virtual DL RF = FDL = 2.14 GHz"

● Select "Fading > Fading Settings > State > On"
● Use the command [:SOURce<hw>]:FSIMulator:HSTRain:FDOPpler? to

query the resulting Doppler shift.

Compare the example below and the Doppler shift trajectory specified in the 3GPP
TS36.104.

High Speed Train Scenario Settings

To access these settings:

1. Select "Fading > Fading Settings > Standards".

2. Navigate to the required high speed train scenario, e.g. "3GPP > High Speed Train
> HST 3 Tunnel Multi Antenna (DL+UL)"

The "3GPP HST" dialog displays the default values of the High Speed Train sce-
narios and allows you to adjust them for further tests.

High Speed Train
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State
Activates/deactivates simulation of High Speed Train propagation according to the
selected scenario.

Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:STATe on page 156

Profile
Determines the fading profile for the selected scenario. The fading profile determines
which transmission path is simulated.

Although both scenarios 1 and 3 are specified as Pure Doppler paths without a fading
profile and scenario 2 as a Rician fading, in this fading simulator you can change the
fading profile.

"Static Path" A static transmission path with no attenuation (loss) or delay is simu-
lated.

"Pure Doppler" A transmission path is simulated in which there is an individual direct
connection from the transmitter to the moving receiver (discrete com-
ponent).
The simulated path has a constant delay and attenuation (no loss).
The Doppler frequency shift is determined only by the parameters
Speed, D (min) and D (S).
Tip: Use the SCPI command [:SOURce<hw>]:FSIMulator:
HSTRain:FDOPpler? to query the Doppler frequency shift.

"Rayleigh" A radio hop is simulated in which many highly scattered subwaves
arrive at a moving receiver.

"Rice" One Rician fading propagation channel with K (Rician factor) and with
one tap is simulated.

High Speed Train
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Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:PROFile on page 155

Speed
Sets the velocity parameter, i.e. the speed of the moving receiver.

Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:SPEed on page 154

D (min)
Determines the parameter Dmin, i.e. the distance between the BS and the railway track.

Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:MINimum on page 153

D (S)
Determines the parameter DS, i.e. the initial distance DS/2 between the train and the
BS at the beginning of the simulation.

Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:STARt on page 153

K (Rician factor)
For scenario 2, sets the Rician factor K that is defined as the ratio between the domi-
nant signal power and the variant of the other weaker signals.

Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:KFACtor on page 155

Consider DL RF
Enables the selection of virtual downlink frequency (DL RF).

By default, this parameter is enabled for the HST (DL+UL) standards. For detailed
description, see "Doppler shift calculation" on page 74.

Note: While performing HST BS tests and "Consider DL RF > Off", the DL Doppler
shift is not considered by the calculation of the UL Doppler shift.

Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe
on page 155

Virtual DL RF
Sets the virtual downlink frequency. For HST BS tests, enter the FDL defined in the
specification. The value is used by the calculation of the UL Doppler shift.

For detailed description, see "Doppler shift calculation" on page 74

High Speed Train
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Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency on page 155

4.10 Custom Fading Profile

The custom fading profile allows you to modify the classical Jakes and Flat fading pro-
files. These modified profiles are required by the IEEE 802.11p channel models.

A frequency offset foffset can be applied to shift the spectrum of the original profile. Two
cut-off frequencies, fl (lower) and fu (upper), can be configured to set the lower and
upper cut-off frequencies of the resulting spectrum, see Figure 4-10.

Figure 4-10: Resulting asymmetric Doppler spectrum

In the Fading Simulator, all these required profile parameters are configurable, see
"Custom Fading Profile Settings" on page 78.

Custom Fading Profile Settings

To access these settings:

1. Select "Fading > Fading Settings > Path Table"

2. Select "Profile > Custom"

3. Select "Custom Profile > Custom Data"

 

Custom Fading Profile
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Doppler Shape
Sets the Doppler shape ("Flat" or "Rayleigh") of the virtual profile.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DSHape on page 186

Bandwidth
Sets the bandwidth of the original Doppler profile from which the resulting profile is cre-
ated, see Figure 4-10.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DATA on page 186

Frequency Offset
Sets the foffset, i.e. the frequency offset used to shift the original profile, see Figure 4-10.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DATA on page 186

Lower/Upper Cutoff Frequency
Sets the lower and upper cut-off frequencies, fl and fu, that depend on the original pro-
file bandwidth Bandwidth.

The following applies:
● fu  ≤  foffset  +  Bandwidth/2

Custom Fading Profile
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● fl  ≥  foffset  -  Bandwidth/2
● fu  -  fl  ≥  50 Hz
● 50 Hz ≤ Bandwidth ≥ 40 kHz
Where the highest possible absolute cut-off frequency is 4 kHz.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DATA on page 186

Custom Fading Profile
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5 Signal Routing (non-MIMO) Settings
These settings are available in "System Configuration > Mode > Standard", i.e. in non-
MIMO scenarios.

► To access the signal routing settings, select "Fading > Signal Routing (non-
MIMO)".

Signal Routing
In "System Configuration > Mode > Standard", defines the signal routing for the fading
signal at the output of the fading simulator.

Note: Signal routing for MIMO setups is performed with the settings provided in section
"MIMO > System Configuration" (see also Chapter 6.2, "Signal Routing Settings in
MIMO Configuration", on page 85).
In remote control, however, all available signal routing settings are configured with the
command [:SOURce<hw>]:FSIMulator:ROUTe.

In "System Configuration > Mode > Standard", the input signal of the fading simulator
is defined by the setting "Baseband > Signal Routing". An instrument equipped with
two fading simulators and two baseband blocks, the input signal of each of the fading
simulator can be:
● the signal from a single baseband block,
● the summation signal from both baseband blocks or
● each a signal from one of the two baseband blocks.
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The following is a list of the routing settings for an instruments equipped with two base-
band blocks, two signal paths and two options Fading Simulator (R&S SMW-B14).

"A to A/ B to B" Dual-channel fading. The fading signal from fader A is output on
baseband path A and the fading signal from fader B is output on
baseband path B.
The R&S SMW can be operated like two instruments; two independ-
ently configured signals are routed to the instrument's output.

This configuration is also suitable for transmit or receive diversity
tests:
● Use the signal of one of the baseband generators to simulate the

receiving conditions of a receiver with two antennas, like a high-
quality car radio, UMTS base station, etc.

● Correlate the paths of the two fading simulators, i.e. the two fad-
ing channels, to simulate the conditions of receiver with two
antennas which receive statistically correlated signals, like a car
with two antennas in which the two received signals exhibit a cer-
tain degree of correlation due to a similar environment such as an
underpass, hill, etc

"A to A/B to A" Dual-channel fading. The fading signal from fader A and the fading
signal from fader B are both output on baseband path A.
This configuration is suitable for the simulation of a mobile radio net-
work handover in the handheld device or for testing of filtering out the
own signal in case of simultaneous presence of a strong signal from
another standard. To simulate the required conditions, configure each
of the baseband signals according to the desired standard and route
them to the fading simulator. After fading, the two signals with widely
divergent signal strengths are output on a common output path.

"A to B / B to B"
Dual-channel fading. The fading signal from fader A and the fading
signal from fader B are both output on baseband path B.

"A to A and B / B to A and B"
Dual-channel fading. The fading signal from fader A and the fading
signal from fader B are output on baseband path A and baseband
path B.
The possible applications are basically analogous to the "A to A / B to
A" routing. With this routing however, the signal at the output of the
fading simulator is split up and routed to both paths; the processing of
these two paths after the fading can be differently. To simulate a fur-
ther degradation of the receiving conditions, for instance, use the pro-
vided function to superimpose the signal of one of the paths by noise
or destroy it.

"A to A and B / B (open)"
The fading signal from fader A is output on baseband path A and
baseband path B. The signal from fader B is not output, the signal
flow of baseband B is interrupted.
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"A (open)/ B to A and B"
The fading signal from fader B is output on baseband path A and
baseband path B. The signal from fader A is not output, the signal
flow of baseband A is interrupted.

Remote command: 
[:SOURce<hw>]:FSIMulator:ROUTe on page 123
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6 Multiple Input Multiple Output (MIMO)
Provided that the instrument is equipped with the required options, the R&S SMW sup-
ports versatile MIMO configurations.

Section Chapter 3.1, "Required Options", on page 17 provides an overview; for
detailed information, refer to the R&S SMW data sheet.

Multiple Input Multiple Output (MIMO) refers to a multi-channel method where two or
more simultaneous channel inputs and channel outputs are being used for boosting
data rates. The benefits of an MIMO system became visible only if the data signal is
tested in fading conditions. The MIMO fading option considers this special form of mul-
tipath propagation in channel simulation.

Depending on the number of the transmitting and receiving antennas used in a MIMO
system, different MxN MIMO test configurations are specified. The term MxN is a rep-
resentation of a MIMO system, where M is the number of the transmitting Tx antennas
and N the number of the receiving Rx antennas. Throughout this description, we also
use the term LxMxN as a short form of the used system configuration, where L repre-
sents the Number of Entities, M the Number of Basebands (Tx Antennas) and N the 
Number of Stream (Rx Antennas).

Normally, the simulation of a system with two or more transmitting and/or receiving
antennas requires two or more signal generators and/or fading simulator. The MIMO
Fading option (R&S SMW-K74) in combination with up to four Fading Simulator options
(R&S SMW-B14) enables you to simulate MIMO receiver tests scenarios with up to 8
Tx or up to 8 Rx antennas with one single instrument (see also Chapter 6.1, "Multiple
Entity MxN MIMO Test Configurations", on page 85).

Configurations with more than two entities as well as the higher order MIMO configura-
tions require the additional options Multiple Entities (R&S SMW-K76) and Higher Order
MIMO (R&S SMW-K75).

Abstract representation of the signal routing

2x2 MIMO system Preview diagram Block diagram

Illustration of the principle Detailed representation of the
signal processing

Each F<Tx><Rx> block repre-
sents one MIMO channel

"High level" representation

The Fading Simulator is displayed as one single block; the number of
the input Basebands (M) and the output Streams (N) indicate the MxN
MIMO configuration.
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The representation of a multi-entity MIMO configuration is even more abstract (see
also Chapter 6.1, "Multiple Entity MxN MIMO Test Configurations", on page 85).

6.1 Multiple Entity MxN MIMO Test Configurations

Equipped with the MIMO Fading option (R&S SMW-K74), the instrument enables the
simulation of versatile MIMO tests scenarios with one single instrument.

The supported MIMO scenarios depend on the installed options, in particular on the
number of options fading simulator (R&S SMW-B14), i.e. the number of the available
FADER boards and on the availability of the options Multiple Entities (R&S SMW-K76)
and and Higher Order MIMO (R&S SMW-K75).

For more details, see the data sheet.

6.2 Signal Routing Settings in MIMO Configuration

You have to select and configure a MIMO scenario before you can define the further
fading settings or the signal routing through the instrument.

To enable a MIMO scenario

1. Select "Fading > MIMO > System Configuration"

2. In the "System Configuration > Fading/Baseband Configuration" dialog, enable
"Mode > Advanced"

3. Define the MIMO scenario, e.g. to configure a 1x4x4 MIMO select:

a) "Entities (Users, Cells) = 1"
b) "Basebands (Rx Antennas) = 4"
c) "Streams (Tx Antennas) = 4"
d) "BB Source Config > Coupled Sources"

The preview diagram displays a detailed view of the signal routing for the current
selected configuration, together with short description of the possible application of
this configuration.

 

 

Signal Routing Settings in MIMO Configuration
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4. Select "Fading/Baseband Configuration > Apply" to trigger the instrument to use
the selected configuration and close the dialog.

The block diagrams displays the configured signal routing.

5. To enable a multiple-entities configuration, select "System Configuration > Fading/
Baseband Configuration" and enable for example:

a) "Mode > Advanced"
b) "Entities (Users, Cells) = 4", "Basebands (Rx Antennas) = 2", "Streams (Tx

Antennas) = 2"
c) "BB Source Config > Coupled Sources per Entity"
d) "Apply".

Signal Routing Settings in MIMO Configuration
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Refer to Chapter 6.3, "Fading Settings in MIMO Configuration", on page 87 for
description on the provided MIMO Fading settings.

Refer to section "Signal Routing and System Configuration" in the R&S SMW user
manual for comprehensive description of the settings in the "System Configuration"
dialog as well as information on how to define the I/Q stream mapping, connect
external instruments, etc.

To define the signal routing in MIMO mode

In MIMO mode, the signal routing is performed upon the selected MIMO configuration.

► Configure the instrument for a MIMO scenario, see "To enable a MIMO scenario"
on page 85.

The signal routing is fixed and depends on the selected MIMO configuration.

6.3 Fading Settings in MIMO Configuration

The MIMO Fading settings are available if a MIMO scenario is configured.

1. Configure the instrument for a MIMO scenario, see "To enable a MIMO scenario"
on page 85.

2. You can access the dialog for configuring the MIMO settings of all MIMO channel
via each of the "Fading" blocks.
Select "Fading > Fading Settings".

 

Fading Settings in MIMO Configuration
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Figure 6-1: General settings in "System Configuration > 2x2x2" (multi entity mode, L=2)

In "System Configurations" with multiple entities (L > 1), the dialog consists of more
than one side tabs; one tab per entity. The tab name indicates the fader state the
settings are related to.

3. Select "Path Table".

Figure 6-2: Path table settings in single entity mode (L=1): Understanding the displayed informa-
tion

1a/1b = Path group number (displayed in the first row) and path number (second row in the table
header); the example shows 4 groups with different number of active paths (the first group is
marked with a blue border)

2 = Fading profile, assigned per fading path
3/3a = Common group delay of a path group ("Basic Delay" is always 0 for group 1); adjustable for the

other groups (light grey background)
4 = Resulting delay per path, calculated as the sum of the common group delay and the path-spe-

cific delay.

Fading Settings in MIMO Configuration
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5 = Adjustable parameter for paths with Rice fading
6 = Pure display parameters are on a dark background
7 = Access to a "Vector" or a "MIMO Matrix" for configuration of the correlation between the chan-

nels

4. In the path table, navigate to the row "Coefficient" and for the corresponding path
select "Matrix" or "Vector".

The "Fading: Correlation Matrix" dialog comprises the parameters necessary to
adjust the correlation between the channels. You can define the correlation in one
of the following ways:
● In "Matrix Mode > Individual"

Figure 6-3: Correlation matrix in an individual matrix mode

In this mode, you can adjust the matrix coefficients directly in the coefficient
matrix.

● In "Matrix Mode > Kronecker"

Fading Settings in MIMO Configuration
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Figure 6-4: Correlation matrix in the kronecker mode

The definition of the correlation matrix settings is based on the Kronecker
assumption, i.e defined are the Rx and Tx antenna correlation coefficients. The
instrument calculates automatically the resulting correlation matrix and displays
it.
See Chapter 6.3.2, "Kronecker Mode Correlation Coefficients", on page 93.

● In "Matrix Mode > AoA/AoD"

Figure 6-5: Correlation matrix in TGn format (AoA/AoD mode)

See Chapter 6.3.3, "TGn/TGac Channel Models Settings", on page 95.
● In "Matrix Mode > SCME/WINNER"

Fading Settings in MIMO Configuration
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See Chapter 6.3.4, "SCME/WINNER Models and Antenna Modeling Settings",
on page 97.

● For static paths and paths with Pure Doppler fading profile, the corresponding
settings are grouped in the "Relative Tap Gain Vector" dialog.

Figure 6-6: Relative tap gain vector

This dialog provides additional parameters to simulate a gain weighting and
phase shift between the signals with constant fading transmitted among the dif-
ferent Tx antennas.
See Chapter 6.3.6, "Relative Gain Vector Matrix Settings", on page 110.
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6.3.1 Current Path (Tap) Settings

Prev
Displays the previous tap relative to the current tap. If tap 1 is the current tap, this but-
ton is disabled.

Remote command: 
n.a.

Copy To Prev
Copies the matrix values of the current tap to the next lower tap. If tap 1 is the current
tap, this button is disabled.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:COPY:PREVious on page 163

Current Path (Tap) #
Selects the tap to be displayed.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP on page 163

Copy To Next
Copies the matrix values of the current tap to the next higher tap. If the current tap is
the last tap, this button is disabled.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:COPY:NEXT on page 162

Copy To All
Copies the matrix values of the current tap all taps.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL on page 162

Next
Displays the next tap relative to the current tap. If the current tap is the last tap, this
button is disabled.

Remote command: 
n.a.

Matrix Mode
Selects the input mode for the Rx and Tx correlation values.

"Individual" Allows entering the correlation values individually.

"Kronecker" Opens additional input fields for entering the Rx correlation and Tx
correlation values, see Chapter 6.3.2, "Kronecker Mode Correlation
Coefficients", on page 93.
The matrix values are calculated automatically.
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"AoA / AoD" Opens additional input fields for defining the Rx and TX correlation
parameters based on the Spatial Channel Model (SCM), see Chap-
ter 6.3.3, "TGn/TGac Channel Models Settings", on page 95.
The matrix values are calculated automatically.

"SCME / WIN-
NER"

Opens additional input fields for defining the parameters of the Spa-
tial Channel Model Extended (SCME) model, see Chapter 6.3.4.1,
"SCME/WINNER Settings", on page 100.
The matrix values are calculated automatically.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:MODE on page 166

Polarization, Antenna Modeling
Accesses the corresponding tab in the "Antenna Model" dialog, see Chapter 6.3.4,
"SCME/WINNER Models and Antenna Modeling Settings", on page 97.

Data Format
Selects the matrix representation format. The data format can be changed at every
time. The matrix table is updated immediately.

"Magnitude-Phase"
Displays the matrix values as value pairs of magnitude and phase.

"Real-Imag" Displays the matrix values as complex numbers.

Remote command: 
n.a.

6.3.2 Kronecker Mode Correlation Coefficients

► To access the settings of the correlation matrix in Kronecker mode, enable a MIMO
configuration, select the "Fading > Path Table > Matrix" and select "Fading: Corre-
lation Matrix > Matrix Mode > Kronecker".
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Figure 6-7: Correlation matrix in Kronecker mode

Calculating of the matrix values based on the Kronecker assumption

In Kronecker mode, it is sufficient that you specify one Tx and one Rx correlation per
MIMO channel. The instrument automatically computes the full correlation matrix
according to the formula:

where ρ(l)
Rx and ρ(l)

Tx are the Rx and Tx correlations.

The evaluation of the Kronecker product ⊗ leads to:

Which and how many coefficients are available, depends on the selected MIMO config-
uration, e.g. any of the 2x2, 4x2, and 3x2 MIMO configurations, requires only one Rx
correlation coefficient AB, whereas there are six Rx correlation coefficients in case of
2x4 MIMO configuration.

Tx Correlation Coefficients, Magnitude/Real
Enters the value for the real/ratio part of the transmitter correlation (ρ(l)

Tx).

The available Tx correlation coefficients depends on the selected MIMO mode.
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Remote command: 
For "Data Format > Magnitude-Phase"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:MAGNitude on page 164
For "Data Format > Real-Imag"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:REAL on page 165

Tx Correlation Coefficients, Phase/Imag
Enters the value for the phase/imaginary part of the transmitter correlation (ρ(l)

Tx).

The available Tx correlation coefficients depends on the selected MIMO mode.

Remote command: 
For "Data Format > Ratio-Phase"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:PHASe on page 164
For "Data Format > Real-Imag"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:IMAGinary on page 164

Rx Correlation Coefficients, Magnitude/Real
Enters the value for the real/ratio part of the receiver correlation (ρ(l)

Rx).

The available Rx correlation coefficients depends on the selected MIMO mode.

Remote command: 
For "Data Format > Magnitude-Phase"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:MAGNitude on page 164
For "Data Format > Real-Imag"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:REAL on page 165

Rx Correlation Coefficients, Phase/Imag
Enters the value for the phase/imaginary part of receiver correlation (ρ(l)

Rx).

The available Rx correlation coefficients depends on the selected MIMO mode.

Remote command: 
For "Data Format > Ratio-Phase"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:PHASe on page 164
For "Data Format > Real-Imag"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:IMAGinary on page 164

6.3.3 TGn/TGac Channel Models Settings

TGn and TGac channel models are specified for the evaluation of IEEE 802.11n and
IEEE 802.11ac systems respectively.
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These channel models are based on the so called rays, which are defined at the BS
and MS side by their AoA (Angle of Arrival) and the AoD (Angle of Departure). The
rays are distributed according to the selected statistic function and angle spread (AS).

In this implementation, one fading path consists by default of one ray but you can
define up to six rays per path. The AoA (Angle of Arrival) / AoD (Angle of Departure)
parameters, i.e. AoA/AoD angles, angle spreads (AS) and distribution of the rays, as
well as the distances between the antennas at the Tx and the Rx side, are configura-
ble.

To access the dialog with TGn/TGac settings

1. Enable a MIMO configuration, select the "Fading > Path Table > Matrix".

2. Select "Fading: Correlation Matrix > Matrix Mode > AoA/AoD".

RX/TX Antenna Distance
Determines the distance between the Tx and Rx antennas as function of the wave
length lambda and is calculated as follow:

Physical Antenna Distance = "RX/TX Antenna Distance" * λ, where

the wave length λ = c / "Frequency" and c is the speed of light.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX on page 172
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX on page 172

Ray State
Enables/disables the selected ray.
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Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:STATe
on page 174

Relative Gain /dB
Sets the relative gain (in dB) of the selected ray.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:GAIN on page 173

Angle of Arrival (AoA)
Sets the AoA (Angle of Arrival) of the selected ray.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:ANGLe
on page 173

AoA Spread
Sets the AoA (Angle of Arrival) spread (AS) of the selected ray.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:SPRead
on page 173

Angle of Departure (AoD)
Sets the AoD (Angle of Departure) of the selected ray.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:
ANGLe on page 173

AoD Spread
Sets the AoD (Angle of Departure) spread (AS) of the selected ray.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:
SPRead on page 173

Distribution
Select one of the proposed statistical functions to determine the distribution of the
selected ray.

Tip: Use this parameter to simulate ray scattering due to obstacles with different sur-
face (see also Chapter 8.8, "TGn Settings", on page 171).

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:DISTribution on page 172

6.3.4 SCME/WINNER Models and Antenna Modeling Settings

The SCME and WINNER II channel models were developed by WINNER [1]. At the
beginning the SCM (Spatial Channel Model) was adopted, the SCME (SCM Extension)
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was the first extension of the original model. The WINNER II was the final model the
WINNER published.

The SCME and WINNER II channel models offer Cluster Delay Line (CDL) models for
reduced complexity simulations. These CDL models can be simulated in the SCME/
WIINER matrix mode. A channel correlation matrix is calculated from the CDL parame-
ters and the channel is stochastically simulated.

Antenna Modeling

The antenna modeling includes the antenna array structure, the antenna polarization
and the antenna radiation pattern.

The antenna model is based on a 2D planar antenna array structure. The antenna ele-
ments are placed in the vertical and horizontal direction in an array composed of N col-
umns and M rows (see Figure 6-8). The antenna elements are uniformly spaced where
the horizontal and vertical spacing between the antenna columns are dh*λ and dv*λ
respectively. The spacing between the antenna pairs of cross polarized antennas is
denoted as cross polarized antenna spacing dxp*λ.

One of four different antenna polarization settings can be selected for all antenna ele-
ments in the antenna array.

In the current firmware version, the antenna elements are placed on a single row and
vertical spacing is not supported.

Figure 6-8: 2D planar antenna array structure where each column is a cross-polarized 45° antenna
with dxp=0*λ
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The user interface illustrates the selected antenna array similarly, see Tx/Rx Antenna
Array Structure.

Antenna and channel polarization

The polarization of an antenna is the polarization of the radiated electromagnetic fields
produced by an antenna, evaluated in the far field.

Available are antenna elements with following polarizations:
● horizontal polarization
● vertical polarization
● cross-polarization 45°
● cross-polarization 90°

The correlation polarization matrix of the channel is computed from the antenna ele-
ment polarization angles and the XPR (cross polarization power ration of a propagation
channel) values, see "Vertical/Horizontal Cross Polarization Power Ratio"
on page 105.

Channel correlation matrix

The total channel correlation matrix R is computed by the element-wise product of
the polarization correlation matrix RP and the spatial correlation matrix RS, i.e.
R = RP*RS.

The polarization and spatial correlation matrices, RP and RS are calculated as follows:

● Spatial correlation matrix Rs
The spatial correlation matrix is determined by the spatial characteristics of the
channel, i.e. antenna radiation patters at the transmitter and the receiver ends,
antenna spacings and the PAS of the clusters.
The correlation between antenna array elements n and m can be expressed as [2].

Where:
– d is the antenna spacing between the two antenna elements
– λ is the wavelength of the signal
– PAS (Ø) is the Power Azimuth Spectrum of the impinging signal
– Gn (Ø) and Gm(Ø) are the antenna radiation patterns, characterized by a power

gain, for antenna elements n and m respectively

Assuming that the transmitter and receiver sides as uncorrelated, the total spatial
channel correlation matrix can be computed by the Kroneker product of the of the
two correlation matrices.
RS=RRx⊗RTx

● Polarization correlation matrix RP
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The polarization of the system is described by three matrices: channel polarization
S, and PTx, PRx for the transmitter and receiver antenna array polarization respec-
tively.
It is assumed that the elements of the channel polarization matrix are uncorrelated.

For description of the related settings, see:
● Chapter 6.3.4.1, "SCME/WINNER Settings", on page 100
● "Channel Polarization Settings" on page 105
● "Tx/Rx Antenna Array Structure" on page 106

6.3.4.1 SCME/WINNER Settings

To access these setting

1. Enable a MIMO configuration.
See "To enable a MIMO scenario" on page 85.

2. Select "Fading > Path Table > Matrix"

3. Navigate to the required "Tap" and select "Fading: Correlation Matrix > Matrix
Mode > SCME / WINNER"

With the provided settings you can define up to 20 clusters, each of which compris-
ing of up to 3 sub-clusters.
A cluster is defined with its AoA (Angle of Arrival) / AoD (Angle of Departure)
parameters, i.e. AoA/AoD angles, angle spreads (AS) and a relative gain. If an
sub-cluster is enabled, its is additionally attenuated; the 3 sub-clusters powers are
fixed ratios of the total cluster power (see Relative Gain /dB < Sub-Cluster)
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Different Power Azimuth Spectrum (PAS) distributions can be used to describe the
distribution of the selected cluster; however, all clusters simulated in one path
should have the same distribution.

MS Speed................................................................................................................... 101
MS DoT (Direction of Travel)...................................................................................... 101
Cluster State............................................................................................................... 101
Relative Gain /dB........................................................................................................ 101
State < Sub-Cluster.....................................................................................................101
Relative Gain /dB < Sub-Cluster................................................................................. 102
Angle of Departure (AoD)............................................................................................102
AoD Spread.................................................................................................................102
Angle of Arrival (AoA)..................................................................................................102
AoA Spread.................................................................................................................102
Distribution.................................................................................................................. 103

MS Speed
Sets the speed of the mobile station.

This value determines the value of the parameter "Speed" (see Path Table > Speed).

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:SPEed on page 175

MS DoT (Direction of Travel)
Sets the direction of travel of the mobile station.

If LOS (line-of-sight) is simulated, then the mobile station direction of travel determines
the value of the parameter Frequency Ratio for Rice fading profile.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:DOT on page 176

Cluster State
Enables/disables the selected cluster.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:STATe
on page 176

Relative Gain /dB
Sets the relative gain (in dB) of the selected cluster.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:GAIN on page 176

State < Sub-Cluster
If the corresponding cluster is enabled, you can enable up to 3 sub-clusters.

A cluster is comprises of 20 spatially separated sub-paths with equal powers. The sub-
paths are occasionally split to sub-sets or sub-clusters (also known as mid-paths) hav-
ing different resolvable delays. In the SCME and WINNER II models, one cluster can
be split into 3 sub-clusters consisting of 10, 6 and 4 sub-paths resulting in 10/20, 6/20
and 4/20 relative power to the total cluster power respectively.
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See also "Relative Gain /dB" on page 101.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:
SUBCluster<di>:STATe on page 178

Relative Gain /dB < Sub-Cluster
Displays the resulting relative attenuation, applied on an enabled sub-cluster. The
value is determined based on the select "Relative Gain" of the cluster and is calculated
as follows:

RelativeGainSub-Cluster[dB] =RelativeGainCluster[dB] + GainFactor [dB], where the used
gain factors are listed in Table 6-1.

Initially proposed by the SCME, these values are part of the SCME Urban Micro-Cell
(UMi) und SCME Urban Macro-Cell (UMa) models used in the specification 3GPP
37.977.
Table 6-1: Overview: Gain factors and default relative gain values per sub-cluster

Sub-Cluster number Gain Factor, W Gain Factor, dB

1 10/20 -3.01

2 6/20 -5.229

3 4/20 -6.99

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:
SUBCluster<di>:GAIN? on page 178

Angle of Departure (AoD)
Sets the AoD (Angle of Departure) of the selected cluster.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:ANGLe
on page 177

AoD Spread
Sets the AoD (Angle of Departure) spread (AS) of the selected cluster.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:SPRead
on page 177

Angle of Arrival (AoA)
Sets the AoA (Angle of Arrival) of the selected cluster.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:ANGLe
on page 177

AoA Spread
Sets the AoA (Angle of Arrival) spread (AS) of the selected cluster.
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Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:SPRead
on page 177

Distribution
Select one of the Power Azimuth Spectrum (PAS) distributions to determine the distri-
bution of the selected cluster. All clusters of the same tap must have the same distribu-
tion.

Tip: Use this parameter to simulate rays scattered due to obstacles with different sur-
face (see also Chapter 8.8, "TGn Settings", on page 171).

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DISTribution
on page 177

6.3.4.2 Channel Polarization and Antenna Modeling Settings

To access the "Antenna Modeling" dialog

1. Enable a MIMO configuration, e.g. a 2x2 MIMO scenario.
See "To enable a MIMO scenario" on page 85.

2. Select "Fading > Path Table > Matrix"

3. Navigate to the required "Tap" and select "Fading: Correlation Matrix > Matrix
Mode > SCME / WINNER"

4. Select "Fading: Correlation Matrix > Polarization".

5. Select "Tx Antenna Array Structure" and configure a base station (BS) antenna
polarization, e.g.:

● "Slant Angle = Cross 45°"
● "Cross Polarization Antenna Spacing = 0*λ"
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6. Select "Rx Antenna Array Structure" and configure a mobile station (MS) antenna
polarization, e.g.:

● "Slant Angle = Cross 90°"
● "Cross Polarization Antenna Spacing = 0*λ"

7. If required, change the "Antenna Pattern".
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The selected 2D antenna pattern file describes the BS and MS antenna gains of
each array element.

With the provided settings you can define the channel polarization and the antenna
array polarization angles.

See also:
● "Channel correlation matrix" on page 99
● Chapter 6.3.4.1, "SCME/WINNER Settings", on page 100

Channel Polarization Settings..................................................................................... 105
└ Channel Polarization State........................................................................... 105
└ Vertical/Horizontal Cross Polarization Power Ratio......................................105
└ S....................................................................................................................105

Tx/Rx Antenna Array Structure................................................................................... 106
└ Antenna Polarization Slant Angle................................................................. 106
└ Number of Rows (M)/Columns (N)................................................................106
└ Horizontal Spacing........................................................................................107
└ Cross Polarized Antenna Spacing................................................................ 107
└ Antenna Pattern............................................................................................108
└ User Defined Antenna Patterns per Row, Column....................................... 108

Channel Polarization Settings
Comprises the channel polarization settings.

Channel Polarization State ← Channel Polarization Settings
Enables/disables simulation of channel polarization.

If "Channel Polarization > Off", the default parameter settings are used for simulation
and not the current polarization settings.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:MODeling[:STATe] on page 178

Vertical/Horizontal Cross Polarization Power Ratio ← Channel Polarization Set-
tings
Sets the cross polarization power ratio (XPR) in dB.

XPRv = Pvv/Phv and XPRh = Phh/Pvh

The resulting channel polarization matrix S is displayed.

Remote command: 
[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:HORizontal
on page 179
[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical
on page 179

S ← Channel Polarization Settings
Displays the resulting channel polarization matrix S calculated as:
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Where:
● Svv = Shh = 1
● Svh and Shv are commonly designated as Sxy and are calculated from the equation

E{Sxy2} = Pxy
where:
– E is the expectation, i.e. the mean power per polarization component
– Pxy are derived from the selected Vertical/Horizontal Cross Polarization Power

Ratio XPR.
● It is assumed that the elements of the channel polarization matrix are uncorrelated,

i.e.:
E{SijSlk*} = 0 for i != j, k != l

Tx/Rx Antenna Array Structure
Comprises the settings necessary to define the antenna elements, i.e. the antenna
array structure and the antenna element radiation pattern for both, the transmit and
receive antenna arrays.

A figure displays the structure of the current antenna array.

See also "Antenna Modeling" on page 98.

Antenna Polarization Slant Angle ← Tx/Rx Antenna Array Structure
Set the antenna element polarization slant angle.

Available are antenna elements with following polarizations:
● horizontal polarization
● vertical polarization
● cross-polarization 45°

The slant 45° antenna is an "X" configuration. According to 3GPP TR 25.996, it is
modeled as an ideal dipole with isotropic gain.

● cross-polarization 90°
A graph displays the structure of the current antenna array.

See also "Antenna Modeling" on page 98.

Remote command: 
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLe
on page 181
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:POLarization:ANGLe
on page 181

Number of Rows (M)/Columns (N) ← Tx/Rx Antenna Array Structure
Sets the number of rows (M) and the number of columns (N) in the antenna array, see
"Antenna Modeling" on page 98.

Note: In this firmware version, only one dimensional arrays are supported.
You can define the "Horizontal Spacing" between the antenna elements but the
antenna elements are placed in one row (i.e. "Number of Rows = 1").
Antennas with co-polarization use one antenna per column, whereas antennas with
cross-polarization use two antennas per column.

The number of Tx and Rx antennas is set automatically according to the selected MxN
MIMO configuration ("System Configuration > LxMxN").
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See section "Signal Routing and System Configuration" in the R&S SMW user manual.

Example: 
In an 1x4x2 MIMO configuration, there are 4 Tx and 2 Rx antennas.
The "Tx Antenna Array" consists of 4 antennas:
● if "Antenna Polarization Slant Angle > Horizontal/Vertical", these 4 antennas are

placed in a row (4x1 array)
● if "Antenna Polarization Slant Angle > Cross-Polarization 45°/90°", there are exact

2 columns and 1 row.
The "Rx Antenna Array" contains exact 2 antennas, that can be distributed in one the
following ways:
● if "Antenna Polarization Slant Angle > Horizontal/Vertical", in 2 columns and 1 row

(2x1array)
● if "Antenna Polarization Slant Angle > Cross-Polarization 45°/90°", there is exact 1

column and 1 row
In both arrays, a distance dxp may also exist between the cross polarized antenna ele-
ments.

Remote command: 
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:COLumn:SIZE on page 180
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ROWS:SIZE on page 180

Horizontal Spacing ← Tx/Rx Antenna Array Structure
Sets the horizontal (dh) physical distance between the antennas in the antenna array
normalized by the wave length λ.

It is calculated as follows:

dh= "Horizontal Spacing" * λ, where

the wave length λ = c / "Frequency" and c is the speed of light.

See also "Antenna Modeling" on page 98.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:HORizontal
on page 180
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontal
on page 180

Cross Polarized Antenna Spacing ← Tx/Rx Antenna Array Structure
Set the physical distance (dxp) between the two antenna elements of an antenna with
cross-polarization 45° or 90° normalized by the wave length λ .

It is calculated as follow:

dxp= "Cross Polarized Antenna Spacing" * λ, where

the wave length λ = c / "Frequency" and c is the speed of light.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:CROSs
on page 180
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:CROSs on page 180
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Antenna Pattern ← Tx/Rx Antenna Array Structure
Antenna patterns are files that describe the 2D antenna radiation pattern.

Available are an "Isotropic" antenna and a "Dipole" antenna, as well as the two
antenna patterns with different number of sectors ("3 Sectors" and "6 Sectors") that are
required for the BS testing, as specified in the 3GPP TR 25.996.

You can also load a user defined antenna pattern, see "User Defined Antenna Patterns
per Row, Column" on page 108.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:PATTern on page 180
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:PATTern on page 180

User Defined Antenna Patterns per Row, Column ← Tx/Rx Antenna Array Struc-
ture
Indicates the used antenna pattern file per antenna element.

To change the used file, select the antenna element, "Select Predefined/User File",
navigate to the antenna pattern file and load it.

Antenna pattern files are XML files with file predefined file syntax and extension
*.ant_pat.

They describe the antenna pattern as an array with typical resolutions of 1 to 5 degree
for the azimuth. These files contain the loss values for a given azimuth.

For an isotropic antenna for instance, that radiates the energy equally in all directions,
the array elements are all 0 dB.

For description of the file format, see Chapter B, "Antenna Pattern File Format",
on page 282.

Remote command: 
[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog? on page 179
[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER?
on page 179
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna<di>:TX:PFILe on page 181
[:SOURce]:FSIMulator:MIMO:ANTenna<di>:RX:PFILe on page 181

6.3.5 Correlation Matrix Table

The correlation matrix table displays the values for the transmitter/receiver correlation.
The correlation matrix is valid for the selected fading path. To adjust the values, edit
the matrix elements directly, use the correlation coefficients of the Kronecker Mode,
define the TGn/TGac parameters of the AoA /AoD mode or use the SCME/WINNER
mode.

To access the settings of the correlation matrix in table form:

1. Enable a MIMO configuration

2. Select the "Fading > Path Table > Matrix" and navigate to "Fading: Correlation
Matrix > Matrix".

 

Fading Settings in MIMO Configuration



Multiple Input Multiple Output (MIMO)R&S®SMW-B14/-K71/-K72/-K74/-K75

109User Manual 1175.6826.02 ─ 09

Defining the matrix values individually

In individual matrix mode, you have to define the matrix values manually. Irrespectively
of the selected data format, you have to enter valid correlation values.

Impossible calculation and conflict settings
The individual direct definition of the matrix elements may lead to impossible calcula-
tion due to inappropriate values and/or settings conflict.
You have to change the corresponding values.

The Figure 6-9 uses a 2x2 MIMO matrix to depict the basic configuration principle.

Figure 6-9: Simplified representation of a 2x2 MIMO matrix

To define the matrix, set the only the value pairs in the diagonal and upper triangle (a
total of 10 value pairs in this example, see Figure 6-9). The instrument exploits the
complex conjugate symmetry across the diagonal and determines automatically the
remaining value pairs in the lower triangle.

By default, the values in the matrix diagonal are set to 1. Use values different than 1 to
simulate antennas with different power level (steering).

Fading Settings in MIMO Configuration
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Real/Magnitude
Enters the value for the real/ratio part of the correlation.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:
MAGNitude on page 167

Phase/Imag
Enters the value for the phase/imaginary part of the correlation.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:
PHASe on page 166

Conflict
Indicates a matrix conflict.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:CONFlict? on page 166

Accept
Accepts the values for the phase/imaginary and the real/ration part of the correlation.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ACCept on page 165

6.3.6 Relative Gain Vector Matrix Settings

The "Fading: Relative Tap Gain Vector" dialog is available for static paths and paths
with "Pure Doppler Fading Profile". This dialog provides additional parameters to simu-
late a gain weighting or phase shift between the signals with constant fading transmit-
ted over the different Tx antennas.

1. To access this dialog, enable a MIMO configuration and select "Fading > Path
Table > Profile > Static or Pure Doppler".

2. Select "Path Table > Coefficient > Vector".
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Use this function to simulate beamforming signal.

Example: 
This example illustrates the phase shift between the signals with a start phase of 45
degrees, power level of 2 dB, and the gain and phase settings as follow:
● "AA Gain > 0", "AA Phase > 0"
● "AB Gain > -1", "AB Phase > 10"
● "BA Gain > -2", "BA Phase > 20"
● "BB Gain > -3", "BB Phase > 350"

Resulting simulation:

Set to Unity
Presets the vector matrix to an unitary matrix.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:PRESet on page 167

Gain
Defines the relative gain of the selected path.

A gain value of 0 dB means no loss, and e.g. -3 dB is loss in this path.

Fading Settings in MIMO Configuration
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Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AA:GAIN on page 168
for the correct syntax of the SCPI command of the other paths, refer to the command
description.

Phase
Defines the phase shift of the selected path.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AA:PHASe on page 169
for the correct syntax of the SCPI command of the other paths, refer to the command
description.

6.4 Bypassing a Deactivated Fading Simulator

To access this setting, proceed as follow:

1. Enable "Fading > Signal Routing (MIMO) > System Configuration > Mode >
Advanced".

2. Select "Fading > Off".

3. Select "Fading > Bypass if Fading Off > On".

The fading simulator is disabled and the input basebands bypass it.

Impact of the parameter on the calculation of the output streams

The parameter determines the way the output streams are calculated, if the fading sim-
ulator is disabled:
● Disabled parameter "Bypass if Fading Off" (default state)

The fading simulator itself is disabled, but each output stream is still the linear com-
bination of the input baseband signals and depend on the current MIMO configura-
tion.
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Example: 
In a 4x2 MIMO system, for instance, the two output streams A and B are calculated
from all the four input basebands. This instrument state is indicated by the sum sym-
bols  at each output streams.
Table 6-2: Representation of the instrument state "Bypass if Fading Off > Off"

In the "System Configuration" preview diagram In the block diagram

● Enabled parameter "Bypass if Fading Off"
Bypasses the "Fading" block, i.e. the fading simulator is disabled and the base-
bands bypass unchanged the fading block.
Depending on the MIMO configuration, the block diagram visualizes this behavior
different (see Table 6-3). The absence of the sum symbols confirm the selection,
too.

Example: 
● In a 4x2 MIMO system, for instance, the two output streams A and B are identical

to the two input baseband signals A and B.
The Basebands C and D are not processed.

● Vice versa, in a 3x4 MIMO system, the three output streams A, B and C are identi-
cal to the three basebands.
The stream D is a zero stream that starts after the "Fading" block.

Bypassing a Deactivated Fading Simulator
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Table 6-3: "Bypass if Fading Off > On": Representation in the block diagram

MxN MIMO configuration,
where M>N

MxN MIMO configuration,
where M<N

"Bypass if Fading Off > ON" during troubleshooting
While performing troubleshooting, enable this parameter to exclude the impact of the
fading in the signal processing.

SCPI command:

[:SOURce]:FSIMulator:BYPass:STATe on page 118

Bypassing a Deactivated Fading Simulator
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7 Summation Ratio A/B
This parameter is available in "System Configuration > Mode > Standard", i.e. in non-
MIMO scenarios.

► To access this settings, select "Fading > Summation Ratio A/B".

The "Summation Ratio A/B" setting is used to set the ratio of the output levels of
both paths A and B in case the two faded signals are added.

Faded signals are added in case one of the following signal routing configuration
(see also Chapter 5, "Signal Routing (non-MIMO) Settings", on page 81):
● Signal Routing A to A / B to A
● Signal Routing A to B / B to B
● Signal Routing A to A&B / B to A&B

The "Summation Ration A/B" function is similar to the "Baseband Offsets > Path Gain"
function in the "Baseband" block.

The "Path Gain" represents the relative gain of the selected path compared to the
baseband signal of the other path and/or of the supplied external baseband signal. The
"Path Gain" is measured at the output of the "Baseband" blocks and is considered in
any signal routing with summed signals.

However, if the baseband signal is additionally faded and routed at the output of the
fading simulator, so that the faded signals from both paths are summed, the real path
gain is measured at the output of the "Fading" blocks and set with the parameter "Sum-
mation Ratio A/B".

The relative gain set with the parameter "Path Gain" in the "Baseband" block is
ignored.

A positive value of the parameter "Summation Ration A/B" indicates a stronger signal
on path A; respectively a negative value indicates a stronger signal on path B.

SCPI command:

[:SOURce<hw>]:FSIMulator:SUM:RATio on page 134
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8 Remote-Control Commands
This subsystem contains the commands necessary to configure the fading simulator in
a remote environment. We assume that the R&S SMW has already been set up for
remote operation in a network as described in the R&S SMW documentation. A knowl-
edge about the remote control operation and the SCPI command syntax are assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMW user manual.

Required Options

All SCPI commands described in this section, require at least the R&S SMW-B14
option. For better overview, this option is not listed at each command. Additionally
required options, however, are listed.

The dynamic fading configurations (Birth Death, Moving Propagation, 2 Channel Inter-
ferer and High Speed Train) are available with option R&S SMW-K71.

See also Chapter 3.1, "Required Options", on page 17.

Common Suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

ENTity<ch> 1 .. 8 entity in a multiple entity configuration

ENTity3|4|5|6|7|8 require option R&S SMW-K76

SOURce<hw> [1]|2 .. 8 available faders

SOURce3|4|5|6|7|8 require option R&S SMW-K76

only SOURce1 possible, if the keyword ENTity is used

GROup<st> [1]|2...4 available fading path groups

PATH<ch> [1]|2..5 available fading paths

TAP<ch> [1]...10 available MIMO taps

RAY<st> [1]...6 available SCM clusters/rays

CLUSter<ch> [1]...20 available SCME/WIMMER clusters

Using SCPI command aliases for advanced mode with multiple entities
You can address multiple entities configurations by using the SCPI commands starting
with the keyword SOURce or the alias commands starting with the keyword ENTity.

Note that the meaning of the keyword SOURce<hw> changes in the second case.

For details, see section "SCPI Command Aliases for Advanced Mode with Multiple
Entities" in the R&S SMW user manual.
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Programming examples

This description provides simple programming examples. The purpose of the examples
is to present all commands for a given task. In real applications, one would rather
reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the example
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (e.g. comments) start with two // characters.

At the beginning of the most remote control program, an instrument (p)reset is recom-
mended to set the instrument to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

The following commands specific to the fading simulator are described here:

● General Settings................................................................................................... 117
● Birth Death............................................................................................................ 138
● Delay Modes......................................................................................................... 142
● High Speed Train.................................................................................................. 152
● Moving Propagation.............................................................................................. 156
● MIMO Settings...................................................................................................... 161
● MIMO Vector Settings...........................................................................................168
● TGn Settings......................................................................................................... 171
● SCME, WINNER I, WINNER II and Antenna Model Settings............................... 174
● 2 Channel Interferer.............................................................................................. 181
● Custom Fading Profile...........................................................................................185

8.1 General Settings

[:SOURce]:FSIMulator:BYPass:STATe.............................................................................118
[:SOURce<hw>]:FSIMulator:CONFiguration......................................................................118
[:SOURce<hw>]:FSIMulator:SISO:COPY......................................................................... 119
[:SOURce<hw>]:FSIMulator:COPY:DESTination...............................................................119
[:SOURce<hw>]:FSIMulator:COPY:EXECute....................................................................119
[:SOURce<hw>]:FSIMulator:COPY:SOURce.................................................................... 119
[:SOURce<hw>]:FSIMulator:FREQuency..........................................................................120
[:SOURce<hw>]:FSIMulator:CLOCk:RATE?..................................................................... 120
[:SOURce<hw>]:FSIMulator:GLOBal:SEED......................................................................120
[:SOURce<hw>]:FSIMulator:HOPPing:MODE................................................................... 121
[:SOURce<hw>]:FSIMulator:IGNore:RFCHanges.............................................................. 121
[:SOURce<hw>]:FSIMulator:ILOSs:CSAMples?................................................................ 122
[:SOURce<hw>]:FSIMulator:ILOSs:MODE........................................................................122
[:SOURce<hw>]:FSIMulator:ILOSs[:LOSS].......................................................................122
[:SOURce<hw>]:FSIMulator:KCONstant...........................................................................123
[:SOURce<hw>]:FSIMulator:PRESet................................................................................123
[:SOURce<hw>]:FSIMulator:RESTart:MODE.................................................................... 123
[:SOURce<hw>]:FSIMulator:ROUTe................................................................................ 123
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[:SOURce<hw>]:FSIMulator:SDEStination........................................................................127
[:SOURce<hw>]:FSIMulator:FREQuency:DETect?............................................................ 127
[:SOURce<hw>]:FSIMulator:SPEed:UNIT.........................................................................128
[:SOURce<hw>]:FSIMulator:STANdard............................................................................ 128
[:SOURce<hw>]:FSIMulator:STANdard:REFerence...........................................................134
[:SOURce<hw>]:FSIMulator:SUM:RATio.......................................................................... 134
[:SOURce<hw>]:FSIMulator[:STATe]............................................................................... 134
[:SOURce]:FSIMulator:CATalog?.....................................................................................135
[:SOURce<hw>]:FSIMulator:LOAD.................................................................................. 135
[:SOURce]:FSIMulator:DELETE.......................................................................................136
[:SOURce<hw>]:FSIMulator:STORe................................................................................ 136
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:CSTD................................................... 136
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:LCONstant............................................ 136
[:SOURce<hw>]:FSIMulator:COUPle:SPEed.................................................................... 137
[:SOURce<hw>]:FSIMulator:CSPeed............................................................................... 137

[:SOURce]:FSIMulator:BYPass:STATe <BypState>

Enables/disables bypassing of the fading simulator if the simulator is deactivated.

Parameters:
<BypState> 0 | 1 | OFF | ON

*RST: 0

[:SOURce<hw>]:FSIMulator:CONFiguration <Configuration>

Sets the fading configuration.

To activate the selected fading configuration, use the remote-control command for
switching the state.

Parameters:
<Configuration> STANdard | BIRThdeath | MDELay | UDYNamic | TCInterferer |

HSTRain
STANdard|BIRThdeath|MDELay|TCInterferer|HSTRain
Defines the configuration: Standard delay, Birth Death Propaga-
tion, Moving Propagation, 2 Channel Interferer and High Speed
Train propagation.
UDYNamic
The User Dynamic configuration is provided for future use.
*RST: STANdard

Example: SOURce1:FSIMulator:CONFiguration MDELay
selects a moving propagation configuration.
SOURce1:FSIMulator:MDELay:STATe ON
activates the moving propagation for fader A.

Manual operation: See "Configuration" on page 27

General Settings
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[:SOURce<hw>]:FSIMulator:SISO:COPY <CopyToDest>

In "System Configurations" with multiple entities (L > 2), copies the settings of the cur-
rent fading simulator to all or to the selected entities.

Parameters:
<CopyToDest> FADB | FADA | FADC | FADD | FADF | FADE | FADG | FADH |

ALL
*RST: ALL

Example: SOURce1:FSIMulator:SISO:COPY ALL
Options: R&S SMW-K76

Manual operation: See "Copy To / Entity" on page 25

[:SOURce<hw>]:FSIMulator:COPY:DESTination <Destination>

Selects a group whose settings will be overwritten.

Parameters:
<Destination> integer

Range: 1  to  4 (Standard Delay)/ 8 (Fine Delay)
*RST: 2

Example: see [:SOURce<hw>]:FSIMulator:COPY:SOURce
on page 119

Manual operation: See "To" on page 43

[:SOURce<hw>]:FSIMulator:COPY:EXECute

Copies the settings of a fading path group to the selected one.

Example: see [:SOURce<hw>]:FSIMulator:COPY:SOURce
on page 119

Usage: Event

Manual operation: See "Copy" on page 43

[:SOURce<hw>]:FSIMulator:COPY:SOURce <Source>

Sets the group whose settings are to be copied.

Parameters:
<Source> integer

Range: 1  to  8
*RST: 1

General Settings
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Example: FSIM:DEL:STAT ON
FSIM:COPY:DEST 4
FSIM:COPY:SOUR 1
FSIM:COPY:EXEC
// copies the settings from group 1 to group 4

Manual operation: See "Copy Path Group" on page 43

[:SOURce<hw>]:FSIMulator:FREQuency <Frequency>

● If [:SOURce<hw>]:FSIMulator:SDEStinationRF is selected, queries the
estimated RF frequency.

● If [:SOURce<hw>]:FSIMulator:SDEStinationBB is selected, sets the fre-
quency used for the calculation of the Doppler shift.

Parameters:
<Frequency> float

Range: 1E5  to  100E9
Increment: 0.01
*RST: 1E9
Default unit: Hz

Example: SOURce1:FSIMulator:SDEStination RF
SOURce1:FSIMulator:FREQuency?

SOURce1:FSIMulator:SDEStination BB
SOURce1:FSIMulator:FREQuency 2143200000

Manual operation: See "Dedicated Frequency" on page 32
See "Virtual RF" on page 32

[:SOURce<hw>]:FSIMulator:CLOCk:RATE?

Queries the clock rate the fading simulator is using for the signal processing.

Return values: 
<ClockRate> CR200 | CR100 | CR050 | CR025

CR200 = 200 MHz, CR100 = 100 MHz, CR050 = 50 MHz,
CR025 = 25 MHz
*RST: CR200

Usage: Query only

Manual operation: See "Fading Clock Rate" on page 29

[:SOURce<hw>]:FSIMulator:GLOBal:SEED <Seed>

This command enters the fading start seed. This value is global for the instrument.

General Settings
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Parameters:
<Seed> integer

Range: 0  to  9
*RST: 0

Example: FSIM:GLOB:SEED 2
sets the start seed to 2

Manual operation: See "Start Seed" on page 40

[:SOURce<hw>]:FSIMulator:HOPPing:MODE <Mode>

Activates frequency hopping and determines how fading is resumed after a frequency
hop.

Note: Prior to activating frequency hopping, list mode and the desired frequency table
must be activated.

Parameters:
<Mode> OFF | IBANd | OOBand

OFF
Frequency hopping is deactivated.
IBANd
Activates an in-band frequency hopping.
OOBand
Activates an out of band frequency hopping.
*RST: OFF

Example: MMEM:CDIR "/var/user/fading"
sets the default directory.
LIST:SELect "fading1"
selects the file fading1 with the frequency values for the fre-
quency hops.
LIST:DWEL 2E-3
sets a dwell time of 2 ms between two frequency hops.
LIST:MODE AUTO
selects untriggered list mode.
FREQ:MODE LIST
activates list mode.
FSIM:HOPP:MODE IBAN
activates an in band frequency hopping. The fading process is
restarted after a hop back.

Manual operation: See "Freq. Hopping Mode" on page 33

[:SOURce<hw>]:FSIMulator:IGNore:RFCHanges <RfChanges>

(instruments with RF output only)

This command determines whether frequency changes < 5% are ignored. This enables
faster frequency hopping.

General Settings
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Parameters:
<RfChanges> 0 | 1 | OFF | ON

*RST: 0

Example: FSIM:IGN:RFCH ON
Ignores frequency changes < 5% for the fading.

Manual operation: See "Ignore RF Changes < 5PCT" on page 32

[:SOURce<hw>]:FSIMulator:ILOSs:CSAMples?

This command queries the share of samples which were clipped due to the insertion
loss setting.

Return values: 
<CSamples> string

Example: FSIM:ILOS:CSAM?
queries the share of samples which were clipped.
Response: 11
11% of the samples were clipped.

Usage: Query only

Manual operation: See "Clipped Samples" on page 39

[:SOURce<hw>]:FSIMulator:ILOSs:MODE <Mode>

This command sets the insertion loss of the fading simulator.

Parameters:
<Mode> NORMal | LACP | USER

NORMal
The minimum insertion loss for a path of the fading simulator is
set to a fixed value of 18 dB.
*RST: NORMal

Example: FSIM:ILOS:MODE USER
chooses the user-defined setting for the insertion loss.
FSIM:ILOS 4 dB
sets the minimum insertion loss to 4 dB.

Manual operation: See "Insertion Loss Mode" on page 38

[:SOURce<hw>]:FSIMulator:ILOSs[:LOSS] <Loss>

This command sets the user-defined insertion loss of the fading simulator when "User"
is selected.

In the "Normal" and "Low ACP" modes, the current setting of the value can be queried.

General Settings
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Parameters:
<Loss> float

Range: -3  to  30
Increment: 0.1
*RST: 0
Default unit: dB

Example: FSIM:ILOS:MODE USER
chooses the user-defined setting for the insertion loss.
FSIM:ILOS 4 dB
sets the minimum insertion loss to 4 dB.

Manual operation: See "Insertion Loss" on page 38

[:SOURce<hw>]:FSIMulator:KCONstant <KConstant>

Selects whether to keep the speed or the resulting Doppler shift constant in case of fre-
quency changes.

Parameters:
<KConstant> SPEed | DSHift

*RST: SPEed

Example: FSIM:KCON SPE
keeps the speed constant in case of frequency changes.

Manual operation: See "Keep Constant" on page 43

[:SOURce<hw>]:FSIMulator:PRESet

Sets the default settings (*RST values) for fading simulation.

Example: SOURce1:FSIMulator:PRESet
Usage: Event

Manual operation: See "Set to Default" on page 26

[:SOURce<hw>]:FSIMulator:RESTart:MODE <Mode>

Selects how a restart of fading simulation is triggered.

Parameters:
<Mode> AUTO

*RST: AUTO

Manual operation: See "Restart Mode" on page 34

[:SOURce<hw>]:FSIMulator:ROUTe <Route>

Selects on which baseband path the faded signal is output. The input signal of the
fader is selected with command SOURce:BB:ROUTe.

General Settings
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For one-path instruments this command is query only. It returns value FAA (Fader A
always outputs the signal on baseband A).

Note: All MIMO configurations are enabled only in :SCONfiguration:MODE
ADVanced.

:SCONfiguration:
MODE

:SCONfiguration:FADing
<FadConfig>

[:SOURce<hw>]:FSIMulator:ROUTe

STANdard FAAFBNone
FAAFBB
FAAFBA
FABFBB
FAABFBN
FANFBAB
FAABFBAB

FAMAXAB
FAAFBB
FAAFBA
FABFBB
FAMAXAB
FBMAXAB
FAABFBAB

ADVanced MIMO1X2
MIMO1X3
MIMO1X4
MIMO2X2
MIMO2X3
MIMO2X4
MIMO3X1
MIMO3X2
MIMO3X3
MIMO3X4
MIMO4X1
MIMO4X2
MIMO4X3
MIMO4X4
MIMO1X8
MIMO8X1
MIMO2X8
MIMO8X2
MIMO2X1
MIMO4X8
MIMO8X4

FA1A2BFB1A2BM12
FA1A2BFB1A2BM13
FA1A2BFB1A2BM14
FA1A2BFB1A2B|FA1A2BFB1A2BM22
FA1A2BFB1A2BM23
FA1A2BFB1A2BM24
FA1A2BFB1A2BM31
FA1A2BFB1A2BM32
FA1A2BFB1A2BM33
FA1A2BFB1A2BM34
FA1A2BFB1A2BM41
FA1A2BFB1A2BM42
FA1A2BFB1A2BM43
FA1A2BFB1A2BM44
FA1A2BFB1A2BM18
FA1A2BFB1A2BM81
FA1A2BFB1A2BM28
FA1A2BFB1A2BM82
FA1A2BFB1A2BM21
FA1A2BFB1A2BM48
FA1A2BFB1A2BM84

 MIMO2X1X2
MIMO2X2X1
MIMO2X2X2
MIMO2X1X3
MIMO2X1X4
MIMO2X2X3
MIMO2X3X1
MIMO2X3X2
MIMO2X4X1

FA1A2BFB1A2BM212
FA1A2BFB1A2BM221
FA1A2BFB1A2BM222
FA1A2BFB1A2BM213
FA1A2BFB1A2BM214
FA1A2BFB1A2BM223
FA1A2BFB1A2BM231
FA1A2BFB1A2BM232
FA1A2BFB1A2BM241
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:SCONfiguration:
MODE

:SCONfiguration:FADing
<FadConfig>

[:SOURce<hw>]:FSIMulator:ROUTe

 MIMO3X1X2
MIMO3X2X1
MIMO3X2X2
MIMO4X1X2
MIMO4X2X1
MIMO4X2X2

FA1A2BFB1A2BM312
FA1A2BFB1A2BM321
FA1A2BFB1A2BM322
FA1A2BFB1A2BM412
FA1A2BFB1A2BM421
FA1A2BFB1A2BM422

 SISO3X1X1
SISO4X1X1
SISO5X1X1
SISO6X1X1
SISO7X1X1
SISO8X1X1

FAAFBB311
FAAFBB411
FAAFBB511
FAAFBB611
FAAFBB711
FAAFBB811

 MIMO2X2X4
MIMO2X4X2
MIMO2X4X4
MIMO2X3X3
MIMO2X3X4
MIMO2X4X3

FA1A2BFB1A2BM224
FA1A2BFB1A2BM242
FA1A2BFB1A2BM244
FA1A2BFB1A2BM233
FA1A2BFB1A2BM234
FA1A2BFB1A2BM243
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Parameters:
<Route> FAA | FAMAXAB | FAAFBA | FAAFBB | FABFBB | FBMAXAB |

FAABFBAB | FA1A2BFB1A2B | FA1A2BFB1A2BM22 |
FA1A2BFB1A2BM24 | FA1A2BFB1A2BM42 |
FA1A2BFB1A2BM23 | FA1A2BFB1A2BM32 |
FA1A2BFB1A2BM12 | FA1A2BFB1A2BM33 |
FA1A2BFB1A2BM34 | FA1A2BFB1A2BM43 |
FA1A2BFB1A2BM44 | FA1A2BFB1A2BM18 |
FA1A2BFB1A2BM81 | FA1A2BFB1A2BM28 |
FA1A2BFB1A2BM82 | FA1A2BFB1A2BM21 |
FA1A2BFB1A2BM212 | FA1A2BFB1A2BM221 |
FA1A2BFB1A2BM222 | FA1A2BFB1A2BM13 |
FA1A2BFB1A2BM31 | FA1A2BFB1A2BM14 |
FA1A2BFB1A2BM41 | FAMAXA | FA1A2BFB1A2BM224 |
FA1A2BFB1A2BM242 | FA1A2BFB1A2BM48 |
FA1A2BFB1A2BM84 | FA1A2BFB1A2BM312 |
FA1A2BFB1A2BM321 | FA1A2BFB1A2BM322 |
FA1A2BFB1A2BM412 | FA1A2BFB1A2BM421 |
FA1A2BFB1A2BM422 | FAAFBB311 | FAAFBB411 |
FAAFBB511 | FAAFBB611 | FAAFBB711 | FAAFBB811 |
FA1A2BFB1A2BM213 | FA1A2BFB1A2BM214 |
FA1A2BFB1A2BM223 | FA1A2BFB1A2BM231 |
FA1A2BFB1A2BM232 | FA1A2BFB1A2BM241 |
FA1A2BFB1A2BM244 | FA1A2BFB1A2BM233 |
FA1A2BFB1A2BM234 | FA1A2BFB1A2BM243
FAA
The faded modulation signal of fader A is placed on baseband
path A.
FAAFBB
The faded modulation signal of fader A is placed on baseband
path A and the faded modulation signal of fader B is placed on
baseband path B.
FAAFBA
The faded modulation signal of fader A and B is placed on base-
band path A.
FABFBB
The faded modulation signal of fader A and B is placed on base-
band path B.
FAABFBAB
The faded modulation signal of fader A and B is placed on base-
band paths A and B.
FAMAXA
The faded modulation signal of fader A is placed on baseband
path A.
FBMAXB
The faded modulation signal of fader B is placed on baseband
path B.
FAMAXAB
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The faded modulation signal of fader A is placed on baseband
paths A and B.
FBMAXAB
The faded modulation signal of fader B is placed on baseband
paths A and B.
FA1A2BFB1A2B|FA1A2BFB1A2BM22| ... |FAAFBB811
sets a MIMO mode

Example: FSIM:ROUT FA1A2BFB1A2BM24
selects a 1x2X4 MIMO configuration

Options: LxMxN configurations with L > 2 require option R&S SMW-K76
higher order MIMO configurations require option R&S SMW-K75

Manual operation: See "Signal Routing" on page 81

[:SOURce<hw>]:FSIMulator:SDEStination <SDestination>

Defines the frequency to that the signal of the whole Fader block is dedicated.

Parameters:
<SDestination> RF | BB

RF
The Doppler shift is calculated based on the actual RF fre-
quency, that is dynamically estimated.
To query the estimated dedicated frequency, use the command
[:SOURce<hw>]:FSIMulator:FREQuency.
To query the output connector, use the command [:
SOURce<hw>]:FSIMulator:FREQuency:DETect?
on page 127.
BB
Set the fader frequency manually by means of the command [:
SOURce<hw>]:FSIMulator:FREQuency.

*RST: RF

Example: see [:SOURce<hw>]:FSIMulator:FREQuency on page 120

Manual operation: See "Signal Dedicated To" on page 29

[:SOURce<hw>]:FSIMulator:FREQuency:DETect?

Queries the output interface the steam used to estimate the dedicated frequency is
mapped to.

Return values: 
<DetectMaster> RFA | BBMM1 | RFB | BBMM2 | IQOUT1 | IQOUT2 | FAD1 |

FAD2 | FAD4 | FAD3 | DEF

Example: :SOURce1:FSIMulator:FREQ:DETect?

Usage: Query only
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Manual operation: See "Dedicated Connector" on page 32

[:SOURce<hw>]:FSIMulator:SPEed:UNIT <Unit>

This command chooses the default unit for the parameter speed as displayed in the
dialog.

Note: The remote control command changes only the units displayed in the graphical
user interface. While configuring the speed via remote control, the speed units must be
specified.

Parameters:
<Unit> MPS | KMH | MPH | NMPH

*RST: KMH

Example: FSIM:SPE:UNIT MPS
sets meters per second as the default unit for the speed param-
eter as displayed in the graphical user interface.

Manual operation: See "Speed Unit" on page 42

[:SOURce<hw>]:FSIMulator:STANdard <Standard>

Selects a predefined fading simulator setting which complies with the test specifica-
tions found in the common mobile radio standards.

For a detailed summary of all of the default settings, see Chapter A, "Predefined Fad-
ing Settings", on page 188.

Standard / Test Case <Predefined_Standard> Description

- USER USER parameter cannot be
set. A query returns this value
if a user-defined Fading set-
ting was loaded or if one of
the associated settings was
changed subsequent to the
selection of a standard

CDMA

see Chapter A.1, "CDMA Stand-
ards", on page 188

CDMA0 | CDMA3 | CDMA8 |
CDMA30 | C1DMA30 | CDMA100

CDMA 5 (0 km/h), CDMA6
(3km/h), CDMA1 (8 km/h),
CDMA2 (30 km/h), CDMA3
(30 km/h, 1 path), CDMA4
(100km/h)

GSM

see Chapter A.2, "GSM Stand-
ards", on page 191

GTU1P5 | G6TU1P5 | GTU3P6 |
G6TU3P6 | GTU3 | G6TU3 | GTU6 |
G6TU6 | GTU50 | G6TU50 |
G6TU100 | G6TU60

GSM Typical Urban
1,5/3/3,6/6/50/60/100 km/h, 6
and 12 path

 GHT100 | G6HT100 | GHT120 |
G6HT120 | GHT200 | G6HT200

GSM Hilly Terrain 100/120
km/h, 6 and 12 path

 GRA130 | GRA250 | GRA300 |
GRA500

GSM Rural Area
130/250/300/500 km/h, 6 path

 GET50 | GET60 | GET100 GSM Equal Test 50/60/100
km/h, 6 path
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Standard / Test Case <Predefined_Standard> Description

 GTI5 GSM typical case for very
small cells, 5km/h, 2 path

NADC

see Chapter A.3, "NADC Stand-
ards", on page 196

NADC8 | NADC50 | NADC100 NADC 8/50/100 km/h, 2 path

DCS1800/PCS1900

see Chapter A.4, "PCN Stand-
ards", on page 197

P6TU1 | PTU1 | P6TU50 | PTU50 Typical Urban 1/50m´km/h, 6
and 12 path

 P6HT100 | PHT100 Hilly Terrain 100 km/h, 6 and
12 path

 PRA130 Rural Area 130 km/h, 6 path.

 PET50 | PET100 Equal Test 50/100 km/h, 6
path

TETRA

see Chapter A.5, "TETRA Stand-
ards", on page 202

TTU | T6TU TETRA Typical Urban
50km/h, 2 path and 6 path

 TBU TETRA 2 path

 THT | T6HT TETRA Hilly Terrain 200
km/h, 2 path and 6 path

 T4ET TETRA Equal Test 200 km/h,
4 path

 TDU TETRA Mode Direct Mode
Rural Propagation Model 1
path

 TDR TETRA Mode Urban Propa-
gation Mode 1 path

3GPP FDD

see Chapter A.6, "3GPP Stand-
ards", on page 206

G3C1 | G3C2 | G3C3 | G3C4 3GPP FDD Test Case x (BS)

 G3UEC1 | G3UEC2 | G3UEC3 |
G3UEC4 | G3UEC5 | G3UEC6

3GPP FDD UE Test Case x
(UE)

 G3UEC7SE 3GPP FDD UE Sector (UE)

 G3UEC7BE 3GPP FDD Beam (UE)

 G3UEC8CQ 3GPP FDD CQI (UE)

 G3UEPA3 | G3UEPB3 3GPP FDD Pedestrian A 4
path / B 6 path (UE)

 G3UEVA3 | G3UEVA30 |
G3UEVA120

3GPP FDD Vehicular A 6
path (UE)

 G3MBSFN3 3GPP MBSFN

 G3TU3 | G3TU50 | G3TU120 3GPP FDD Typical Urban 20
path

General Settings



Remote-Control CommandsR&S®SMW-B14/-K71/-K72/-K74/-K75

130User Manual 1175.6826.02 ─ 09

Standard / Test Case <Predefined_Standard> Description

 G3HT120 3GPP FDD Hilly Terrain 20
path

 G3RA120 | G3RA250 3GPP FDD Rural Area 10
path

 BD1 3GPP Birth Death 2 path

Moving Propagation MD1 3GPP Moving Propagation
"Ref. + Moving Channel",
2path

see Chapter A.15, "3GPP/LTE
Moving Propagation",
on page 252

MPLTEETU200 3GPP Moving Propagation
scenario 1 "ETU200Hz",
according to the test case
3GPP TS36.141, annex B4.

 MPLTEPDOPP 3GPP Moving Propagation
scenario 2 "AWGN", accord-
ing to the test case
3GPP TS36.141, annex B4.

3GPP High Speed Train scenar-
ios

G3HST1OS | G3HST1OSDU 3GPP HST1 "Open space",
according to the test case
3GPP TS25.141, annex D.4A
and 3GPP TS36.141, annex
B.3

see Chapter A.14, "3GPP/LTE
High Speed Train", on page 250

G3HST2TLC | G3HST2TLCDU 3GPP HST2 "Tunnel with
leaky cable", according to the
test case 3GPP TS25.141,
annex D.4A

 G3HST3TMA | G3HST3TMADU 3GPP HST3 "Tunnel for multi-
antennas", according to the
test case 3GPP TS25.141,
annex D.4A and
3GPP TS36.141, annex B.3

SCME UMi 3kmh/30kmh

SCME UMa 3kmh/30kmh

see Chapter A.16, "SCME Chan-
nel Models for MIMO OTA",
on page 254

G3SCMEUMA3 | G3SCMEUMA30 |
G3SCMEUMI3 | G3SCMEUMI30

SCME Urban Micro/Macro-
Cell Channel, 3 km/h and 30
km/h

WLAN

see Chapter A.7, "WLAN Stand-
ards", on page 217

HL2A | HL2B | HL2C | HL2D | HL2E WLAN HyperLan 18 path

DAB

see Chapter A.8, "DAB Stand-
ards", on page 222

DABRA04 | DABRA06 DAB Rural Area 4 and 6 path

 DABTU12 | DABTU06 DAB Typical Urban 12 and 6
path

 DABSFN DAB Single Frequency Net-
work (in the VHF range) 7
path
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Standard / Test Case <Predefined_Standard> Description

WiMAX WMITUOIPA | WMITUOIPB | WMI-
TUVA60 | WMITUVA120

Wimax ITU OIP-A, ITU OIP-B,

ITU V-A-60, ITU V-A-120

see Chapter A.9, "WIMAX Stand-
ards", on page 224

WMSUI1A360P90 |
WMSUI1A360P75 |
WMSUI1A030P90 |
WMSUI1A030P75

SUI 1 (omi ant. 90/75%),

SUI 1 (30 ant. 90/75%)

 WMSUI2A360P90 |
WMSUI2A360P75 |
WMSUI2A030P90 |
WMSUI2A030P75

SUI 2 (omi ant. 90/75%),

SUI 2 (30 ant. 90/75%)

 WMSUI3A360P90 |
WMSUI3A360P75 |
WMSUI3A030P90 |
WMSUI3A030P75

SUI 3 (omi ant. 90/75%),

SUI 3 (30 ant. 90/75%)

 WMSUI4A360P90 |
WMSUI4A360P75 |
WMSUI4A030P90 |
WMSUI4A030P75

SUI 4 (omi ant. 90/75%),

SUI 4 (30 ant. 90/75%)

 WMSUI5A360P90 |
WMSUI5A360P75 |
WMSUI5A360P50 |
WMSUI5A030P90 |
WMSUI5A030P75 |
WMSUI5A030P50

SUI 5 (omi ant. 90/75/50%),

SUI 5 (30 ant. 90/75/50%)

 WMSUI6A360P90 |
WMSUI6A360P75 |
WMSUI6A360P50 |
WMSUI6A030P90 |
WMSUI6A030P75 |
WMSUI6A030P50 |

SUI 6 (omi ant. 90/75/50%),

SUI 6 (30 ant. 90/75/50%)

WiMAX-MIMO

see Chapter A.12, "WIMAX-MIMO
Standards", on page 242

WMITUPB3L | WMITUPB3M | WMI-
TUPB3H | WMITUVA60L | WMI-
TUVA60M | WMITUVA60H

ITU PB Low/Medium/High,

ITU VA Low/Medium/High

LTE

see Chapter A.10, "LTE Stand-
ards", on page 237

LTEEPA5 | LTEEVA5 | LTEEVA70 |
LTEETU70 | LTEETU300 |
LTEMBSFN5

LTE EPA 5Hz ,
LTE EVA 5/70Hz,
LTE ETU 70/300Hz,

LTE MBSFN 5Hz

LTE-MIMO

see Chapter A.11, "LTE-MIMO
Standards", on page 240

LMEPA5L | LMEPA5M | LMEPA5H |
LMEVA5L | LMEVA5M | LMEVA5H |
LMEVA70L | LMEVA70M |
LMEVA70H | LMETU70L |
LMETU70M | LMETU70H |
LMETU300L | LMETU300M |
LMETU300H

LTE EPA 5Hz Low/Medium/
High, LTE EVA 5/70Hz Low/
Medium/High,
LTE ETU 70/300Hz Low/
Medium/High

1xEVDO

see Chapter A.13, "1xEVDO
Standards", on page 246

EVDO1CH1 | EVDO1CH1BC5 |
EVDO1CH2 | EVDO1CH2BC5 |
EVDO1CH3 | EVDO1CH3BC5 |
EVDO1CH4 | EVDO1CH4BC5 |
EVDO1CH5 | EVDO1CH5BC5

1xEVDO Chan. 1/2/3/4/5
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Standard / Test Case <Predefined_Standard> Description

WATTERSON

see Chapter A.17, "Watterson
Standards", on page 256

WATTI1 | WATTI3 | WATTI2 Watterson I1, I2, I3

802.11n-SISO

see Chapter A.18, "802.11n-SISO
Standards", on page 258

WLANNSMODA | WLANNSMODB |
WLANNSMODC | WLANNSMODD |
WLANNSMODE | WLANNSMODF

802.11n SISO Model
A/B/C/D/E/F

802.11n-MIMO

see Chapter A.19, "802.11n-
MIMO Standards", on page 258

WLANNMODA | WLANNMODB |
WLANNMODC | WLANNMODD |
WLANNMODE | WLANNMODF

802.11n MIMO Model
A/B/C/D/E/F

802.11ac-SISO

see Chapter A.21, "802.11ac-
SISO Standards", on page 279

WLANACSMODA|WLANACSMODB|
WLANACSMODC|WLANACSMODD|
WLANACSMODE|WLANACSMODF

802.11ac SISO Model
A/B/C/D/E/F

802.11ac-MIMO

see Chapter A.20, "802.11ac-
MIMO Standards", on page 269

WLANACMODA | WLANACMODB |
WLANACMODC | WLANACMODD |
WLANACMODE | WLANACMODF

802.11ac MIMO Model
A/B/C/D/E/F

802.11p

see Chapter A.22, "802.11p
Channel Models", on page 280

WLANPRURALLOS | WLANPURBA-
NAPPLOS | WLANPURBANCRON-
LOS | WLANPHIGHWAYNLOS |
WLANPHIGHWAYLOS

802.11p Channel models:
Rural LOS, Urban Approach-
ing LOS, Urban Crossing
NLOS, Highway LOS, High-
way NLOS
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Parameters:
<Standard> USER | CDMA8 | CDMA30 | C1DMA30 | CDMA100 | CDMA0 |

CDMA3 | G6TU3 | GTU3 | G6TU50 | GTU50 | G6HT100 |
GHT100 | GRA250 | GET50 | GET100 | HL2A | HL2B | HL2C |
HL2D | HL2E | NADC8 | NADC50 | NADC100 | P6TU1 | PTU1 |
P6TU50 | PTU50 | P6HT100 | PHT100 | PRA130 | PET50 |
PET100 | TTU | TBU | THT | T4ET | G3C1 | G3C2 | G3C3 |
G3C4 | G3UEC4 | G3UEC5 | G3UEC6 | G3UEC7SE |
G3UEC7BE | G3UEC8CQ | G3UEPA3 | G3UEPB3 |
G3UEVA30 | G3UEVA120 | G3TU3 | G3TU50 | G3TU120 |
G3HT120 | G3RA120 | G3RA250 | BD1 | MP1 | DABRA04 |
DABRA06 | DABTU12 | DABTU06 | DABSFN |
WMSUI1A360P90 | WMSUI1A360P75 | WMSUI1A030P90 |
WMSUI1A030P75 | WMSUI2A360P90 | WMSUI2A360P75 |
WMSUI2A030P90 | WMSUI2A030P75 | WMSUI3A360P90 |
WMSUI3A360P75 | WMSUI3A030P90 | WMSUI3A030P75 |
WMSUI4A360P90 | WMSUI4A360P75 | WMSUI4A030P90 |
WMSUI4A030P75 | WMSUI5A360P90 | WMSUI5A360P75 |
WMSUI5A360P50 | WMSUI5A030P90 | WMSUI5A030P75 |
WMSUI5A030P50 | WMSUI6A360P90 | WMSUI6A360P75 |
WMSUI6A360P50 | WMSUI6A030P90 | WMSUI6A030P75 |
WMSUI6A030P50 | WMITUOIPA | WMITUOIPB | WMITUVA60 |
TDU | TDR | WMITUVA120 | GET60 | G6HT120 | G6HT200 |
GRA130 | GRA300 | GRA500 | G6TU1P5 | G6TU3P6 | G6TU6 |
G6TU60 | G6TU100 | GHT120 | GHT200 | GTU1P5 | GTU3P6 |
GTU6 | GTU60 | GTU100 | LMEPA5L | LMEPA5M | LMEPA5H |
LMEVA5L | LMEVA5M | LMEVA5H | LMEVA70L | LMEVA70M |
LMEVA70H | LMETU70L | LMETU70M | LMETU70H |
LMETU300L | LMETU300M | LMETU300H | WMITUPB3L |
WMITUPB3M | WMITUPB3H | WMITUVA60L | WMITUVA60M |
WMITUVA60H | EVDO1CH1 | EVDO1CH1BC5 | EVDO1CH2 |
EVDO1CH2BC5 | EVDO1CH3 | EVDO1CH3BC5 | EVDO1CH4 |
EVDO1CH4BC5 | EVDO1CH5 | EVDO1CH5BC5 | G3HST1OS |
G3HST2TLC | G3HST3TMA | MPLTEETU200 | MPLTEPDOPP |
T6TU | T6HT | LTEEPA5 | LTEEVA5 | LTEEVA70 | LTEETU70 |
LTEETU300 | G3UEC1 | G3UEC2 | G3UEC3 | G3UEVA3 |
G3MBSFN3 | WATTI1 | WATTI3 | WATTI2 | GTI5 |
G3HST1OSDU | G3HST2TLCDU | G3HST3TMADU |
LTEMBSFN5 | LTECQI5 | LTEETU30 | LMETU30L |
LMETU30M | LMETU30H | WLANNMODA | WLANNMODB |
WLANNMODC | WLANNMODD | WLANNMODE |
WLANNMODF | WLANACMODA | WLANACMODB |
WLANACMODC | WLANACMODD | WLANACMODE |
WLANACMODF | WLANNSMODA | WLANNSMODB |
WLANNSMODC | WLANNSMODD | WLANNSMODE |
WLANNSMODF | WLANACSMODA | WLANACSMODB |
WLANACSMODC | WLANACSMODD | WLANACSMODE |
WLANACSMODF | G3SCMEUMA3 | G3SCMEUMA30 |
G3SCMEUMI3 | G3SCMEUMI30 | WLANPRURALLOS |
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WLANPURBANAPPLOS | WLANPURBANCRONLOS |
WLANPHIGHWAYNLOS | WLANPHIGHWAYLOS
*RST: USER

Example: FSIM:STAN THT
selects settings in conformity with Tetra Hilly Terrain 200 (with
two fading paths).

Manual operation: See "Standard / Test Case" on page 27

[:SOURce<hw>]:FSIMulator:STANdard:REFerence <Reference>

Queries the reference in the standard for the selected test case.

Parameters:
<Reference> string

Example: FSIM:STAN WC1BUP2
selects settings in conformity with 3GPP FDD Test Case 1 (with
two fading paths).
FSIM:STAN:REF?
queries the reference in the standard.
Response: "3GPP TS 25.101 V6.2.0 (2003-09),
annex B2.2"
the test case is defined in the specified reference.

Manual operation: See "Standard / Test Case" on page 27

[:SOURce<hw>]:FSIMulator:SUM:RATio <Ratio>

Set the ratio of the output levels of both paths A and B in case the fader 1 and 2 are
added.

A positive value of the parameter Summation Ration A/B indicates a stronger signal on
path A; respectively a negative value indicates a stronger signal on path B.

Parameters:
<Ratio> float

Range: -80  to  80
Increment: 0.1
*RST: 0

Example: FSIM:SUM:RAT -30
sets the ratio to -30dB.

[:SOURce<hw>]:FSIMulator[:STATe] <State>

This command activates fading simulation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0
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Example: FSIM ON
activates fading simulation in baseband path A with the current
settings.

Manual operation: See "State" on page 25
See "State Path" on page 44

[:SOURce]:FSIMulator:CATalog?

Reads out the files with fading settings in the default directory. The default directory is
set with the command MMEM:CDIRectory. Only files with the file ending *.fad are
read out.

Return values: 
<FileNames> string

Example: MMEM:CDIR "/var/user/fading"
sets the default directory
FSIM:STOR "delay_3gpp"
saves the current fading simulator settings of fader A in the file
delay_3gpp.
FSIM:CAT?
reads all files from the default directory with fading settings
Response: Birth_3gpp, delay_3gpp, fad_test
FSIM:LOAD "Birth_3gpp"
loads the fading settings from the file Birth_3gpp.
FSIM:DELETE "fad_test"
deletes the file fad_test.

Usage: Query only

Manual operation: See "Save/Recall" on page 26

[:SOURce<hw>]:FSIMulator:LOAD <Filename>

Loads the specified file containing a fading setting from the default directory. The
default directory is set with the command MMEM:CDIRectory. A path can also be
specified. Only files with the file ending *.fad are loaded.

Setting parameters: 
<Filename> string

Example: see [:SOURce]:FSIMulator:CATalog? on page 135

Usage: Setting only

Manual operation: See "Save/Recall" on page 26
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[:SOURce]:FSIMulator:DELETE <Filename>

Deletes the specified file containing a fading setting from the default directory. The
default directory is set with the command MMEM:CDIRectory. A path can also be
specified. Only files with the file ending *.fad are deleted.

Note: This command is only valid with DELETE in the long form as DEL is used as
short form of header keyword DELay.

Setting parameters: 
<Filename> string

Example: see [:SOURce]:FSIMulator:CATalog? on page 135

Usage: Setting only

Manual operation: See "Save/Recall" on page 26

[:SOURce<hw>]:FSIMulator:STORe <Filename>

Saves the current fading simulator settings in the specified file in the default directory.
The default directory is set with the command MMEM:CDIRectory. A path can also be
specified. The file ending *.fad is automatically used.

Setting parameters: 
<Filename> string

Example: see [:SOURce]:FSIMulator:CATalog? on page 135

Usage: Setting only

Manual operation: See "Save/Recall" on page 26

[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:CSTD <Cstd>
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:LCONstant <LConstant>

(available in "System Configuration > Mode > Standard")

Couples the lognormal fading setting.

Parameters:
<LConstant> 0 | 1 | OFF | ON

*RST: 0

General Settings
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Example: SCONfiguration:MODE STANdard

SOURce1:FSIMulator:CONFiguration STAN
SOURce1:FSIMulator:DEL:GROup1:PATH1:PROFile PDOP
SOURce1:FSIMulator:DEL:GROup1:PATH1:SPEed 1111.111
SOURce1:FSIMulator:STATe 1
SOURce1:FSIMulator:COUPle:SPEed 1
SOURce1:FSIMulator:CSPeed 1

SOURce2:FSIMulator:CONFiguration STAN
SOURce2:FSIMulator:STATe 1
SOURce2:FSIMulator:DEL:GROup1:PATH1:SPEed?
// 1111.111

SOURce1:FSIMulator:COUPle:LOGNormal:LCONstant 1
SOURce1:FSIMulator:COUPle:LOGNormal:CSTD 1
SOURce1:FSIMulator:DEL:GROup1:PATH1:LOGNormal:STATe 1
SOURce1:FSIMulator:DEL:GROup1:PATH1:LOGNormal:LCONstant 150
SOURce2:FSIMulator:DEL:GROup1:PATH1:LOGNormal:LCONstant?
// 150
SOURce1:FSIMulator:DEL:GROup1:PATH1:LOGNormal:CSTD 2
SOURce2:FSIMulator:DEL:GROup1:PATH1:LOGNormal:CSTD?
// 2

Manual operation: See "Local Constant Coupled" on page 40

[:SOURce<hw>]:FSIMulator:COUPle:SPEed <Speed>

(available in "System Configuration > Mode > Standard")

Couples the setting for the speed for the paths of both faders.

Parameters:
<Speed> 0 | 1 | OFF | ON

*RST: 0

Example: see [:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:
LCONstant on page 136

Manual operation: See "Speed Setting Coupled" on page 39

[:SOURce<hw>]:FSIMulator:CSPeed <CSpeed>

Determines whether the same speed is set for all of the activated fading paths.

Parameters:
<CSpeed> 0 | 1 | OFF | ON

*RST: 1

Example: see [:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:
LCONstant on page 136

Manual operation: See "Common Speed For All Paths" on page 43
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8.2 Birth Death

The Birth Death dynamic fading configurations are available with option R&S SMW-
K71.

[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:GRID...................................................... 138
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MINimum.................................................138
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MAXimum?..............................................138
[:SOURce<hw>]:FSIMulator:BIRThdeath:HOPPing:DWELl.................................................139
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:LOSS................................................139
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:PROFile............................................ 139
[:SOURce<hw>]:FSIMulator:BIRThdeath:POSitions...........................................................140
[:SOURce<hw>]:FSIMulator:BIRThdeath:SOFFset............................................................ 140
[:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed...............................................................140
[:SOURce<hw>]:FSIMulator:BIRThdeath:FRATio.............................................................. 141
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler?........................................ 141
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler:ACTual?............................ 142
[:SOURce<hw>]:FSIMulator:BIRThdeath:STATe...............................................................142

[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:GRID <Grid>

Sets the delay grid for both paths with birth death propagation fading.

Parameters:
<Grid> float

Range: 1E-9  to  dynamic
Increment: 1E-9
*RST: 1E-6

Example: FSIM:BIRT:DEL:GRID 0.00001
sets a delay grid of 10 us.

Manual operation: See "Delay Grid" on page 55

[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MINimum <Minimum>
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MAXimum?
Queries the minimum/maximum delay for both paths with birth death propagation fad-
ing.

Return values: 
<Maximum> float

Range: 0  to  max
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Example: FSIM:BIRT:DEL:MIN 0.000012
sets a minimum delay of 12 us.
FSIM:BIRT:DEL:GRID 0.000002
sets a delay grid of 2 us.
FSIM:BIRT:POS 9
sets 9 possible hop positions.
FSIM:BIRT:DEL:MAX?
queries the maximum delay.
Response: 0.000028
the maximum delay is 28 us. The delay range lies between +12
and +28 us. There are 9 hop positions on a 2 us grid available.

Usage: Query only

Manual operation: See "Maximum Delay" on page 55

[:SOURce<hw>]:FSIMulator:BIRThdeath:HOPPing:DWELl <Dwell>

Sets the time until the next change in the delay of a path (birth death event).

Parameters:
<Dwell> float

Range: 1E-3  to  429.49672950
Increment: 100E-9
*RST: 191E-3

Example: FSIM:BIRT:HOPP:DWEL 210 ms
sets a dwell time of 210 ms until the next change in the delay of
a fading path.

Manual operation: See "Hopping Dwell" on page 56

[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:LOSS <Loss>

Sets the loss of the paths with birth death propagation.

Parameters:
<Loss> float

Range: 0  to  50
Increment: 0.001
*RST: 0
Default unit: dB

Example: FSIM:BIRT:PATH2:LOSS 4 dB
sets a loss of 4 dB for the second fading path.

Manual operation: See "Path Loss" on page 54

[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:PROFile <Profile>

This command queries the fading profile. In birth death propagation, the pure Doppler
profile is used.

Birth Death
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Parameters:
<Profile> PDOPpler

*RST: PDOPpler

Example: FSIM:BIRT:PATH2:PROF?
queries the profile of the second fading path.

Manual operation: See "Profile" on page 54

[:SOURce<hw>]:FSIMulator:BIRThdeath:POSitions <Positions>

Sets the number of possible hop positions in the delay range.

0 us < (...:BIRT:POS – 1) x ...:DEL:GRID + ...:DEL:MIN < 40 us

Parameters:
<Positions> integer

Range: 3  to  50
*RST: 11

Example: FSIM:BIRT:POS 11
sets 11 possible delay positions.

Manual operation: See "Positions" on page 55

[:SOURce<hw>]:FSIMulator:BIRThdeath:SOFFset <Soffset>

Sets the time until the start of the next birth death event. With dual-channel fading, this
allows the user to intentionally displace the birth death events of the two faders with
respect to one another.

Parameters:
<Soffset> float

Range: 0  to  429
Increment: 100E-9
*RST: 0

Example: FSIM:BIRT:SOFF 21E-6
sets a start offset of 21 us.

Manual operation: See "Start Offset" on page 55

[:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed <Speed>

Sets the speed of the moving receiver for birth death propagation.

The default speed unit is m/s. Units different than the default one must be specified.

Birth Death
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Parameters:
<Speed> float

Range: 0  to  dynamic
Increment: 0.001
*RST: 0
Default unit: m/s

Example: SOURce1:FSIMulator:BIRThdeath:SPEed 100 KMH
SOURce1:FSIMulator:BIRThdeath:PATH1:FDOPpler?
// 92.6574343641427
SOURce1:FSIMulator:BIRThdeath:FRATio 1
SOURce1:FSIMulator:BIRThdeath:PATH1:FDOPpler:ACTual?
// 92.66
SOURce1:FSIMulator:BIRThdeath:FRATio 0.5
SOURce1:FSIMulator:BIRThdeath:PATH1:FDOPpler:ACTual?
// 46.33

Manual operation: See "Speed" on page 57

[:SOURce<hw>]:FSIMulator:BIRThdeath:FRATio <FRatio>

Sets the ratio of the actual Doppler frequency to the set Doppler frequency with birth
death propagation fading.

Parameters:
<FRatio> float

Range: -1  to  1
Increment: 0.0001
*RST: 1

Example: See [:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed
on page 140

Manual operation: See "Frequency Ratio" on page 57

[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler?

Queries the resulting Doppler frequency with birth death propagation.

Return values: 
<FDoppler> float

Range: 0  to  1000
Increment: 0.01
*RST: 0

Example: see [:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed
on page 140

Usage: Query only

Manual operation: See "Resulting Doppler Shift" on page 57
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[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler:ACTual?

Queries the actuial Doppler frequency.

Return values: 
<ActDoppler> float

Range: -1600  to  1600
Increment: 0.01
*RST: 0

Example: see [:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed
on page 140

Usage: Query only

Manual operation: See "Actual Doppler Shift" on page 57

[:SOURce<hw>]:FSIMulator:BIRThdeath:STATe <State>

This command selects the birth death propagation fading configuration and switches
the fading simulation on and off.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SOUR2:FSIM:BIRT:STAT ON
selects birth death propagation for fader B and switches on fad-
ing in path B.

Manual operation: See "Configuration" on page 27

8.3 Delay Modes

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:ADELay.................... 143
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:ADELay...........................143
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:BDELay.................... 143
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:BDELay...........................143
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:COEFficient. 144
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:PHASe........144
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:STATe........ 145
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase.......................... 145
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FDOPpler..................146
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler[:RESulting]....... 146
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler:ACTual?...........146
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FRATio..................... 147
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio............................147
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSHift..............................147
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSPRead........................ 148
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:CSTD............148
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[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:LCONstant.... 148
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:STATe.......... 149
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:LOSS........................149
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOSS..............................149
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PRATio........................... 149
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:PROFile....................150
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PROFile.......................... 150
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:RDELay?.................. 151
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:RDELay?.........................151
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:SPEed...................... 151
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:SPEed............................ 151
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:STATe...................... 152
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:STATe............................ 152
[:SOURce<hw>]:FSIMulator:DELay|DEL:STATe............................................................... 152

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:ADELay
<ADelay>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:ADELay
<ADelay>

Determines the path-specific delay ("Additional Delay") of the selected path. The
Resulting Delay of a path is obtained by adding the Basic Delay and the Additional
Delay.

Parameters:
<ADelay> float

Range: 0  to  40.0E-6 s
*RST: 0

Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:ADEL 10E-6
sets an Additional Delay of 10 us for fading path 2.

Manual operation: See "Additional Delay" on page 46

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:BDELay
<BDelay>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:BDELay
<BDelay>

Determines the group delay ("Basic Delay". Within a group, all of the paths are jointly
delayed by this value. The Resulting Delay of a path is obtained by adding the Basic
Delay and the Additional Delay. The Basic Delay of group 1 is always equal to 0.

Parameters:
<BDelay> float

Range: 0.0  to  2.56E-3 s
Increment: 10 ns
*RST: 0.0
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Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO2:PATH:BDEL 1E-3
sets a delay of 1 ms for fading group 2. This value applies to all
of the paths in the group.

Manual operation: See "Basic Delay" on page 46

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:
COEFficient <Coefficient>

Determines the magnitude of the complex correlation coefficient. The higher the
entered percentage, the greater the correlation of the statistical fading processes for
the two paths. Highly correlated ambient conditions for the signal are simulated in this
manner.

Sets the correlation coefficient of the correlated path of the second fader also to the
entered value.

Parameters:
<Coefficient> float

Range: 0  to  100
Increment: 0.1
*RST: 100
Default unit: PCT

Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO2:PATH:CORR:STAT ON
switches on the correlation of fading path 1 of group 2 of fader A
to fading path 1 of group 2 of fader B.
FSIM:DEL:GRO2:PATH:CORR:COEF 95
specifies a correlation coefficient of 95% for the two paths.

Manual operation: See "Correlation Coefficient" on page 50

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:
PHASe <Phase>

Determines the phase of the complex correlation coefficient.

Sets the phase of the correlation coefficient of the correlated path of the second fader
also to the entered value.

Parameters:
<Phase> float

Range: 0  to  359.9
Increment: 0.05
*RST: 0
Default unit: DEG
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Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO2:PATH:CORR:STAT ON
switches on the correlation of fading path 1 of group 2 of fader A
to fading path 1 of group 2 of fader B.
FSIM:DEL:GRO2:PATH:CORR:PHAS 5
specifies a phase of the correlation coefficient equal to 5 DEG
for the two paths.

Manual operation: See "Correlation Coefficient Phase" on page 50

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:
STATe <State>

Enables correlation of the paths of the first fader. The suffix in SOURce defines the
fader on which path settings the correlation is based.

When correlation is activated, the settings of the correlation parameters, the profile, the
speed and the lognormal parameters are the same for both paths.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:FSIMulator:DELay:STATe ON
SOURce1:FSIMulator:DELay:GROup2:PATH1:
CORRelation:STATe ON
enables correlation of fading path 1 of group 2 of fader A to fad-
ing path 1 of group 2 of fader B.

Manual operation: See "Correlation Path" on page 49

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase
<CPhase>

Sets the start phase rotation.

Parameters:
<CPhase> float

Range: 0  to  359.9
Increment: 0.1
*RST: 0
Default unit: DEG

Example: FSIM:DEL:STAT ON
activates the Standard Delay fading configuration.
FSIM:DEL:GRO1:PATH1:PROF RICE
selects the Rice fading profile for fading path 1 of group 1.
FSIM:DEL:GRO1:PATH:CPH 5DEG
sets a start phase rotation of 5 DEG for fading path 1 of group 2.
The path is multiplied by this phase.
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Manual operation: See "Const. Phase" on page 47
See "Start Phase" on page 47

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FDOPpler
<FDoppler>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler[:
RESulting] <FDoppler>

Queries the resulting Doppler frequency for the fading configuration.

The Doppler frequency is determined by the selected speed ([:SOURce<hw>]:
FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:SPEed).

For the Pure Doppler and Rice Fading profiles, the actual Doppler shift is a function of
the selected ratio of the Doppler shift to the Doppler frequency ([:SOURce<hw>]:
FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio). Use the command [:
SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler:
ACTual? to query the actual Doppler shift.

Parameters:
<FDoppler> float

Range: 0  to  4000
Increment: 0.01
*RST: 0

Example: SOURce1:FSIMulator:CONFiguration STAN
SOURce1:FSIMulator:DEL:GROup1:PATH1:PROFile RICE
SOURce1:FSIMulator:DEL:GROup1:PATH1:FRATio 1
SOURce1:FSIMulator:DEL:GROup1:PATH1:FDOPpler:RESulting?
// Response:  2.77968967451476
// set a frequency ratio for the first fading path of group 1. 
// I.e. set an angle of incidence of about 45° with respect to 
// a receiver that is going away from the transmitter
SOURce1:FSIMulator:DEL:GROup1:PATH1:FRATio -0.71
SOURce1:FSIMulator:DEL:GROup1:PATH1:FDOPpler:RESulting?
// Response:  2.77968967451476
SOURce1:FSIMulator:DELay:GROup1:PATH1:FDOPpler:ACTual?
// Response:  -1.97

Manual operation: See "Resulting Doppler Shift" on page 48

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler:
ACTual?

Queries the actual Doppler shift.

For the Pure Doppler and Rice Fading profiles, the actual Doppler shift is a function of
the selected ratio of the Doppler shift to the Doppler frequency ([:SOURce<hw>]:
FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio).
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Return values: 
<ActDoppler> float

Range: -4000.0  to  4000
Increment: 0.01
*RST: 0

Example: see [:SOURce<hw>]:FSIMulator:DELay|DEL:
GROup<st>:PATH<ch>:FDOPpler[:RESulting]
on page 146

Usage: Query only

Manual operation: See "Actual Doppler Shift" on page 49

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FRATio
<FRatio>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio <FRatio>

For Rice, pure Doppler and Gauss Doppler fading, sets the ratio of the actual Doppler
frequency to the set Doppler frequency. The Frequency Ratio serves as a measure of
the angle of incidence between the transmitter and receiver.

Parameters:
<FRatio> float

Range: -1  to  1
Increment: 0.0001
*RST: 0

Example: see [:SOURce<hw>]:FSIMulator:DELay|DEL:
GROup<st>:PATH<ch>:FDOPpler[:RESulting]
on page 146

Manual operation: See "Frequency Ratio" on page 48

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSHift <FShift>

Sets the frequency shift for the Gauss Watterson fading.

Parameters:
<FShift> float

Range: -10  to  10
Increment: 0.0001
*RST: 0

Example: FSIM:DEL:GRO:PATH2:PROF WATT
FSIM:DEL:GRO:PATH2:FS?

Manual operation: See "Frequency Shift" on page 47

Delay Modes



Remote-Control CommandsR&S®SMW-B14/-K71/-K72/-K74/-K75

148User Manual 1175.6826.02 ─ 09

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSPRead
<FSpread>

Sets the frequency spread for the Gauss Watterson fading.

Parameters:
<FSpread> float

Range: 1E-4  to  10
Increment: 1E-4
*RST: 0.1

Example: FSIM:DEL:GRO:PATH2:PROF WATT
FSIM:DEL:GRO:PATH2:FSPR?

Manual operation: See "Frequency Spread" on page 47

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
CSTD <Cstd>

Sets the standard deviation for lognormal fading.

Parameters:
<Cstd> integer

Range: 0  to  12
*RST: 0
Default unit: dB

Example: FSIM:DEL:STAT ON
activates the Standard Delay fading configuration.
FSIM:DEL:GRO:PATH2:LOGN:STAT ON
selects lognormal fading for fading path 2 of group 1.
FSIM:DEL:GRO:PATH2:LOGN:CSTD 2
sets a standard deviation of 2 dB for fading path 2 of group 1.

Manual operation: See "Standard Deviation " on page 51

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
LCONstant <LConstant>

Sets the Local Constant for lognormal fading.

Parameters:
<LConstant> float

Range: 0  to  200
Increment: 0.1
*RST: 100
Default unit: m
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Example: FSIM:DEL:STAT ON
activates the Standard Delay fading configuration.
FSIM:DEL:GRO:PATH2:LOGN:STAT ON
selects lognormal fading for fading path 2 of group 1.
FSIM:DEL:GRO:PATH2:LOGN:LCON 100
sets a Local Constant of 100 m for the second fading path of
group 1.

Manual operation: See "Local Constant" on page 50

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
STATe <State>

Enables/ disables a lognormal fading.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:LOGN:STAT ON
activates lognormal fading for fading path 2 of group 1.

Manual operation: See "Lognormal State" on page 50

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:LOSS
<Loss>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOSS <Loss>

Sets the loss of the paths.

Parameters:
<Loss> float

Range: 0  to  50
Increment: 0.001
*RST: 10|0
Default unit: dB

Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:LOSS 2 dB
sets a loss of 2 dB for fading path 2 of group 1.

Manual operation: See "Path Loss" on page 46

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PRATio <PRatio>

Sets the power ratio of the discrete and distributed components for Rice fading
(:SOURce:FSIMulator:DELay:GROup:PATH2:PROFile RICE).
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Parameters:
<PRatio> float

Range: -30  to  30
Increment: 0.01
*RST: 0
Default unit: dB

Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:PROF RICE
sets the Rice fading profile for fading path 2 of group 1.
FSIM:DEL:GRO:PATH2:PRAT -15
sets a power ratio of –15 dB. The distributed (Rayleigh) compo-
nent prevails. The total power of the two components remains
constant.

Manual operation: See "Power Ratio" on page 46

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:PROFile
<Profile>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PROFile
<Profile>

Selects the fading profile for the paths.

Parameters:
<Profile> SPATh | RAYLeigh | PDOPpler | RICE | CPHase | OGAUs |

TGAUs | DGAUs | WDOPpler | WRICe | GDOPpler | GFD8 |
GFD1 | WATTerson | BELLindoor | BELVehicle
SPAT
static transmission path
PDOPpler | RAYLeigh | RICE
pure Doppler | Rayleigh | Rice
CPHase
constant phase
OGAUs | TGAUs | DGAUs | GDOPpler | GFD8 | GFD1
GAUS1 | GAUS2 | GAUSDAB | Gauss Doppler | Gauss (0.08 fd)
| Gauss (0.01 fd)

WATTerson
Gauss (Watterson)
WDOPpler | WRICe
WiMAX Doppler | WiMAX Rice
BELLindoor|BELVehicle
Bell Shape tgn Indoor, Bell Shape tgn Moving Vehicle
*RST: RAYLeigh

Manual operation: See "Profile" on page 44
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[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:RDELay?
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:RDELay?
Queries the Resulting Delay of the paths for the selected fading configuration. The
Resulting Delay is the sum of the Basic Delay (SOURce:FSIM:...:BDELay) and the
Additional Delay (SOURce:FSIM:...:ADELay).

Return values: 
<RDelay> float

Range: 0  to  max
Increment: 10E-9
*RST: 0

Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO2:PATH:BDEL 2E-4
sets a Delay Offset of 200 us for group 2.
FSIM:DEL:GRO2:PATH2:ADEL 1E-5
sets an Additional Delay of 10 us for fading path 2 of group 2.
FSIM:DEL:GRO2:PATH2:RDEL?
queries the Resulting Delay for fading path 2 of group 2.
Response: 0.00021
the Resulting Delay is 210 us.

Usage: Query only

Manual operation: See "Resulting Delay" on page 46

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:SPEed
<Speed>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:SPEed <Speed>

Sets the speed v of the moving receiver.

Parameters:
<Speed> float

Range: 0  to  dynamic
Increment: 0.001
*RST: 0.83333

Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:SPE 2MPS
sets a speed of 2 m/s for the moving receiver for fading path 2 of
group 1.

Manual operation: See "Speed" on page 47

Delay Modes



Remote-Control CommandsR&S®SMW-B14/-K71/-K72/-K74/-K75

152User Manual 1175.6826.02 ─ 09

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:STATe
<State>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:STATe <State>

Activates the selected path.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:STAT ON
activates fading path 2 in group 1.

Manual operation: See "State Path" on page 44

[:SOURce<hw>]:FSIMulator:DELay|DEL:STATe <State>

Activates the fading configurations.

Note: Changing the configuration will cause an interruption in the fading process, fol-
lowed by a restart after about one second.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: FSIM:DEL:STAT ON
activates the "Standard Delay" fading configuration for fader A
and switches on fading for path A.

8.4 High Speed Train

The High Speed Train dynamic fading configurations are available with option
R&S SMW-K71.

Example: Enabling and configuring a high speed train propagation
The following is an example on how to configure the settings without using a prede-
fined standard.

SOURce1:FSIMulator:CONFiguration HSTRain
SOURce1:FSIMulator:HSTRain:PROFile PDOPpler
SOURce1:FSIMulator:HSTRain:SPEed 100kmh
SOURce1:FSIMulator:HSTRain:DISTance:MINimum 20m
SOURce1:FSIMulator:HSTRain:DISTance:STARt 2000m
SOURce1:FSIMulator:HSTRain:PATH:STATe ON 
SOURce1:FSIMulator:HSTRain:STATe ON
SOURce1:FSIMulator:HSTRain:FDOPpler?
// 92.657 Hz
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Example: Configuring a high speed train scenario for BS tests
The following is an example on how to configure fading simulator to generate a HST
BS test signal according to 3GPP TS36.104.
For frequency Band 1 tests, the specification defines:
FDL = 2.14 GHz, FUL = 1.95 GHz

and FD = 1140 Hz

SOURce1:FSIMulator:PRESet
SOURce1:FSIMulator:STANdard G3HST1OSDU
SOURce1:FREQuency:CW 1.95E9
SOURce1:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe ON
SOURce1:FSIMulator:HSTRain:DOWNlink:FREQuency 2.14E9
SOURce1:FSIMulator:HSTRain:PATH:STATe ON 
SOURce1:FSIMulator:HSTRain:STATe ON
SOURce1:FSIMulator:HSTRain:FDOPpler?
// 1136.89307687654

[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:MINimum................................................ 153
[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:STARt.................................................... 153
[:SOURce<hw>]:FSIMulator:HSTRain:SPEed................................................................... 154
[:SOURce<hw>]:FSIMulator:HSTRain:FDOPpler?.............................................................154
[:SOURce<hw>]:FSIMulator:HSTRain:PATH:STATe..........................................................154
[:SOURce<hw>]:FSIMulator:HSTRain:PROFile.................................................................155
[:SOURce<hw>]:FSIMulator:HSTRain:KFACtor.................................................................155
[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe.................................155
[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency............................................155
[:SOURce<hw>]:FSIMulator:HSTRain:STATe................................................................... 156

[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:MINimum <Minimum>

Sets the parameter Dmin, i.e. the distance between the BS and the railway track.

Parameters:
<Minimum> float

Range: 1  to  100
Increment: 0.1
*RST: 2

Example: see Example "Enabling and configuring a high speed train prop-
agation" on page 152

Manual operation: See "D (min)" on page 77

[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:STARt <Start>

Sets the parameter DS, i.e. the initial distance DS/2 between the train and the BS at the
beginning of the simulation.
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Parameters:
<Start> integer

Range: 20  to  2000
*RST: 300

Example: see Example "Enabling and configuring a high speed train prop-
agation" on page 152

Manual operation: See "D (S)" on page 77

[:SOURce<hw>]:FSIMulator:HSTRain:SPEed <Speed>

Sets the velocity parameter , i.e. the speed of the moving receiver in m/s.

Parameters:
<Speed> float

Range: 0.001  to  dynamic
Increment: 0.001
*RST: 83.333

Example: see Example "Enabling and configuring a high speed train prop-
agation" on page 152

Manual operation: See "Speed" on page 77

[:SOURce<hw>]:FSIMulator:HSTRain:FDOPpler?

Queries the maximum Doppler Shift for the selected configuration.

Return values: 
<FDoppler> float

Range: 0  to  1000
Increment: 0.01
*RST: 0

Example: see Example "Configuring a high speed train scenario for BS
tests" on page 153

Usage: Query only

Manual operation: See "Profile" on page 76

[:SOURce<hw>]:FSIMulator:HSTRain:PATH:STATe <State>

Activates/deactivates the selected path for the High Speed Train fading configurations.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: see Example "Enabling and configuring a high speed train prop-
agation" on page 152
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Manual operation: See "State Path" on page 44

[:SOURce<hw>]:FSIMulator:HSTRain:PROFile <Profile>

Determines the fading profile for the selected scenario. The fading profile determines
which transmission path is simulated.

Parameters:
<Profile> SPATh | PDOPpler | RAYLeigh

*RST: PDOPpler

Example: see Example "Enabling and configuring a high speed train prop-
agation" on page 152

Manual operation: See "Profile" on page 76

[:SOURce<hw>]:FSIMulator:HSTRain:KFACtor <KFactor>

Sets the Rician factor K for high speed train scenario 2.

Parameters:
<KFactor> float

Range: -30  to  30
Increment: 0.01
*RST: 10

Example: SOURce1:FSIMulator:PRESet
SOURce1:FSIMulator:STANdard G3HST2TLC
SOURce1:FSIMulator:HSTRain:KFACtor 10

Manual operation: See "K (Rician factor)" on page 77

[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe
<HstDlFreqState>

Enables the definition of virtual downlink frequency.

Parameters:
<HstDlFreqState> 0 | 1 | OFF | ON

*RST: 0

Example: see Example "Configuring a high speed train scenario for BS
tests" on page 153

Manual operation: See "Consider DL RF" on page 77

[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency <HstDlFreq>

Sets the virtual downlink frequency, necessary to calculate the UL Doppler shift.
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Parameters:
<HstDlFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 1E9

Example: see Example "Configuring a high speed train scenario for BS
tests" on page 153

Manual operation: See "Virtual DL RF" on page 77

[:SOURce<hw>]:FSIMulator:HSTRain:STATe <State>

Activates/deactivates simulation of High Speed Train propagation according to the
selected scenario 1 or 3.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: see Example "Enabling and configuring a high speed train prop-
agation" on page 152

Manual operation: See "Configuration" on page 27
See "State" on page 76

8.5 Moving Propagation

The moving propagation dynamic fading configurations are available with option
R&S SMW-K71.

[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:VPERiod............................................. 156
[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:DELay:VARiation..................................157
[:SOURce<hw>]:FSIMulator:MDELay:CHANnel:MODE......................................................157
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:CPHase.................... 158
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:MEAN............................................. 158
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:VARiation........................................ 159
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:LOSS.........................................................159
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:STATe....................................................... 159
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:VPERiod.................................................... 159
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:DELay...................................................160
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:LOSS....................................................160
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:STATe...................................................160
[:SOURce<hw>]:FSIMulator:MDELay:STATe....................................................................161

[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:VPERiod <VPeriod>

Sets the speed of the delay variation of the moving fading paths for moving propaga-
tion with all moving channels. A complete cycle comprises one pass through this "Var-
iation Period".
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Parameters:
<VPeriod> float

Range: 5  to  200
Increment: 0.1
*RST: 25

Example: FSIM:CONF MDEL
selects a moving propagation configuration.
FSIM:MDEL:CHAN:MODE ALL
enables all moving channels.
FSIM:MDEL:STAT ON
activates the moving propagation for fader A.
FSIM:MDEL:ALL:MOV:VPER 50 s
sets the period for the delay variation to 100 s.

Manual operation: See "Variation Period" on page 65

[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:DELay:VARiation <Variation>

This command enters the range for the delay of the moving fading paths for moving
propagation with all moving channels. The delay of the moving path slowly varies
sinusoidally within this range.

Parameters:
<Variation> float

Range: 0.3E-6  to  10E-6
Increment: 10E-9
*RST: 5E-6

Example: FSIM:CONF MDEL
selects a moving propagation configuration.
FSIM:MDEL:CHAN:MODE ALL
enables all moving channels.
FSIM:MDEL:STAT ON
activates the moving propagation for fader A.
FSIM:MDEL:ALL:MOV:DEL:VAR 1E-5
sets the range 10 us for the delay of the moving fading path.

Manual operation: See "Delay Variation (Peak-Peak)" on page 65

[:SOURce<hw>]:FSIMulator:MDELay:CHANnel:MODE <Mode>

Determines whether only one or several moving channels are simulated.

Parameters:
<Mode> ONE | ALL

*RST: ONE

Example: FSIM:CONF MDEL
selects a moving propagation configuration.
FSIM:MDEL:CHAN:MODE ALL
enables all moving channels.
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Manual operation: See "Moving Channels" on page 29

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:CPHase
<CPhase>

These commands determine the phase for constant phase fading for the "Standard
Delay", and "Moving Propagation All Moving Channels" fading configurations.

Parameters:
<CPhase> float

Range: 0  to  359.9
Increment: 0.1
*RST: 0

Example: FSIM:DEL:STAT ON
activates the Standard Delay fading configuration.
FSIM:DEL:GRO2:PATH:PROF CPH
selects the Constant Phase fading profile for fading path 1 of
group 2.
FSIM:DEL:GRO2:PATH:CPH 5DEG
sets a phase of 5 DEG for fading path 1 of group 2. The path is
multiplied by this phase.

[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:MEAN <Mean>

Sets the mean delay of the moving fading path for moving propagation.

Parameters:
<Mean> float

Range: 0  to  40E-6
Increment: 10E-9
*RST: 3.5E-6

Example: FSIM:MDEL:STAT ON
sets moving propagation.
FSIM:MDEL:MOV:DEL:VAR 1E-5
sets the range 10 us (+/- 5 us) for the variation of the delay of
the moving fading path.
FSIM:MDEL:MOV:DEL:MEAN 9E-6
sets the mean delay of the moving path to 9 us.
FSIM:MDEL:MOV:VPER 105
sets a period of 105 s for the sinusoidal variation of the delay of
the moving path. The delay of the moving path now varies once
sinusoidal in 105 s between 4 us and 14 us.

Manual operation: See "Delay" on page 64
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[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:VARiation <Variation>

Enters the range for the delay of the moving fading path for moving propagation. The
delay of the moving path slowly varies sinusoidal within this range.

Parameters:
<Variation> float

Range: 0.3E-6  to  dynamic
Increment: 10E-9
*RST: 5E-6

Example: FSIM:MDEL:MOV:DEL:VAR 1E-5
sets the range 10 us for the delay of the moving fading path.

Manual operation: See "Variation (Peak-Peak)" on page 64

[:SOURce<hw>]:FSIMulator:MDELay:MOVing:LOSS <Loss>

Sets the insertion loss of the moving path for moving propagation.

Parameters:
<Loss> float

Range: 0  to  50
Increment: 0.001
*RST: 0

Example: FSIM:MDEL:MOV:LOSS 12 dB
sets the loss for the moving fading path.

Manual operation: See "Path Loss" on page 63

[:SOURce<hw>]:FSIMulator:MDELay:MOVing:STATe <State>

This command activates the moving fading path for moving propagation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: FSIM:MDEL:STAT ON
sets moving propagation.
FSIM:MDEL:MOV:STAT ON
activates the moving path for moving propagation.

Manual operation: See "State" on page 63

[:SOURce<hw>]:FSIMulator:MDELay:MOVing:VPERiod <VPeriod>

This command sets the speed of the delay variation of the moving fading path for mov-
ing propagation. A complete cycle comprises one pass through this "Variation Period".
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Parameters:
<VPeriod> float

Range: 10  to  500
Increment: 0.1
*RST: 157

Example: FSIM:MDEL:MOV:VPER 100 s
sets the period for the delay variation to 100 s.

Manual operation: See "Variation Period" on page 64

[:SOURce<hw>]:FSIMulator:MDELay:REFerence:DELay <Delay>

This command enters the delay of the reference path for moving propagation.

Parameters:
<Delay> float

Range: 0  to  40E-6
Increment: 10E-9
*RST: 0

Example: FSIM:MDEL:REF:DEL 1E-5
sets the range to 10 us for the delay of the reference path.

Manual operation: See "Delay" on page 63

[:SOURce<hw>]:FSIMulator:MDELay:REFerence:LOSS <Loss>

Sets the loss of the reference path for moving propagation.

Parameters:
<Loss> float

Range: 0  to  50
Increment: 0.001
*RST: 0

Example: FSIM:MDEL:REF:LOSS 12 dB
sets the insertion loss for the reference path.

Manual operation: See "Path Loss" on page 63

[:SOURce<hw>]:FSIMulator:MDELay:REFerence:STATe <State>

This command activates the reference path for moving propagation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1
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Example: FSIM:MDEL:STAT ON
sets moving propagation.
FSIM:MDEL:REF:STAT ON
activates the reference path for moving propagation.

Manual operation: See "State" on page 63

[:SOURce<hw>]:FSIMulator:MDELay:STATe <State>

This command activates the moving propagation fading configuration. The paths and
the fading simulator must be switched on separately
(SOURce:FSIMulator:MDELay:MOVing|REFerence:STATe ON and
SOURce:FSIMulator ON).

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: FSIM:MDEL:STAT ON
sets moving propagation for fader A.

Manual operation: See "Configuration" on page 27

8.6 MIMO Settings

The MIMO configurations require additional options:
● for up to 2x2 MIMO configurations, 2x option R&S SMW-B14+R&S SMW-K74 are

required
● the MxN MIMO configurations with M>2 or N>2 require 4xR&S SMW-

B14+R&S SMW-K74

Placeholder <path>

To simplify the description of the remote control commands, the placeholder <path> is
introduced. Replace this placeholder <path> with AB, AC, etc.

The description of each command containing this placeholder provides a link to the
related commands with their correct syntax.

The replacement of the place holder <path> is mandatory, i.e. remote control com-
mands containing this placeholder are not recognized and accepted by the instrument.

[:SOURce<hw>]:FSIMulator:MIMO:CAPability?.................................................................162
[:SOURce<hw>]:FSIMulator:MIMO:COPY:NEXT...............................................................162
[:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL..................................................................162
[:SOURce<hw>]:FSIMulator:MIMO:COPY:PREVious.........................................................163
[:SOURce<hw>]:FSIMulator:MIMO:MDLoad..................................................................... 163
[:SOURce<hw>]:FSIMulator:MIMO:MDSTore....................................................................163
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[:SOURce<hw>]:FSIMulator:MIMO:TAP........................................................................... 163
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:

COLumn<st>:IMAGinary.......................................................................................164
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:

COLumn<st>:IMAGinary.......................................................................................164
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:

COLumn<st>:PHASe........................................................................................... 164
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:

COLumn<st>:PHASe........................................................................................... 164
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:

COLumn<st>:MAGNitude..................................................................................... 164
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:

COLumn<st>:MAGNitude..................................................................................... 164
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:

COLumn<st>:REAL............................................................................................. 165
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:

COLumn<st>:REAL............................................................................................. 165
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ACCept........................................... 165
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:CONFlict?........................................166
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:MODE.............................................166
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:PHASe.........166
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:MAGNitude...167
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:PRESet..........................................167
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:<path>:GAIN.................................. 167
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:<path>:PHASe................................168

[:SOURce<hw>]:FSIMulator:MIMO:CAPability?

Queries the supported MIMO configurations.

Return values: 
<MimoCapability> string

Example: :SOURce1:FSIMulator:MIMO:CAPability?
Response: "M2X2,M2X4,M4X2,M2X3,M3X2,M1X2,..."

Usage: Query only

[:SOURce<hw>]:FSIMulator:MIMO:COPY:NEXT

Copies the matrix values of the current tap to the subsequent tap. If the current tap is
the last tap, the command is discarded.

See also [:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL on page 162.

Usage: Event

Manual operation: See "Copy To Next" on page 92

[:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL

Applies the matrix values of the current tap to all taps.
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Usage: Event

Options: R&S SMW-B14/K74

Manual operation: See "Copy To All" on page 92

[:SOURce<hw>]:FSIMulator:MIMO:COPY:PREVious

This command copies the matrix values of the current tap to the next lower tap.

Example: FSIM:MIMO:COPY:PREV
copies the settings of the current tap to the next lower tap.

Usage: Event

Manual operation: See "Copy To Prev" on page 92

[:SOURce<hw>]:FSIMulator:MIMO:MDLoad <MDLoad>

This command loads a file with saved MIMO settings.

Setting parameters: 
<MDLoad> string

Example: FSIM:MIMO:MDL 'MIMO_Settings'
loads the settings file.

Usage: Setting only

[:SOURce<hw>]:FSIMulator:MIMO:MDSTore <MDStore>

This command save the MIMO settings in a file.

Setting parameters: 
<MDStore> string

Example: FSIM:MIMO:MDST 'MIMO_Settings'
saves the MIMO settings in a file.

Usage: Setting only

[:SOURce<hw>]:FSIMulator:MIMO:TAP <Tap>

Sets the current tap.

Parameters:
<Tap> TAP1 | TAP2 | TAP3 | TAP4 | TAP5 | TAP6 | TAP7 | TAP8 |

TAP9 | TAP10 | TAP11 | TAP12 | TAP13 | TAP14 | TAP15 |
TAP16 | TAP17 | TAP18 | TAP19 | TAP20
*RST: TAP1

Example: SORce1:FSIMulator:MIMO:TAP TAP15
Manual operation: See "Current Path (Tap) #" on page 92
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:IMAGinary <Imaginary>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:IMAGinary <Imaginary>

Sets the value for the imaginary part of the receiver/transmitter correlation.

Note: In case that the values for the real part and the imaginary part are both set to 0,
the phase value will also be set to 0 when changing the data format.

Parameters:
<Imaginary> float

Range: -1  to  1
Increment: 0.001
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:KRONecker:
CORRelation:TX:ROW1:COLumn2:IMAGinary 0.5
sets the imaginary part of the Tx correlation AB to 0.5.

Options: up to 4xR&S SMW-B14 and R&S SMW-K74

Manual operation: See "Tx Correlation Coefficients, Phase/Imag" on page 95

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:PHASe <Phase>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:PHASe <Phase>

Sets the value for the phase of the receiver/transmitter correlation.

Note: In case that the values for the real part and the imaginary part are both set to 0,
the phase value will also be set to 0 when changing the data format.

Parameters:
<Phase> float

Range: 0  to  360
Increment: 0.02
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:KRONecker:
CORRelation:TX:ROW1:COLumn2:PHASe 30
sets the phase of the Tx correlation AB to 30 degrees.

Options: up to 4xR&S SMW-B14 and R&S SMW-K74

Manual operation: See "Tx Correlation Coefficients, Phase/Imag" on page 95

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:MAGNitude <Magnitude>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:MAGNitude <Magnitude>

Sets the ratio of the receiver/transmitter correlation.
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Note: In case that the values for the real part and the imaginary part are both set to 0,
the phase value will also be set to 0 when changing the data format.

Parameters:
<Magnitude> float

Range: 0  to  1
Increment: 0.001
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:KRONecker:
CORRelation:TX:ROW1:COLumn2:MAGNitude 0.5
sets the ratio of the Tx correlation AB to 0.5.

Options: up to 4xR&S SMW-B14 and R&S SMW-K74

Manual operation: See "Tx Correlation Coefficients, Magnitude/Real" on page 94

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:REAL <Real>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:REAL <Real>

Sets the value for the real part of the receiver/transmitter correlation.

Note: In case that the values for the real part and the imaginary part are both set to 0,
the phase value will also be set to 0 when changing the data format.

Parameters:
<Real> float

Range: -1  to  1
Increment: 0.001
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:KRONecker:
CORRelation:TX:ROW1:COLumn2:REAL 0.5
sets the value for the real part of the Tx correlation AB to 0.5.

Options: up to 4xR&S SMW-B14 and R&S SMW-K74

Manual operation: See "Tx Correlation Coefficients, Magnitude/Real" on page 94

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ACCept

Accepts the values for the phase/imaginary and the real/ration part of the correlation.

Example: FSIM:MIMO:TAP2:MATR:ACC
accepts the values for the phase/imaginary and the real/ration
part of the correlation

Usage: Event

Options: R&S SMW-B14/-K71/-K74

Manual operation: See "Accept" on page 110
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:CONFlict?

Queries whether there is a matrix conflict or not.

Return values: 
<Conflict> 0 | 1 | OFF | ON

Example: FSIM:MIMO:TAP2:MATR:CONF?
queries whether there is a matrix conflict or not

Usage: Query only

Options: R&S SMW-B14/-K71/-K74

Manual operation: See "Conflict" on page 110

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:MODE <Mode>

Sets the input mode for the Rx and Tx correlation values (matrix mode).

Parameters:
<Mode> INDividual | KRONecker | AOAaod | SCWI

*RST: INDividual

Example: FSIM:MIMO:TAP2:MATR:MODE IND
selects the matrix mode individual.

Options: R&S SMW-B14/-K71/-K74

Manual operation: See "Matrix Mode" on page 92

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:
PHASe <Phase>

This command enters the value for the phase/imaginary part of the correlation.

Suffix: 
<di>

.
1..4

<st> 1..4

Parameters:
<Phase> float

Range: 0  to  360
Increment: 0.02
*RST: 0

Example: FSIM:MIMO:TAP2:MATR:ROW1:COL1:PHAS 90
sets the correlation value to the specified value.

Options: R&S SMW-B14/-K71/-K74

Manual operation: See "Phase/Imag" on page 110
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:
MAGNitude <Magnitude>

Determines the value for the real/magnitude part of the correlation.

Suffix: 
<di>

.
1..4

<st> 1..4

Parameters:
<Magnitude> float

Range: 0  to  1
Increment: 0.0001
*RST: 1

Example: FSIM:MIMO:TAP2:MATR:ROW1:COL1:MAGN 0.5
sets the correlation value to the specified value.

Options: R&S SMW-B14/-K71/-K74

Manual operation: See "Real/Magnitude" on page 110

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:PRESet

The command presets the vector matrix to an unitary matrix.

Example: FSIM:MIMO:TAP2:GVEC:PRES
resets the gain vector matrix.

Usage: Event

Manual operation: See "Set to Unity" on page 111

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:<path>:GAIN

Sets the relative gain in the selected path.

For the correct syntax of the other available commands, see Chapter 8.7.1, "Relative
Gain", on page 168.

Parameters:
<Gain> float

Range: -50  to  0
Increment: 0.01
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:GVECtor:AA:GAIN -3
decreases the level in path AA by 3 dB.

Options: up to 4xR&S SMW-B14 and R&S SMW-K74
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:<path>:PHASe

Sets the phase shift of the selected path.

For the correct syntax of the other available commands, see Chapter 8.7.2, "Phase
Shift", on page 169.

Parameters:
<Phase> float

Range: 0  to  360
Increment: 0.02
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:GVECtor:AA:PHASe
45
shifts the phase in path AA by 45 degree.

Options: up to 4xR&S SMW-B14 and R&S SMW-K74

8.7 MIMO Vector Settings

8.7.1 Relative Gain

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AA:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AB:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AC:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AD:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AE:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AF:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AG:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AH:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BA:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BB:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BC:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BD:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BE:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BF:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BG:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BH:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CA:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CB:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CC:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CD:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CE:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CF:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CG:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CH:GAIN <Gain>
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DA:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DB:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DC:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DD:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DE:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DF:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DG:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DH:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EA:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EB:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EC:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:ED:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EE:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EF:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EG:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EH:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FA:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FB:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FC:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FD:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FE:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FF:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FG:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FH:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GA:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GB:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GC:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GD:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GE:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GF:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GG:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GH:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HA:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HB:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HC:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HD:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HE:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HF:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HG:GAIN <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HH:GAIN <Gain>

For description, refer to [:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:
<path>:GAIN on page 167.

8.7.2 Phase Shift

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AA:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AB:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AC:PHASe <Gain>
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AD:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AE:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AF:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AG:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:AH:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BA:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BB:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BC:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BD:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BE:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BF:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BG:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:BH:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CA:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CB:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CC:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CD:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CE:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CF:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CG:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:CH:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DA:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DB:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DC:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DD:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DE:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DF:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DG:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:DH:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EA:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EB:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EC:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:ED:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EE:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EF:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EG:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:EH:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FA:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FB:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FC:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FD:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FE:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FF:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FG:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:FH:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GA:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GB:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GC:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GD:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GE:PHASe <Gain>
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GF:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GG:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:GH:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HA:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HB:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HC:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HD:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HE:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HF:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HG:PHASe <Gain>
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:HH:PHASe <Gain>

For description, refer to [:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:
<path>:PHASe on page 168.

8.8 TGn Settings

The MIMO configurations are available with option R&S SMW-K74.

Example: Simulating one path TGn fading with two rays with different distribu-
tions
In the following example we assume that a MIMO fading configuration is enabled, e.g
2x2 MIMO. One MIMO path is activated, the default path settings are used.

// ******************************************************************
// Enable the corresponding matrix mode and set the relevant SCM settings
// ******************************************************************

SOURce:FSIMulator:MIMO:TAP:MATRix:MODE AOAaod
SOURce:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX 0.5
SOURce:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX 0.5

// ******************************************************************
// Set ray#1 to simulate signal scattered by 
// obstacles causing static fading distribution, e.g. a building
// ******************************************************************
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:GAIN 0
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:ARRival:ANGLe 72
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:ARRival:SPRead 5
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:DEParture:ANGLe 15
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:DEParture:SPRead 3
SOURce:FSIMulator:MIMO:TAP:TGN:DISTribution EQUal
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:STATe ON

// ******************************************************************
// Set ray#2 to simulate signal scattered by 
// obstacles causing Gaussian fading distribution, e.g. a tree 
// ******************************************************************
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SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:GAIN -10
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:ARRival:ANGLe 23
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:ARRival:SPRead 7
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:DEParture:ANGLe 25
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:DEParture:SPRead 5
SOURce:FSIMulator:MIMO:TAP:TGN:DISTribution GAUSs
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:STATe ON

// ******************************************************************
// Query the resulting matrix correlation coefficients with the 
// SOURce:FSIMulator:MIMO:TAP:MATRix:... commands
// ******************************************************************

[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX....................................... 172
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX........................................172
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:DISTribution......................................... 172
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:ANGLe...................... 173
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:ANGLe...................173
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:SPRead.....................173
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:SPRead................. 173
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:GAIN......................................173
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:STATe................................... 174

[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX <RxAntDist>
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX <TxAntDist>

Sets the RX/TX antenna distance in the SCM fading model.

Parameters:
<TxAntDist> float

Range: 0.1  to  2
Increment: 0.1
*RST: 0.5

Example: see Example "Simulating one path TGn fading with two rays with
different distributions" on page 171.

Manual operation: See "RX/TX Antenna Distance" on page 96

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:DISTribution <Distribution>

Selects one of the proposed statistical functions to determine the distribution of the
selected cluster.

Parameters:
<Distribution> LAPLace | EQUal | GAUSs

*RST: EQUal

Example: see Example "Simulating one path TGn fading with two rays with
different distributions" on page 171.

Manual operation: See "Distribution" on page 97
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:ANGLe
<ArrAngle>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:ANGLe
<DepAngle>

Sets the AoA (Angle of Arrival) / AoD (Angle of Departure) of the selected ray.

Parameters:
<DepAngle> float

Range: 0  to  359.9
Increment: 0.001
*RST: 0

<ArrAngle> float
Range: 0  to  359.9
Increment: 0.001
*RST: 0

Example: see Example "Simulating one path TGn fading with two rays with
different distributions" on page 171.

Manual operation: See "Angle of Departure (AoD)" on page 97

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:SPRead
<ArrSpread>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:SPRead
<DepSpread>

Sets the AoD (Angle of Departure) / AoA (Angle of Arrival) spread (AS) of the selected
ray.

Parameters:
<DepSpread> float

Range: 0.1  to  75
Increment: 0.001
*RST: 0.1

<ArrSpread> float
Range: 0.1  to  75
Increment: 0.001
*RST: 0.1

Example: see Example "Simulating one path TGn fading with two rays with
different distributions" on page 171.

Manual operation: See "AoD Spread" on page 97

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:GAIN <Gain>

Sets the relative gain (in dB) of the selected ray.
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Parameters:
<Gain> float

Range: -50  to  0
Increment: 0.001
*RST: 0

Example: see Example "Simulating one path TGn fading with two rays with
different distributions" on page 171.

Manual operation: See "Relative Gain /dB" on page 97

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:STATe <RayState>

Enables/disables the selected ray.

Parameters:
<RayState> 0 | 1 | OFF | ON

*RST: 0

Example: see Example "Simulating one path TGn fading with two rays with
different distributions" on page 171.

Manual operation: See "Ray State" on page 96

8.9 SCME, WINNER I, WINNER II and Antenna Model Set-
tings

The SCME, WINNER I and II, and the antenna model settings are available with option
R&S SMW-K72.

Example: Defining an antenna model
The following is a simple example on how to configure and enable an antenna model.

// Enable 2x2 MIMO configuration
SCONfiguration:MODE ADVanced
SCONfiguration:FADing MIMO2X2
SCONfiguration:APPLy

// select SCME/WINNER matrix mode
// configure the spacial channel model
SOURce1:FSIMulator:MIMO:TAP TAP1
SOURce1:FSIMulator:MIMO:TAP1:MATRix:MODE SCWI
SOURce1:FSIMulator:MIMO:SCWI:TAP1:SPEed 30kmh
SOURce1:FSIMulator:DEL:GROup1:PATH1:SPEed?
// Response:  8.333
SOURce1:FSIMulator:MIMO:SCWI:TAP1:DOT 120
SOURce1:FSIMulator:DEL:GROup1:PATH1:FRATio?
// Response: -0.5
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:TAP1:STATe 1
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SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:TAP1:SUBCluster1:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:GAIN 0
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:TAP1:SUBCluster1:GAIN?
// Response: -3.01029995663981
SOURce1:FSIMulator:DEL:GROup1:PATH1:LOSS?
// Response: 3.01
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:ARRival:ANGLe 0.7
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:DEParture:ANGLe 6.6
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:DEParture:SPRead 5
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:ARRival:SPRead 35
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:DISTribution LAPL

// enable channel polarization
SOURce1:FSIMulator:MIMO:ANTenna:MODeling:STATe 1
SOURce:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical 9
SOURce:FSIMulator:MIMO:ANTenna:POLarization:PRATio:HORizontal 9

// configure the Tx antenna array (BS)
SOURce1:FSIMulator:MIMO:ANTenna:TX:PATTern DIPole
SOURce1:FSIMulator:MIMO:ANTenna:TX:POLarization:ANGLe POLCROSS45
SOURce1:FSIMulator:MIMO:ANTenna:TX:COLumn:SIZE ANT01
SOURce1:FSIMulator:MIMO:ANTenna:TX:ROWS:SIZE ANT01
SOURce1:FSIMulator:MIMO:ANTenna:TX:ESPacing:CROSS 4

// configure the Rx antenna array (MS)
SOURce:FSIMulator:MIMO:ANTenna:RX:PATTern ISO
SOURce:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLe POLCROSS90
SOURce:FSIMulator:MIMO:ANTenna:RX:COLumn:SIZE ANT01
SOURce:FSIMulator:MIMO:ANTenna:RX:ROWS:SIZE ANT01
SOURce:FSIMulator:MIMO:ANTenna:RX:ESPacing:CROSS?
// 0.5

SOURce1:FSIMulator:STATe 1

// loading and using an user defined antenna pattern
// query predefined antenna pattern files (*.ant_pat)
SOURce:FSIMulator:MIMO:ANTenna:PATTern:CATalog?
// 3Sector,6Sector,Dipole,Isotropic
query existing user defined antenna pattern files (*.ant_pat)
SOURce:FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER? "/var/user/AntPatternFiles"
//  ant.ant_pat
SOURce1:FSIMulator:MIMO:ANTenna:TX:PATTern USER
SOURce1:FSIMulator:MIMO:ANTenna1:TX:PFILe "/var/user/AntPatternFiles/ant"

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:SPEed <Speed>

Sets the speed of the mobile station.
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Parameters:
<Speed> float

Range: 0  to  27778
Increment: 0.001
*RST: 0.83333

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "MS Speed" on page 101

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:DOT <DotAngle>

Sets the direction of travel of the mobile station.

Parameters:
<DotAngle> float

Range: 0  to  359.9
Increment: 0.1
*RST: 0

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "MS DoT (Direction of Travel)" on page 101

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:STATe
<SCWIClustState>

Enables/disables the selected cluster.

Parameters:
<SCWIClustState> 0 | 1 | OFF | ON

*RST: 0

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "Cluster State" on page 101

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:GAIN <SCWIGain>

Sets the relative gain (in dB) of the selected cluster.

Parameters:
<SCWIGain> float

Range: -50  to  0
Increment: 0.001
*RST: 0

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "Relative Gain /dB" on page 101
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[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:ANGLe
<SCWIArrAngle>

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:ANGLe
<SCWIDepAngle>

Sets the AoA (Angle of Arrival) / AoD (Angle of Departure) of the selected cluster.

Parameters:
<SCWIDepAngle> float

Range: 0  to  359.9
Increment: 0.001
*RST: 0

<SCWIArrAngle> float
Range: 0  to  360
Increment: 0.1
*RST: 0

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "Angle of Departure (AoD)" on page 102

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:SPRead
<SCWIArrSpread>

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:SPRead
<SCWIDepSpread>

Sets the AoD (Angle of Departure) / AoA (Angle of Arrival) spread (AS) of the selected
cluster.

Parameters:
<SCWIDepSpread> float

Range: 1  to  75
Increment: 0.001
*RST: 1

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "AoD Spread" on page 102

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DISTribution
<SCWIDistrib>

Sets one of the Power Azimuth Spectrum (PAS) distributions.

Parameters:
<SCWIDistrib> LAPLace | EQUal | GAUSs

*RST: EQUal

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "Distribution" on page 103

SCME, WINNER I, WINNER II and Antenna Model Settings



Remote-Control CommandsR&S®SMW-B14/-K71/-K72/-K74/-K75

178User Manual 1175.6826.02 ─ 09

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:SUBCluster<di>:
STATe <SCWISubClustSta>

If the corresponding cluster is enabled, enables the sub-clusters.

Suffix: 
<di>

.
1 .. 3
sub-cluster number

Parameters:
<SCWISubClustSta> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:SUBCluster2:STATe 1

Manual operation: See "State < Sub-Cluster" on page 101

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:SUBCluster<di>:
GAIN?

Queries the resulting relative gain of an enabled sub-cluster.

Return values: 
<SCWISubClusGain> float

Range: -50  to  0
Increment: 0.001
*RST: 0

Example: SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:SUBCluster2:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:GAIN 0
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:SUBCluster2:GAIN?
// Response: -5.299

Usage: Query only

Manual operation: See "Relative Gain /dB < Sub-Cluster" on page 102

[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:MODeling[:STATe] <AntennaState>

Enables/disables simulation of channel polarization.

Parameters:
<AntennaState> 0 | 1 | OFF | ON

*RST: 0

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "Channel Polarization State" on page 105
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[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog?

Queries the available predefined antenna pattern files (*.ant_pat).

To query the user-defined antenna pattern files, use the command [:SOURce]:
FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER? on page 179.

Return values: 
<Catalog> string

Files names without file extension.

Example: See Example "Defining an antenna model" on page 174.

Usage: Query only

Manual operation: See "User Defined Antenna Patterns per Row, Column"
on page 108

[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER? [<CatDir>]

Queries the user-defined antenna pattern files (*.ant_pat) in the specified directory.

Query parameters: 
<CatDir> string

File path

Return values: 
<Catalog> string

Files names without file extension.

Example: See Example "Defining an antenna model" on page 174.

Manual operation: See "User Defined Antenna Patterns per Row, Column"
on page 108

[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:HORizontal
<AntPolPowRatHor>

[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical
<AntPolPowRatVer>

Sets the cross polarization power ratio (XPR) in dB.

Parameters:
<AntPolPowRatVer> float

Range: 0  to  20
Increment: 0.001
*RST: 9

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "Vertical/Horizontal Cross Polarization Power Ratio"
on page 105
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[:SOURce]:FSIMulator:MIMO:ANTenna:RX:COLumn:SIZE <AntModRxColSize>
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ROWS:SIZE <AntModRxRowSize>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:COLumn:SIZE

<AntModTxColSize>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ROWS:SIZE <AntModTxRowSize>

Sets the number of rows and the number of columns in the antenna array.

Parameters:
<AntModTxRowSize> ANT01 | ANT02 | ANT03 | ANT04 | ANT08

*RST: ANT01

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "Number of Rows (M)/Columns (N)" on page 106

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:CROSs <Cross>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:CROSs <Cross>
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontal

<AntRxEspacHori>
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:VERTical <AntRxEspacVert>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:HORizontal

<AntTxEspacHori>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:VERTical

<AntTxEspacVert>

Sets the vertical, horizontal or cross polarized distance between the antennas in the
antenna array.

Parameters:
<AntTxEspacVert> float

Range: 0  to  10
Increment: 0.01
*RST: 0.5

<Cross> float
Range: 0  to  10
Increment: 0.01
*RST: 0

Example: see Example "Defining an antenna model" on page 174

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:PATTern <AntRxPattDesc>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:PATTern <AntTxPattDesc>

Sets the antenna pattern mode.

Parameters:
<AntTxPattDesc> ISOtropic | USER | SEC3 | SEC6 | DIPole

*RST: ISOtropic

Example: see Example "Defining an antenna model" on page 174
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Manual operation: See "Antenna Pattern" on page 108

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLe <AntRxPolAngle>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:POLarization:ANGLe

<AntTxPolAngle>

Set the antenna element polarization slant angle.

Parameters:
<AntTxPolAngle> POLCROSS45 | POLCROSS90 | POLCO0 | POLCO90

POLCROSS45 | POLCROSS90
cross-poliarization 45°/90°
POLCO0 | POLCO90
co-poliarization 0°/90° (vertical/horizontal poliarization)
*RST: POLCO0

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "Antenna Polarization Slant Angle" on page 106

[:SOURce]:FSIMulator:MIMO:ANTenna<di>:RX:PFILe <RxPattern>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna<di>:TX:PFILe <TxPattern>

Selects the antenna pattern file (*.ant_pat) per antenna.

Suffix: 
<di>

.
1 .. 8
value range depends on the selected system configuration, i.e.
the number of Tx and Rx antennas and the antenna array, i.e.
number of columns and rows

Parameters:
<TxPattern> string

Example: see Example "Defining an antenna model" on page 174

Manual operation: See "User Defined Antenna Patterns per Row, Column"
on page 108

8.10 2 Channel Interferer

The 2 channel interferer fading configurations are available with option R&S SMW-
K71.

Example: Enabling a two channel interferer fading configuration
The following is a simple example on how to configure and enable a two channel inter-
ferer fading configuration.

SOURce1:FSIMulator:CONFiguration TCI
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SOURce1:FSIMulator:TCInterferer:REFerence:PROFile PDOP
SOURce1:FSIMulator:TCInterferer:REFerence:LOSS 1
SOURce1:FSIMulator:TCInterferer:REFerence:SPEed 2
SOURce1:FSIMulator:TCInterferer:REFerence:FRATio 0.5
SOURce1:FSIMulator:TCInterferer:REFerence:DELay:MINimum 0.00003
SOURce1:FSIMulator:TCInterferer:PERiod 160

SOURce1:FSIMulator:TCInterferer:MOVing:PROFile SPAT
SOURce1:FSIMulator:TCInterferer:REFerence:LOSS 0
SOURce1:FSIMulator:TCInterferer:MOVing:DELay:MINimum 0.00003
SOURce1:FSIMulator:TCInterferer:MOVing:DELay:MAXimum 0.00011
SOURce1:FSIMulator:TCInterferer:MOVing:MMODe SLID

SOURce1:FSIMulator:TCInterferer:REFerence:STATe 1
SOURce1:FSIMulator:TCInterferer:MOVing:STATe 1
SOURce1:FSIMulator:TCINterferer:STATe 0
SOURce1:FSIMulator:STATE 1

SOURce1:FSIMulator:TCINterferer:REFerence:FDOPpler?
// Response: 3.33564095198152

[:SOURce<hw>]:FSIMulator:TCINterferer[:STATe]............................................................ 182
[:SOURce<hw>]:FSIMulator:TCINterferer:MOVing:DELay:MAXimum.................................. 183
[:SOURce<hw>]:FSIMulator:TCINterferer:MOVing:MMODe................................................183
[:SOURce<hw>]:FSIMulator:TCINterferer:PERiod............................................................. 183
[:SOURce<hw>]:FSIMulator:TCINterferer:SPEed.............................................................. 183
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:DELay:MINimum.................. 184
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler?.......................... 184
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FRATio................................184
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:LOSS..................................185
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:PROFile.............................. 185
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:STATe................................ 185

[:SOURce<hw>]:FSIMulator:TCINterferer[:STATe] <State>

Activates the 2 channel interferer fading configuration.

The paths and the fading simulator must be switched on separately, see [:
SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:STATe and [:
SOURce<hw>]:FSIMulator[:STATe].

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

Manual operation: See "Configuration" on page 27
See "State" on page 69
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[:SOURce<hw>]:FSIMulator:TCINterferer:MOVing:DELay:MAXimum <Maximum>

Sets the maximum delay for the moving path.

Parameters:
<Maximum> float

Range: dynamic  to  0.001
Increment: 20E-9
*RST: 110E-6

Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

Manual operation: See "Delay Max (Moving Path)" on page 70

[:SOURce<hw>]:FSIMulator:TCINterferer:MOVing:MMODe <MMode>

Selects the type of moving applied to the moving path.

Parameters:
<MMode> SLIDing | HOPPing

*RST: HOPPing

Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

Manual operation: See "Moving Mode (Moving Path)" on page 71

[:SOURce<hw>]:FSIMulator:TCINterferer:PERiod <Period>

Sets either the dwell time or the period for a complete cycle of the moving path.

Parameters:
<Period> float

Range: 0.1  to  10
Increment: 0.01
*RST: 2.9 s (for hopping mode) / 160 s (for sliding mode)

Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

Manual operation: See "Period/Dwell" on page 71

[:SOURce<hw>]:FSIMulator:TCINterferer:SPEed <Speed>

Sets the speed v of the moving receiver for 2 channel interferer fading.

Parameters:
<Speed> float

Range: 0  to  27778 (dynamic)
Increment: 0.001
*RST: 0.83333

2 Channel Interferer
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Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

Manual operation: See "Speed" on page 70

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:DELay:MINimum
<Minimum>

Sets the minimum delay for the reference path and the moving path.

Parameters:
<Minimum> float

Range: 0  to  dynamic
Increment: 20E-9
*RST: 0

Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

Manual operation: See "Delay Min" on page 70

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler?

Queries the Doppler frequency of the reference and moving path with 2 channel inter-
ferer fading.

Return values: 
<FDoppler> float

Range: 0  to  1000
Increment: 0.01
*RST: 0

Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

Usage: Query only

Manual operation: See "Profile" on page 69
See "Res. Doppler Shift" on page 70

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FRATio <FRatio>

Sets the ratio of the actual Doppler frequency to the set Doppler frequency for the ref-
erence and moving path with 2 channel interferer fading.

Parameters:
<FRatio> float

Range: -1  to  1
Increment: 0.0001
*RST: 0

Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

2 Channel Interferer
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Manual operation: See "Freq. Ratio" on page 70

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:LOSS <Loss>

Seta the loss of the reference and moving path with 2 channel interferer fading.

Parameters:
<Loss> float

Range: 0  to  50
Increment: 0.1
*RST: 0

Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

Manual operation: See "Path Loss" on page 69

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:PROFile <Profile>

Sets the fading profile to be used for the reference and moving path with 2 channel
interferer fading.

Parameters:
<Profile> SPATh | PDOPpler | RAYLeigh

*RST: SPATh

Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:STATe <State>

Activate the reference and moving path of the 2 channel interferer fading configuration.

The 2 channel interferer fading configuration and the fading simulator must be
switched on separately, see [:SOURce<hw>]:FSIMulator:TCINterferer[:
STATe] on page 182 and .[:SOURce<hw>]:FSIMulator[:STATe]
Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: see Example "Enabling a two channel interferer fading configu-
ration" on page 181

Manual operation: See "State" on page 69

8.11 Custom Fading Profile

The custom fading profile requires R&S SMW-K72.
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Example: Enabling, configuring and disabling a custom fading profile
The following is a simple example on how to configure, enable and disable a custom
profile.

SOURce1:FSIMulator:DELay:GROup1:PATH2:PROFile CUSTom
SOURce1:FSIMulator:DEL:GROup1:PATH2:CUSTom:DATA 200,100,100,200

SOURce1:FSIMulator:DEL:GROup1:PATH2:CUSTom:DSHape FLAT

SOURce1:FSIMulator:DEL:GROup1:PATH2:PROFile RAYL

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:DSHape............ 186
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:DATA................186

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DSHape <DopplerShape>

Sets the doppler shape of the virtual profile.

Parameters:
<DopplerShape> FLAT | RAYLeigh

*RST: RAYLeigh

Example: see Example "Enabling, configuring and disabling a custom fad-
ing profile" on page 186

Manual operation: See "Doppler Shape" on page 79

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:DATA
<Bandwidth>, <OffsetFreq>, <LowerCutFreq>, <UpperCutFreq>

Sets the paramters of the custom fading profile.

Parameters:
<Bandwidth> float

Range: 50  to  40000
Increment: 1
*RST: 200
Default unit: Hz

<OffsetFreq> float
Range: -23950  to  23950
Increment: 1
*RST: 0
Default unit: Hz

<LowerCutFreq> float
Range: -4000  to  3950
Increment: 1
*RST: 0
Default unit: Hz

Custom Fading Profile
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<UpperCutFreq> float
Range: -3950  to  4000
Increment: 1
*RST: 100
Default unit: Hz

Example: see Example "Enabling, configuring and disabling a custom fad-
ing profile" on page 186

Manual operation: See "Bandwidth" on page 79
See "Frequency Offset" on page 79
See "Lower/Upper Cutoff Frequency" on page 79

Custom Fading Profile
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Annex
A Predefined Fading Settings

The predefined fading settings correspond to the test scenarios stipulated in the com-
mon mobile radio standards. The following tables provide a listing of the predefined
standards along with the underlying test scenarios and the enabled settings.

● CDMA Standards.................................................................................................. 188
● GSM Standards.....................................................................................................191
● NADC Standards...................................................................................................196
● PCN Standards..................................................................................................... 197
● TETRA Standards.................................................................................................202
● 3GPP Standards................................................................................................... 206
● WLAN Standards.................................................................................................. 217
● DAB Standards..................................................................................................... 222
● WIMAX Standards.................................................................................................224
● LTE Standards...................................................................................................... 237
● LTE-MIMO Standards........................................................................................... 240
● WIMAX-MIMO Standards......................................................................................242
● 1xEVDO Standards...............................................................................................246
● 3GPP/LTE High Speed Train................................................................................250
● 3GPP/LTE Moving Propagation............................................................................252
● SCME Channel Models for MIMO OTA................................................................ 254
● Watterson Standards............................................................................................ 256
● 802.11n-SISO Standards......................................................................................258
● 802.11n-MIMO Standards.....................................................................................258
● 802.11ac-MIMO Standards...................................................................................269
● 802.11ac-SISO Standards.................................................................................... 279
● 802.11p Channel Models...................................................................................... 280

A.1 CDMA Standards

A.1.1 CDMA 1 (8km/h - 2 Path)

Table A-1: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Correlated with: off off
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 Path 1 Path 2

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 8 8

also with 15km/h in band class 5

A.1.2 CDMA 2 (30km/h - 2 Path)

Table A-2: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Correlated with: off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 30 30

also with 14km/h in band classes 1,4,6,8

also with 58km/h in band class 5

A.1.3 CDMA 3 (30km/h - 1 Path)

Table A-3: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Correlated with: off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 30

also with 58km/h in band class 5

 

 

CDMA Standards



Predefined Fading SettingsR&S®SMW-B14/-K71/-K72/-K74/-K75

190User Manual 1175.6826.02 ─ 09

A.1.4 CDMA 4 (100km/h - 3 Path)

Table A-4: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1 Path 2 Path 3

Profile [Type] Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 3

Delay [ns]: 0 2000 14500

LogNormal off off off

Correlated with: off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0 0 0

Speed [km/h]: 100 100 100

also with 192km/h in band class 5

A.1.5 CDMA 5 (0km/h - 2 Path)

Table A-5: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Correlated with: off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 0 0

A.1.6 CDMA 6 (3km/h - 1 Path)

Table A-6: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Correlated with: off
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 Path 1

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 3

A.2 GSM Standards

A.2.1 GSM TU3 (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 0 2 6 8 10

Delay [ns]: 0 200 500 1600 2300 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3 3

A.2.2 GSM TU50 (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 0 2 6 8 10

Delay [ns]: 0 200 500 1600 2300 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50
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A.2.3 GSM HT100 (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1,5 4,5 7,5 8 17,7

Delay [ns]: 0 100 300 500 15000 17200

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 100 100 100 100 100 100

A.2.4 GSM RA250 (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rice Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 4 8 12 16 20

Delay [ns]: 0 100 200 300 400 500

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 6,88 0 0 0 0 0

Freq Ratio: 0,7 0 0 0 0 0

Speed [km/h]: 250 250 250 250 250 250

There has been a change in the specifications TS8916B, Baseline Change from 5.1.0
to 5.2.0. The power ratio for path 1 with Rice fading is now no longer referred only to
Rayleigh of path 1. Instead, it is referred to the total power of all of the paths.
The preset value used in the instrument of 6.88 fulfills this requirement. It does not
conform to the value given in the specification since the instrument always determines
the power ratio for one path. By taking into account the power of the other paths in cal-
culating this value, however, the required power ratio for all six paths is achieved.

A.2.5 GSM ET50 (EQ50) (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

A.2.6 GSM ET60 (EQ60) (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 60 60 60 60 60 60

A.2.7 GSM ET100 (EQ100) (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 100 100 100 100 100 100
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A.2.8 GSM TU3 (12 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 3 0 2,6 3 5

Delay [ns]: 0 100 300 500 800 1100

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3 3

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 7 5 6,5 8,6 11 10

Delay [ns]: 1300 1700 2300 3100 3200 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3 3

A.2.9 GSM TU50 (12 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 3 0 2,6 3 5

Delay [ns]: 0 100 300 500 800 1100

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 7 5 6,5 8,6 11 10
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Delay [ns]: 1300 1700 2300 3100 3200 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

A.2.10 GSM HT100 (12 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 10 8 6 4 0 0

Delay [ns]: 0 100 300 500 700 1000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 100 100 100 100 100 100

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 8 9 10 12 14

Delay [ns]: 1300 15000 15200 15700 17200 20000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 100 100 100 100 100 100

A.2.11 GSM TI5

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0
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 Path 1 Path 2

Delay [ns]: 0 400

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 5 5

A.3 NADC Standards

Path 2 should be placed in its own group (delay max. 40 000 ns).

A.3.1 NADC 8 (2 Path)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 41200

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 8 8

A.3.2 NADC 50 (2 Path)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 41200

LogNormal off off

Corr with off off
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 Path 1 Path 2

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 50 50

A.3.3 NADC 100 (2 Path)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 41200

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 100 100

A.4 PCN Standards

A.4.1 PCN TU1.5 (6 Path)

Same as GSM Tux

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 0 2 6 8 10

Delay [ns]: 0 200 500 1600 2300 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 1,5 1,5 1,5 1,5 1,5 1,5
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A.4.2 PCN TU50 (6 Path)

Same as GSM TU50

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 0 2 6 8 10

Delay [ns]: 0 200 500 1600 2300 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

A.4.3 PCN HT100 (6 Path)

Same as GSM

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1,5 4,5 7,5 8 17,7

Delay [ns]: 0 100 300 500 15000 17200

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 100 100 100 100 100 100

A.4.4 PCN RA130 (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rice Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 4 8 12 16 20

Delay [ns]: 0 100 200 300 400 500

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 6,47 0 0 0 0 0
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Freq Ratio: 0,7 0 0 0 0 0

Speed [km/h]: 130 130 130 130 130 130

A.4.5 PCN ET50 (EQ50) (6 Path)

Same as GSM

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

50 50 50 50 50 50

A.4.6 PCN ET60 (EQ60) (6 Path)

Same as GSM

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

60 60 60 60 60 60
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A.4.7 PCN ET100 (EQ100) (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

100 100 100 100 100 100

A.4.8 PCN TU1.5 (12 Path)

Same as GSM Tux

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 3 0 2,6 3 5

Delay [ns]: 0 100 300 500 800 1100

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

1,5 1,5 1,5 1,5 1,5 1,5

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 7 5 6,5 8,6 11 10

Delay [ns]: 1300 1700 2300 3100 3200 5000

LogNormal off off off off off off

Corr with off off off off off off

 

 

PCN Standards



Predefined Fading SettingsR&S®SMW-B14/-K71/-K72/-K74/-K75

201User Manual 1175.6826.02 ─ 09

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

1,5 1,5 1,5 1,5 1,5 1,5

A.4.9 PCN TU50 (12 Path)

Same as GSM

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 3 0 2,6 3 5

Delay [ns]: 0 100 300 500 800 1100

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 7 5 6,5 8,6 11 10

Delay [ns]: 1300 1700 2300 3100 3200 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

A.4.10 PCN HT100 (12 Path)

Same as GSM

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 10 8 6 4 0 0
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Delay [ns]: 0 100 300 500 700 1000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

100 100 100 100 100 100

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 8 9 10 12 14

Delay [ns]: 1300 15000 15200 15700 17200 20000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

100 100 100 100 100 100

A.5 TETRA Standards

A.5.1 TETRA TU50 (2 Path)

EN300 392-2

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 22,3

Delay [ns]: 0 5000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0
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 Path 1 Path 2

Freq Ratio: 0 0

Speed [km/h]: 50 50

A.5.2 TETRA TU50 (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3.00 0 2.0 6.0 8.0 10.0

Delay [ns]: 0 0 0 0 0 0

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

50 50 50 50 50 50

A.5.3 TETRA BU50 (2 Path)

EN300 392-2

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 3

Delay [ns]: 0 5000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 50 50
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A.5.4 TETRA HT200 (2 Path)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 8,6

Delay [ns]: 0 15000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 200 200

A.5.5 TETRA HT200 (6 Path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 2 4 7 6 12

Delay [ns]: 0 200 400 600 15000 17200

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

200.02 200.02 200.02 200.02 200.02 200.02

A.5.6 TETRA ET200 (4 Path)

EN300 392-2, Equalizer Test

Note:Path 3 and 4 should be placed in their own group (delay max. 40 000 ns)

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 10,2 16
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 Path 1 Path 2 Path 3 Path 4

Delay [ns]: 0 11600 73200 99300

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: 200 200 200 200

A.5.7 TETRA DU 50 (1Path)

ETSI EN 300 396-2 V1.2.1

 Path 1

Profile [Type] Rice

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0,7

Speed [km/h]: 50

A.5.8 TETRA DR 50 (1Path)

ETSI EN 300 396-2 V1.2.1

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 50

 

 

TETRA Standards



Predefined Fading SettingsR&S®SMW-B14/-K71/-K72/-K74/-K75

206User Manual 1175.6826.02 ─ 09

A.6 3GPP Standards

VAx are typical fading profiles, with x representing the speed, such as VA3 represents
3 km/h.
These standards define a certain combination of channels with a specific doppler fre-
quency. Basically, the maximum possible doppler frequency of a path is determined by
the RF output frequency and the speed of the moving mobile receiver. However, if you
change the RF frequency in a VAx standard, the doppler frequency remains the same,
thus resulting in individual speed settings.
Refer also to Chapter A.6.12, "3GPP Mobile VA3, 3GPP Mobile VA30, 3GPP Mobile
VA120", on page 210 for VAx fading profiles.

A.6.1 3GPP Case 1 (UE/BS)

Table A-7: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0 (2003-09), annex
D.2

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 10

Delay [ns]: 0 976

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 3 3

A.6.2 3GPP Case 2 (UE/BS)

Table A-8: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0 (2003-09), annex
D.2

 Path 1 Path 2 Path 3

Profile [Type] Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0

Delay [ns]: 0 976 20000

LogNormal off Off off

Corr with off Off off

Power Ratio [dB]: 0 0 0
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 Path 1 Path 2 Path 3

Freq Ratio: 0 0 0

Speed [km/h]: 3 3 3

A.6.3 3GPP Case 3 (UE/BS)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0
(2003-09), annex D.2

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 3 6 9

Delay [ns]: 0 260 521 781

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: 120 120 120 120

A.6.4 3GPP Case 4 (UE)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 976

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 3 3

A.6.5 3GPP Case 5 (UE)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2
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 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 10

Delay [ns]: 0 976

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 50 50

A.6.6 3GPP Case 6 (UE) and Case 4 (BS)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0
(2003-09), annex D.2

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 3 6 9

Delay [ns]: 0 260 521 781

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: 250 250 250 250

A.6.7 3GPP Mobile Case 7 (UE-Sector)

Table A-9: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 4.3 6.6 2 7 7.5

Delay [ns]: 0 260 1040 4690 7290 14580

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

50 50 50 50 50 50

A.6.8 3GPP Mobile Case 7 (UE-Beam)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0.3 0.9

Delay [ns]: 4690 7290 14580

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0 0 0

Speed [km/h]: 50 50 50

A.6.9 3GPP Mobile Case 8 (UE, CQI)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, Table B.1C;

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 10

Delay [ns]: 0 976

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 30 30

A.6.10 3GPP Mobile PA3

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, ITU Pedestrian A (HSDPA)
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 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 9.7 19.2 22.8

Delay [ns]: 0 110 190 410

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: 3 3 3 3

A.6.11 3GPP Mobile PB3

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, ITU Pedestrian B (HSDPA)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0.9 4.9 8 7.8 23.9

Delay [ns]: 0 200 800 1200 2300 3700

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

3 3 3 3 3 3

A.6.12 3GPP Mobile VA3, 3GPP Mobile VA30, 3GPP Mobile VA120

Table A-10: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, ITU vehicular A (HSDPA)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1 9 10 15 20

Delay [ns]: 0 310 710 1090 1730 2510

LogNormal off off off off off off

Corr with off off off off off off
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

3 | 30 | 120 1) 3 | 30 | 120 1) 3 | 30 | 120 1) 3 | 30 | 120 1) 3 | 30 | 120 1) 3 | 30 | 120 1)

1) Speed of the respective standard VAx: VA3 = 3 km/h, VA30 = 30 km/h and VA120 =
120 km/h.

A.6.13 3GPP MBSFN Propagation Channel Profile (18 Path)

Table A-11: 3GPP 3GPP TS 36.521-1 respectivelly TS36.101 V9.8.0

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1.5 1.4 3.6 0.6 7.0

Delay [ns]: 0 30 150 310 370 1090

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Frequency
[Hz]: *

3 3 3 3 3 3

Table A-12: 3GPP 3GPP TS 36.521-1 respectivelly TS36.101 V9.8.0 (Cont.)

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 10.0 11.5 11.4 13.6 10.6 17.0

Delay [ns]: 12490 12520 12640 12800 12860 13580

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Frequency
[Hz]: *

3 3 3 3 3 3
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Table A-13: 3GPP 3GPP TS 36.521-1 respectivelly TS36.101 V9.8.0 (Cont.)

 Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 20.0 21.5 21.4 23.6 20.6 27.0

Delay [ns]: 27490 27520 27640 27800 27860 28580

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Frequency
[Hz]: *

3 3 3 3 3 3

A.6.14 3GPP Birth Death

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.4

 Path 1 Path 2

Profile [Type] Static Static

Loss [dB]: 0 0

Delay [ns]: 0…10us 0…10us

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 1 1

Speed [km/h]: 0 0

Dwell: 191ms

(Mean)-Offset: 5 us

A.6.15 3GPP TUx

Table A-14: 3GPP TS 25.943 V5.1.0 (2002-06)

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 7.6 10.1 10.2 5.7 16.3

Delay [ns]: 217 512 514 0 1230

LogNormal off off off off off
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 Path 1 Path 2 Path 3 Path 4 Path 5

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3

Table A-15: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

 Path 6 Path 7 Path 8 Path 9 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 10.2 11.5 13.4 21.5 21.6

Delay [ns]: 517 674 882 1820 1840

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3

Table A-16: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

 Path 11 Path 12 Path 13 Path 14 Path 15

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 16.9 17.1 17.4 22.1 22.6

Delay [ns]: 1287 1311 1349 1880 1940

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3

Table A-17: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

 Path 16 Path 17 Path 18 Path 19 Path 20

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 19 19 19.8 23.5 24.3

Delay [ns]: 1533 1535 1622 2050 2140

LogNormal off off off off off
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 Path 16 Path 17 Path 18 Path 19 Path 20

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3

A.6.16 3GPP HTx

Table A-18: 3GPP TS 25.943 V5.1.0 (2002-06)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7 Path 8 Path 9 Path 10

Profile
[Type]

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Loss
[dB]:

8.9 10.2 11.5 3.6 17.6 11.8 12.7 13 25.8 26.2

Delay
[ns]:

356 441 528 0 15000 546 609 625 16880 16980

Log-
Normal

off off off off off off off off off off

Corr
with

off off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0 0

Speed
[km/h]:

100 100 100 100 100 100 100 100 100 100

Table A-19: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

 Path
11

Path
12

Path
13

Path
14

Path
15

Path
16

Path
17

Path
18

Path
19

Path
20

Profile
[Type]

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Loss
[dB]:

16.2 17.3 17.7 29 29.9 22.7 24.1 25.8 30 30.7

Delay
[ns]:

842 916 941 17620 17830 16172 16492 16876 17850 18020

Log-
Normal

off off off off off off off off off off

Corr
with

off off off off off off off off off off
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 Path
11

Path
12

Path
13

Path
14

Path
15

Path
16

Path
17

Path
18

Path
19

Path
20

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0 0

Speed
[km/h]:

100 100 100 100 100 100 100 100 100 100

A.6.17 3GPP RAx

Table A-20: 3GPP TS 25.943 V5.1.0 (2002-06)

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Pure Dop Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 5.2 6.4 8.4 9.3 10

Delay [ns]: 0 42 101 129 149

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0.7 0 0 0 0

Speed [km/h]: 250 250 250 250 250

Table A-21: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

 Path 6 Path 7 Path 8 Path 9 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 13.1 15.3 18.5 20.4 22.4

Delay [ns]: 245 312 410 469 528

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0 0 0 0 0

Speed [km/h]: 250 250 250 250 250

A.6.18 3GPP Birth Death

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.4
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 Path 1 Path 2

Profile [Type] Static Static

Loss [dB]: 0 0

Delay [ns]: 0…10us 0…10us

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 1 1

Speed [km/h]: 0 0

Dwell: 191ms

(Mean)-Offset: 5 us

A.6.19 Reference + Moving Channel

See Chapter A.15.1, "Reference + Moving Channel", on page 252.

A.6.20 HST1 Open Space, HST1 Open Space (DL+UL)

See Chapter A.14.1, "HST1 Open Space, HST1 Open Space (DL+UL)", on page 250.

A.6.21 HST2 Tunnel Leaky Cable

See Chapter A.14.2, "HST2 Tunnel Leaky Cable, HST2 Tunnel Leaky Cable (DL+UL)",
on page 251.

A.6.22 HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL+UL)

See Chapter A.14.3, "HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL
+UL)", on page 251.
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A.7 WLAN Standards

A.7.1 WLAN / HyperLan/2 Model A

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7 Path 8 Path 9

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

0 0,9 1,7 2,6 3,5 4,3 5,2 6,1 6,9

Delay
[ns]:

0 10 20 30 40 50 60 70 80

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

 Path 10 Path 11 Path 12 Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

7,8 4,7 7,3 9,9 12,5 13,7 18 22,4 26,7

Delay
[ns]:

90 110 140 170 200 240 290 340 390

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8
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Corresp. to a typical office environment for NLOS conditions and an average rms delay
spread of 50ns

A.7.2 WLAN / HyperLan/2 Model B

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7 Path 8 Path 9

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

2,6 3 3,5 3,9 0 1,3 2,6 3,9 3,4

Delay
[ns]:

0 10 20 30 50 80 110 140 180

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

 Path 10 Path 11 Path 12 Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

5,6 7,7 9,9 12,1 14,3 15,4 18,4 20,7 24,6

Delay
[ns]:

230 280 330 380 430 490 560 640 730

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

Corresp. to a typical large open space and office environments for NLOS conditions
and an average rms delay spread of 100ns
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A.7.3 WLAN / HyperLan/2 Model C

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7 Path 8 Path 9

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

3,3 3,6 3,9 4,2 0 0,9 1,7 2,6 1,5

Delay
[ns]:

0 10 20 30 50 80 110 140 180

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

 Path 10 Path 11 Path 12 Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

3 4,4 5,9 5,3 7,9 9,4 13,2 16,3 21,2

Delay
[ns]:

230 280 330 400 490 600 730 880 1050

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8
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A.7.4 WLAN / HyperLan/2 Model D

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7 Path 8 Path 9

Profile
[Type]

Rice Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

0 10 10,3 10,6 6,4 7,2 8,1 9 7,9

Delay
[ns]:

0 10 20 30 50 80 110 140 180

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

10 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

 Path 10 Path 11 Path 12 Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

9,4 10,8 12,3 11,7 14,3 15,8 19,6 22,7 27,6

Delay
[ns]:

230 280 330 400 490 600 730 880 1050

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

Corresponds to a typical office environment for "LOS" conditions. A 10db spike at 0
delay has been added resulting in an average rms delay spread of 140ns
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A.7.5 WLAN / HyperLan/2 Model E

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7 Path 8 Path 9

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

4,9 5,1 5,2 0,8 1,3 1,9 0,3 1,2 2,1

Delay
[ns]:

0 10 20 40 70 100 140 190 240

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

 Path 10 Path 11 Path 12 Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

0 1,9 2,8 5,4 7,3 10,6 13,4 17,4 20,9

Delay
[ns]:

320 430 560 710 880 1070 1280 1510 1760

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

Corresponds to a typical large open space environment for NLOS conditions and an
average rms delay spread of 250ns
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A.8 DAB Standards

A.8.1 DAB RA (4Tabs)

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rice Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 2 10 20

Delay [ns]: 0 200 400 600

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]:  0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: 120 120 120 120

Tap 2: S(d) = 0,1 +/- 0,02

A.8.2 DAB RA (6 Tabs)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rice Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 4 8 12 16 20

Delay [ns]: 0 100 200 300 400 500

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

120 120 120 120 120 120
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A.8.3 DAB TU (12 Tabs)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Gaus1 Gaus1

Loss [dB]: 4 3 0 2,6 3 5

Delay [ns]: 0 100 300 500 800 1100

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

25 25 25 25 25 25

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile
[Type]

Gaus1 Gaus1 Gaus2 Gaus2 Gaus2 Gaus2

Loss [dB]: 7 5 6,5 8,6 11 10

Delay [ns]: 1300 1700 2300 3100 3200 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

25 25 25 25 25 25

Tap 6: S(d) = 1,0 +/- 0,1

A.8.4 DAB TU (6 Tabs)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Gaus1 Gaus2 Gaus2

Loss [dB]: 3 0 2 6 8 10

Delay [ns]: 0 200 500 1600 2300 5000

LogNormal off off off off off off

Corr with off off off off off off
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

25 25 25 25 25 25

Tap 3: S(d) = 1,0 +/- 0,1

A.8.5 DAB SFN (VHF)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7

Profile
[Type]

Rayleigh GausDAB GausDAB GausDAB GausDAB GausDAB GausDAB

Loss [dB]: 0 13 18 22 26 31 32

Delay [ns]: 0 100000 220000 290000 385000 480000 600000

LogNor-
mal

off off off off off off off

Corr with off off off off off off off

Power
Ratio [dB]:

0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0

Speed
[km/h]:

60 60 60 60 60 60 60

Needs both Fading Boards combined, i.e. Signal Routing "A->A(max paths) || B-
>B(unfaded)" or "A->A(unfaded) || B->B(max paths)".
Do not use Group 5.

A.9 WIMAX Standards

A.9.1 SUI 1 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 15 20
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 Path 1 Path 2 Path 3

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 6,0206 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K-fact. = 4 ->> 10lg4 = 6,02

A.9.2 SUI 1 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 15 20

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 13,0103 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

A.9.3 SUI 1 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 21 32

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 12,0412 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06
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A.9.4 SUI 1 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 21 32

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 18,57332 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K-fact. = 72

A.9.5 SUI 2 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 12 15

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 3,0103 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=2

A.9.6 SUI 2 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 12 15

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off
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 Path 1 Path 2 Path 3

Power Ratio [dB]: 10,41393 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

A.9.7 SUI 2 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 18 27

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 9,0309 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=8

A.9.8 SUI 2 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 18 27

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 15,56303 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=36
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A.9.9 SUI 3 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 5 10

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

A.9.10 SUI 3 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 5 10

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 8,45098 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=7

A.9.11 SUI 3 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 11 22

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 4,771213 0 0
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 Path 1 Path 2 Path 3

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=3

A.9.12 SUI 3 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 11 22

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 12,78754 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=19

A.9.13 SUI 4 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 4 8

Delay [ns]: 0 1500 4000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=0 (no Rice-component)
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A.9.14 SUI 4 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 4 8

Delay [ns]: 0 1500 4000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=1

A.9.15 SUI 4 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 10 20

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=1

A.9.16 SUI 4 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 10 20

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off
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 Path 1 Path 2 Path 3

Power Ratio [dB]: 6,9897 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=5

A.9.17 SUI 5 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 5 10

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=0 (no Rice-component)

A.9.18 SUI 5 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 5 10

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=0 (no Rice-component)
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A.9.19 SUI 5 (omni ant., 50%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 5 10

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 3,0103 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=2

A.9.20 SUI 5 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 11 22

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=0 (no Rice-component)

A.9.21 SUI 5 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 11 22

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off
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 Path 1 Path 2 Path 3

Power Ratio [dB]: 3,0103 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=2

A.9.22 SUI 5 (30° ant., 50%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 11 22

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 8,45098 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=7

A.9.23 SUI 6 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 10 14

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=0 (no Rice-component)

 

 

WIMAX Standards



Predefined Fading SettingsR&S®SMW-B14/-K71/-K72/-K74/-K75

234User Manual 1175.6826.02 ─ 09

A.9.24 SUI 6 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 10 14

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=0 (no Rice-component)

A.9.25 SUI 6 (omni ant., 50%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 10 14

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=1

A.9.26 SUI 6 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 16 26

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off
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 Path 1 Path 2 Path 3

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=0 (no Rice-component)

A.9.27 SUI 6 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 16 26

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 3,0103 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=2

A.9.28 SUI 6 (30° ant., 50%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 16 26

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 6,9897 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=5
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A.9.29 ITU OIP-A

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 9,7 19,2 22,8

Delay [ns]: 0 110 190 410

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: - - - -

A.9.30 ITU OIP-B

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0,9 4,9 8 7,8 23,9

Delay [ns]: 0 200 800 1200 2300 3700

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

- - - - - -

A.9.31 ITU V-A 60

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1 9 10 15 20

Delay [ns]: 0 310 710 1090 1730 2510

LogNormal off off off off off off

Corr with off off off off off off
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

60 60 60 60 60 60

A.9.32 ITU V-A 120

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1 9 10 15 20

Delay [ns]: 0 310 710 1090 1730 10000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

120 120 120 120 120 120

A.10 LTE Standards

A.10.1 CQI 5Hz

CQI Tests according to 3GPP 36.521.1 Version 9.1.0, B2.4

 Path 1 Path 2

Profile [Type] Const. Phase Pure Doppler

Loss [dB]: 0 0

Delay [ns]: 0 450

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0
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 Path 1 Path 2

Freq Ratio: 0 0

Speed [Hz]: 0 5 Hz

A.10.2 EPA (Extended Pedestrian A)

Table A-22: 3GPP TR36.803

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1 2 3 8

Delay [ns]: 0 30 70 90 110

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Frequency
[Hz]:

5 5 5 5 5

 Path 6 Path 7 Path 8 Path 9 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 17.2 20.8    

Delay [ns]: 190 410    

LogNormal off off    

Corr with off off    

Power Ratio
[dB]:

0 0    

Frequency
[Hz]:

5 5    

A.10.3 EVA (Extended Vehicular A)

Table A-23: 3GPP TR36.803

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1.5 1.4 3.6 0.6

Delay [ns]: 0 30 150 310 370

LogNormal off off off off off

Corr with off off off off off
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 Path 1 Path 2 Path 3 Path 4 Path 5

Power Ratio
[dB]:

0 0 0 0 0

Frequency
[Hz]: *

     

 Path 6 Path 7 Path 8 Path 9 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 9.1 7 12 16.9  

Delay [ns]: 710 1090 1730 2510  

LogNormal off off off off  

Corr with off off off off  

Power Ratio
[dB]:

0 0 0 0  

Frequency
[Hz]: *

     

* Possible frequency values are 5 Hz or 70 Hz

A.10.4 ETU (Extended Typical Urban)

Table A-24: 3GPP TR36.803

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 1 1 1 0 0

Delay [ns]: 0 50 120 200 230

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Frequency
[Hz]: *

     

 Path 6 Path 7 Path 8 Path 9 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 3 5 7  

Delay [ns]: 500 1600 2300 5000  

LogNormal off off off off  

Corr with off off off off  
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 Path 1 Path 2 Path 3 Path 4 Path 5

Power Ratio
[dB]:

0 0 0 0  

Frequency
[Hz]: *

     

* Possible frequency values are 70 Hz or 300 Hz

A.10.5 MBSFN Propagation Channel Profile (5 Hz)

See Chapter A.6.13, "3GPP MBSFN Propagation Channel Profile (18 Path)",
on page 211.

* All fading paths use "Frequency = 5 Hz" and "Speed = 5.4 km/h".

A.10.6 HST1 Open Space

See Chapter A.14.1, "HST1 Open Space, HST1 Open Space (DL+UL)", on page 250.

A.10.7 HST3 Tunnel Multi Antennas

See Chapter A.14.3, "HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL
+UL)", on page 251.

A.10.8 ETU 200Hz Moving

See Chapter A.15.2, "ETU 200Hz Moving (UL Timing Adjustment, Scenario 1)",
on page 252.

A.10.9 Pure Doppler Moving

SeeChapter A.15.3, "Pure Doppler Moving (UL Timing Adjustment, Scenario 2)",
on page 253.

A.11 LTE-MIMO Standards

A.11.1 EPA (Extended Pedestrian A)

See Chapter A.10.2, "EPA (Extended Pedestrian A)", on page 238.
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A.11.2 EVA (Extended Vehicular A)

See Chapter A.10.3, "EVA (Extended Vehicular A)", on page 238.

A.11.3 ETU (Extended Typical Urban)

See Chapter A.10.4, "ETU (Extended Typical Urban)", on page 239.

A.11.4 MIMO Parameter

Table A-25: R-High

real imaginary real imaginary real imaginary real imaginary

1 0 -0.4193 0.24 0.5297 0.7013 -0.3904 -0.1669

-0.4193 -0.24 1 0 -0.0538 -0.4212 0.5297 0.7013

0.5297 -0.7013 -0.0538 0.4212 1 0 -0.4193 0.24

-0.3904 0.1669 0.5297 -0.7013 -0.4193 -0.24 1 0

Table A-26: R-Medium

real imaginary real imaginary real imaginary real imaginary

1 0 0 0 0.7264 0 0 0

0 0 1 0 0 0 -0.7264 0

0.7264 0 0 0 1 0 0 0

0 0 -0.7264 0 0 0 1 0

Table A-27: R-Low

real imaginary real imaginary real imaginary real imaginary

1 0 0 0 0 0 0 0

0 0 1 0 0 0 0 0

0 0 0 0 1 0 0 0

0 0 0 0 0 0 1 0

The MIMO correlation matrices for the high, medium and low antenna correlation for
the 1x2, 2x2 and 4x2 MIMO configurations are calculated according to 3GPP
TS36.101, annex B2.3.2.

A.11.5 HST3 Tunnel Multi Antennas

See Chapter A.14.3, "HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL
+UL)", on page 251.
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A.12 WIMAX-MIMO Standards

A.12.1 ITU Pedestrian B 3

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0,9 4,9 8 7,8 23,9

Delay [ns]: 0 200 800 1200 2300 3700

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Speed
[km/h]:

3 3 3 3 3 3

Table A-28: MIMO Parameter - High Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1 1 0 -0,1468 0,4156 0,0303 0,7064 -0,298 -0,0911

 -0,1468 -0,4156 1 0 0,28913 -0,1163 0,0303 0,7064

 0,0303 -0,7064 0,28913 0,11629 1 0 -0,1468 0,4156

 -0,298 0,09111 0,0303 -0,7064 -0,1468 -0,4156 1 0

TAP 2 1 0 -0,4467 0,4227 -0,4007 -0,6073 0,4357 0,10191

 -0,4467 -0,4227 1 0 -0,0777 0,44066 -0,4007 -0,6073

 -0,4007 0,6073 -0,0777 -0,4407 1 0 -0,4467 0,4227

 0,4357 -0,1019 -0,4007 0,6073 -0,4467 -0,4227 1 0

TAP 3 1 0 -0,2906 0,4347 -0,6664 0,262 0,07976 -0,3658

 -0,2906 -0,4347 1 0 0,30755 0,21355 -0,6664 0,262

 -0,6664 -0,262 0,30755 -0,2135 1 0 -0,2906 0,4347

 0,07976 0,36582 -0,6664 -0,262 -0,2906 -0,4347 1 0

TAP 4 1 0 -0,4273 0,4259 -0,6522 0,2088 0,18976 -0,367

 -0,4273 -0,4259 1 0 0,36761 0,18855 -0,6522 0,2088

 -0,6522 -0,2088 0,36761 -0,1886 1 0 -0,4273 0,4259

 0,18976 0,36699 -0,6522 -0,2088 -0,4273 -0,4259 1 0

TAP 5 1 0 -0,7026 -0,3395 -0,5378 -0,4866 0,21266 0,52447
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 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

 -0,7026 0,3395 1 0 0,54306 0,1593 -0,5378 -0,4866

 -0,5378 0,4866 0,54306 -0,1593 1 0 -0,7026 -0,3395

 0,21266 -0,5245 -0,5378 0,4866 -0,7026 0,3395 1 0

TAP 6 1 0 -0,45 0,4222 -0,4564 -0,5655 0,44413 0,06178

 -0,45 -0,4222 1 0 -0,0334 0,44717 -0,4564 -0,5655

 -0,4564 0,5655 -0,0334 -0,4472 1 0 -0,45 0,4222

 0,44413 -0,0618 -0,4564 0,5655 -0,45 -0,4222 1 0

Table A-29: MIMO Parameter - Medium Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1-
TAP 6

1 0 0 0 0,7264 0 0 0

 0 0 1 0 0 0 -0,7264 0

 0,7264 0 0 0 1 0 0 0

 0 0 -0,7264 0 0 0 1 0

Table A-30: MIMO Parameter - Low Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1 1 0 0 0 0,02201 0,51313 0 0

 0 0 1 0 0 0 -0,022 -0,5131

 0,02201 -0,5131 0 0 1 0 0 0

 0 0 -0,022 0,51313 0 0 1 0

TAP 2 1 0 0 0 -0,2911 -0,4411 0 0

 0 0 1 0 0 0 0,29107 0,44114

 -0,2911 0,44114 0 0 1 0 0 0

 0 0 0,29107 -0,4411 0 0 1 0

TAP 3 1 0 0 0 -0,4841 0,19032 0 0

 0 0 1 0 0 0 0,48407 -0,1903

 -0,4841 -0,1903 0 0 1 0 0 0

 0 0 0,48407 0,19032 0 0 1 0

TAP 4 1 0 0 0 -0,4738 0,15167 0 0

 0 0 1 0 0 0 0,47376 -0,1517

 -0,4738 -0,1517 0 0 1 0 0 0
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 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

 0 0 0,47376 0,15167 0 0 1 0

TAP 5 1 0 0 0 -0,3907 -0,3535 0 0

 0 0 1 0 0 0 0,39066 0,35347

 -0,3907 0,35347 0 0 1 0 0 0

 0 0 0,39066 -0,3535 0 0 1 0

TAP 6 1 0 0 0 -0,3315 -0,4108 0 0

 0 0 1 0 0 0 0,33153 0,41078

 -0,3315 0,41078 0 0 1 0 0 0

 0 0 0,33153 -0,4108 0 0 1 0

A.12.2 ITU Vehicular A-60

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1 9 10 15 20

Delay [ns]: 0 310 710 1090 1730 2510

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Speed
[km/h]:

60 60 60 60 60 60

Table A-31: MIMO Parameter - High Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1 1 0 -0,2366 0,4312 0,6883 0,1211 -0,2151 0,26814

 -0,2366 -0,4312 1 0 -0,1106 -0,3254 0,6883 0,1211

 0,6883 -0,1211 -0,1106 0,32545 1 0 -0,2366 0,4312

 -0,2151 -0,2681 0,6883 -0,1211 -0,2366 -0,4312 1 0

TAP 2 1 0 0,1388 0,2343 -0,3508 -0,5926 0,09016 -0,1644

 0,1388 -0,2343 1 0 -0,1875 -6E-05 -0,3508 -0,5926

 -0,3508 0,5926 -0,1875 6E-05 1 0 0,1388 0,2343

 0,09016 0,16445 -0,3508 0,5926 0,1388 -0,2343 1 0
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 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 3 1 0 -0,6443 0,365 0,3884 -0,5604 -0,0457 0,50283

 -0,6443 -0,365 1 0 -0,4548 0,2193 0,3884 -0,5604

 0,3884 0,5604 -0,4548 -0,2193 1 0 -0,6443 0,365

 -0,0457 -0,5028 0,3884 0,5604 -0,6443 -0,365 1 0

TAP 4 1 0 -0,362 0,4331 0,1899 0,6795 -0,363 -0,1637

 -0,362 -0,4331 1 0 0,22555 -0,3282 0,1899 0,6795

 0,1899 -0,6795 0,22555 0,32822 1 0 -0,362 0,4331

 -0,363 0,16373 0,1899 -0,6795 -0,362 -0,4331 1 0

TAP 5 1 0 -0,7074 0,3372 -0,3933 -0,565 0,46874 0,26706

 -0,7074 -0,3372 1 0 0,0877 0,5323 -0,3933 -0,565

 -0,3933 0,565 0,0877 -0,5323 1 0 -0,7074 0,3372

 0,46874 -0,2671 -0,3933 0,565 -0,7074 -0,3372 1 0

TAP 6 1 0 -0,4405 0,4238 -0,4383 -0,58 0,43888 0,06974

 -0,4405 -0,4238 1 0 -0,0527 0,44124 -0,4383 -0,58

 -0,4383 0,58 -0,0527 -0,4412 1 0 -0,4405 0,4238

 0,43888 -0,0697 -0,4383 0,58 -0,4405 -0,4238 1 0

Table A-32: MIMO Parameter - Medium Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1-
TAP 6

1 0 0 0 0,7264 0 0 0

 0 0 1 0 0 0 -0,7264 0

 0,7264 0 0 0 1 0 0 0

 0 0 -0,7264 0 0 0 1 0

Table A-33: MIMO Parameter - Low Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1 1 0 0 0 0,49998 0,08797 0 0

 0 0 1 0 0 0 -0,5 -0,088

 0,49998 -0,088 0 0 1 0 0 0

 0 0 -0,5 0,08797 0 0 1 0

TAP 2 1 0 0 0 -0,2548 -0,4305 0 0

 0 0 1 0 0 0 0,25482 0,43046
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 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

 -0,2548 0,43046 0 0 1 0 0 0

 0 0 0,25482 -0,4305 0 0 1 0

TAP 3 1 0 0 0 0,28213 -0,4071 0 0

 0 0 1 0 0 0 -0,2821 0,40707

 0,28213 0,40707 0 0 1 0 0 0

 0 0 -0,2821 -0,4071 0 0 1 0

TAP 4 1 0 0 0 0,13794 0,49359 0 0

 0 0 1 0 0 0 -0,1379 -0,4936

 0,13794 -0,4936 0 0 1 0 0 0

 0 0 -0,1379 0,49359 0 0 1 0

TAP 5 1 0 0 0 -0,3907 -0,3535 0 0

 0 0 1 0 0 0 0,39066 0,35347

 -0,3907 0,35347 0 0 1 0 0 0

 0 0 0,39066 -0,3535 0 0 1 0

TAP 6 1 0 0 0 -0,3184 -0,4213 0 0

 0 0 1 0 0 0 0,31838 0,42131

 -0,3184 0,42131 0 0 1 0 0 0

 0 0 0,31838 -0,4213 0 0 1 0

A.13 1xEVDO Standards

According to 3GPP2 C.S0032-A v2.0

A.13.1 1xEVDO Chan. 1

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0
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 Path 1 Path 2

Freq Ratio: 0 0

Speed [km/h]: 8 8

A.13.2 1xEVDO Chan. 1 (Bd. 5, 11)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 15 15

A.13.3 1xEVDO Chan. 2

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 3

A.13.4 1xEVDO Chan. 2 (Bd. 5, 11)

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0
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 Path 1

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 6

A.13.5 1xEVDO Chan. 3

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 30

A.13.6 1xEVDO Chan. 3 (Bd. 5, 11)

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 58
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A.13.7 1xEVDO Chan. 4

 Path 1 Path 2 Path 3

Profile [Type] Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 3

Delay [ns]: 0 2000 14500

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0 0 0

Speed [km/h]: 100 100 100

A.13.8 1xEVDO Chan. 4 (Bd. 5, 11)

 Path 1 Path 2 Path 3

Profile [Type] Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 3

Delay [ns]: 0 2000 14500

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0 0 0

Speed [km/h]: 192 192 192

A.13.9 1xEVDO Chan. 5

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0
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 Path 1 Path 2

Freq Ratio: 0 0

Speed [km/h]: 0 0

A.13.10 1xEVDO Chan. 5 (Bd. 5, 11)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 0 0

A.14 3GPP/LTE High Speed Train

A.14.1 HST1 Open Space, HST1 Open Space (DL+UL)

3GPP TS25.141, annex D.4A "High Speed Train" and 3GPP TS36.141, annex B.3
"High Speed Train"

The HST DL+UL standards consider the downlink and the uplink. That is, if a doppler
shift occurs in the downlink, the mobile receiver synchronizes to that shifted frequency.
The uplink to the base station then results in a doppler shift enlarged by a factor based
on the sum of the DL and UL frequency.

 Path 1

Profile [Type] Pure Doppler

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: -
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 Path 1

Freq Ratio:  

Speed [km/h]: 350km/h

Dmin 50m

Ds 1000m

A.14.2 HST2 Tunnel Leaky Cable, HST2 Tunnel Leaky Cable (DL+UL)

3GPP TS25.141, annex D.4A "High Speed Train"

The HST DL+UL standards consider the downlink and the uplink. That is, if a doppler
shift occurs in the downlink, the mobile receiver synchronizes to that shifted frequency.
The uplink to the base station then results in a doppler shift enlarged by a factor based
on the sum of the DL and UL frequency.

 Path 1

Profile [Type] Rice

Loss [dB]: 10

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 1

Speed [km/h]: 300km/h

A.14.3 HST3 Tunnel Multi Antennas, HST3 Tunnel Multi Antennas (DL+UL)

3GPP TS25.141, annex D.4A "High Speed Train" and 3GPP TS36.141, annex B.3A
"High Speed Train"

The HST DL+UL standards consider the downlink and the uplink. That is, if a doppler
shift occurs in the downlink, the mobile receiver synchronizes to that shifted frequency.
The uplink to the base station then results in a doppler shift enlarged by a factor based
on the sum of the DL and UL frequency.

 Path 1

Profile [Type] Pure Doppler

Loss [dB]: 0
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 Path 1

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: -

Freq Ratio:  

Speed [km/h]: 300km/h

Dmin 2m

Ds 300m

A.15 3GPP/LTE Moving Propagation

A.15.1 Reference + Moving Channel

Table A-34: 3GPP TS 25.101, annex B2.3

 Path 1 Path 2

Profile [Type] Static Static

Loss [dB]: 0 0

Delay [ns]: 0 1… 6us

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 1 1

Speed [km/h]: 0 0

Period: 157,0796s = 2*PI/0.04

(Mean)-Delay: 3.5μs

A.15.2 ETU 200Hz Moving (UL Timing Adjustment, Scenario 1)

Table A-35: 3GPP TS36.141, annex B.4 "Moving Propagation Conditions"

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 1 1 1 0 0
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 Path 1 Path 2 Path 3 Path 4 Path 5

Delay [ns]: 0 50 120 200 230

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Doppler [Hz]:      

Speed [km/h]: 120 120 120 120 120

 Path 6 Path 7 Path 8 Path 9

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 3 5 7

Delay [ns]: 500 1600 2300 5000

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Doppler [Hz]:     

Speed [km/h]: 120 120 120 120

Period: 157,0796s = 2*PI/0.04

Amplitude: 5us = 10us/2

A.15.3 Pure Doppler Moving (UL Timing Adjustment, Scenario 2)

Table A-36: 3GPP TS36.141, annex B.4 "Moving Propagation Conditions"

 Path 1

Profile [Type] Pure Doppler

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Doppler [Hz]:  

Speed [km/h]: 350

Period: 48,33s = 2*PI/0.13

 

3GPP/LTE Moving Propagation



Predefined Fading SettingsR&S®SMW-B14/-K71/-K72/-K74/-K75

254User Manual 1175.6826.02 ─ 09

Amplitude: 5μs = 10μs/2

A.16 SCME Channel Models for MIMO OTA

The SCME models define 6 clusters characterized by the delay, the AoA/AoD, AS and
PAS shape.

The following antenna polarization and antenna pattern settings apply for all SCME
models.

Antenna Settings Polarization Distance (da) Antenna Pattern

Tx Cross 45° 0 Dipole

Rx Cross 90° 0 Isotropic

A.16.1 SCME Urban Micro-Cell Channel (UMi) 3 and 30 km/h

Tap Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Cluster  1   2  

Profile
[Type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 5.2 7 4.3 6.5 8.3

Delay [ns]: 0 5 10 285 290 295

Fine Delay
required:

0 0 0 0 0 0

AoA [°]:  0.7   -13.2  

AoD [°]:  6.6   14.1  

Tap Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Cluster  3   4  

Profile
[Type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 5.7 7.9 9.7 7.3 9.5 11.3

Delay [ns]: 205 210 215 660 665 670

Fine Delay
required:

0 0 0 0 0 0

AoA [°]:  146.1   -30.5  

AoD [°]:  50.8   38.4  
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Tap Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Cluster  5   6  

Profile
[Type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 9 11.2 13 11.4 13.6 15.4

Delay [ns]: 805 810 815 925 930 935

Fine Delay
required:

0 0 0 0 0 0

AoA [°]:  -11.4   -1.1  

AoD [°]:  6.7   40.3  

Delay Spread [ns]: 294

Cluster AS AoD / AS AoA [°]: 5 /35

Cluster PAS shape: Laplacian

Total AS AoD / AS AoA [°]: 18.2 /67.8

Mobile speed [km/h] / Direction of travel [°]: 3, 30 /120

XPR1) [dB]: 9

1) XPR = cross polarization power ratio in the selected propagation channel

A.16.2 SCME Urban Macro-Cell Channel (UMa) 3 and 30 km/h

Tap Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Cluster  1   2  

Profile
[Type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 5.2 7 5.2 7.4 9.2

Delay [ns]: 0 5 10 360 365 370

Fine Delay
required:

0 0 0 0 0 0

AoA [°]:  66   46  

AoD [°]:  82   81  

Tap Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Cluster  3   4  

Profile
[Type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh
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Tap Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Loss [dB]: 4.7 6.9 8.7 8.2 10.4 12.2

Delay [ns]: 255 260 265 1040 1045 1050

Fine Delay
required:

0 0 0 0 0 0

AoA [°]:  143   33  

AoD [°]:  80   99  

Tap Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Cluster  5   6  

Profile
[Type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 12.1 14.3 16.1 15.5 17.7 19.5

Delay [ns]: 2730 2735 2740 4600 4605 4610

Fine Delay
required:

0 0 0 0 0 0

AoA [°]:  -91   -19  

AoD [°]:  102   107  

Delay Spread [ns]: 839.5

Cluster AS AoD / AS AoA [°]: 2 / 35

Cluster PAS shape: Laplacian

Total AS AoD / AS AoA [°]: 7.8 / 62.6

Mobile speed [km/h] / Direction of travel [°]: 3, 30 / 120

XPR1) [dB]: 9

1) XPR = cross polarization power ratio in the selected propagation channel

A.17 Watterson Standards

A.17.1 Watterson I1

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watterson

Loss [dB]: 4.1 4.3 1.2 7.2 13.5
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 Path 1 Path 2 Path 3 Path 4 Path 5

Delay [ns]: 40000 40000 40000 290000 1139000

LogNormal off off off off off

Corr with off off off off off

Freq. Spread: 0.0073 0.0318 0.0272 0.144 0.34

Freq Shift
[Hz]:

0.0022 0.017 0.0094 0.0089 -0.167

Speed [km/h]:      

Tap 2: S(d) = 0,1 +/- 0,02

A.17.2 Watterson I2

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Gauss-Wat-
terson

Gauss-Wat-
terson

Gauss-Wat-
terson

Gauss-Wat-
terson

Gauss-Watter-
son

Gauss-Watter-
son

Loss [dB]: 4.1 5.5 1.7 5.9 17.6 12.6

Delay [ns]: 40000 40000 40000 290000 590000 1126000

LogNormal off off off off off off

Corr with off off off off off off

Freq.
Spread:

0.0064 0.0084 0.0153 0.18 0.334 0.336

Freq Shift
[Hz]:

-0.0008 0.0127 0.0071 0.0159 0.108 0.118

Speed
[km/h]:

      

Tap 3: S(d) = 0,1 +/- 0,02

A.17.3 Watterson I3

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watterson

Loss [dB]: 3.8 5.7 1.6 10.8 10.6

Delay [ns]: 445000 445000 445000 750000 750000

LogNormal off off off off off

Corr with off off off off off
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 Path 1 Path 2 Path 3 Path 4 Path 5

Freq. Spread: 0.034 0.032 0.0658 0.0104 0.013

Freq Shift
[Hz]:

0.0764 0.0134 0.0989 0.121 0.141

Speed [km/h]:      

 Path 6 Path 7 Path 8 Path 9

Profile [Type] Gauss-Watterson Gauss-Watterson Gauss-Watterson Gauss-Watterson

Loss [dB]: 7.7 12.9 10.4 8.5

Delay [ns]: 750000 1088000 1088000 1088000

LogNormal off off off off

Corr with off off off off

Freq. Spread: 0.0229 0.0149 0.0206 0.0335

Freq Shift [Hz]: 0.131 0.121 0.151 0.014

Speed [km/h]:     

Tap 6: S(d) = 1,0 +/- 0,1

A.18 802.11n-SISO Standards

These fading profiles are implemented as the IEEE 802.11n-MIMO models, expect
that:
● Correlation Path = Off
● Coefficient, % = 100
● Phase, deg = 0

See Chapter A.19, "802.11n-MIMO Standards", on page 258.

A.19 802.11n-MIMO Standards

According to IEEE 801.11-03/940r4

Rx Antenna Distance = 1

Tx Antenna Distance = 0.5

Distribution = Laplace

Profile = Bell Shape tgn Indoor, exception Model F, Path 3 where the Profile = Bell
Shape tgn Moving Vehicle

Speed = 1.2 km/h, exception Model F, Path 3 where Speed = 40 km/h
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A.19.1 Model A

Tap: Path 1

Cluster  

Profil [Typ] Bell Shape tgn Indoor

Loss [dB] 0

Delay [ns] 0

AoA 45

AS (A) 40

AoD 45

AS (D) 40

Speed [km/h] 1.2

A.19.2 Model B

Tap: Path 1 Path 2 Path 3  Path 4  

Cluster   1 2 1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

0 5.4 10.8 3.2 16.2 6.3

Delay [ns]: 0 10 20 20 30 30

AoA: 4.3 4.3 4.3 118.4 4.3 118.4

AS (A): 14.4 14.4 14.4 25.2 14.4 25.2

AoD: 225.1 225.1 225.1 106.5 225.1 106.5

AS (D): 14.4 14.4 14.4 25.4 14.4 25.4

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 5  Path 6 Path 7 Path 8 Path 9

Cluster 1 2     

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

21.7 9.4 12.5 15.6 18.7 21.8

Delay [ns]: 40 40 50 60 70 80
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Tap: Path 5  Path 6 Path 7 Path 8 Path 9

AoA: 4.3 118.4 118.4 118.4 118.4 118.4

AS (A): 14.4 25.2 25.2 25.2 25.2 25.2

AoD: 225.1 106.5 106.5 106.5 106.5 106.5

AS (D): 14.4 25.4 25.4 25.4 25.4 25.4

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

A.19.3 Model C

Tap: Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Cluster       

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

0 2.1 4.3 6.5 8.6 10.8

Delay [ns]: 0 10 20 30 40 50

AoA: 290.3 290.3 290.3 290.3 290.3 290.3

AS (A): 24.6 24.6 24.6 24.6 24.6 24.6

AoD: 13.5 13.5 13.5 13.5 13.5 13.5

AS (D): 24.7 24.7 24.7 24.7 24.7 24.7

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 7 Path 7 Path 8 Path 8 Path 9 Path 9

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

13 5 15.2 7.2 17.3 9.3

Delay [ns]: 60 60 70 70 80 80

AoA: 290.3 332.3 290.3 332.3 290.3 332.3

AS (A): 24.6 22.4 24.6 22.4 24.6 22.4

AoD: 13.5 56.4 13.5 56.4 13.5 56.4

AS (D): 24.7 22.5 24.7 22.5 24.7 22.5
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Tap: Path 7 Path 7 Path 8 Path 8 Path 9 Path 9

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 10 Path 10 Path 11 Path 12 Path 13 Path 14

Cluster 1 2     

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

19.5 11.5 13.7 15.8 18 20.2

Delay [ns]: 90 90 110 140 170 200

AoA: 290.3 332.3 332.3 332.3 332.3 332.3

AS (A): 24.6 22.4 22.4 22.4 22.4 22.4

AoD: 13.5 56.4 56.4 56.4 56.4 56.4

AS (D): 24.7 22.5 22.5 22.5 22.5 22.5

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

A.19.4 Model D

Tap: Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Cluster       

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

0 0.9 1.7 2.6 3.5 4.3

Delay [ns]: 0 10 20 30 40 50

AoA: 158.9 158.9 158.9 158.9 158.9 158.9

AS (A): 27.7 27.7 27.7 27.7 27.7 27.7

AoD: 332.1 332.1 332.1 332.1 332.1 332.1

AS (D): 27.4 27.4 27.4 27.4 27.4 27.4

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace
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Tap: Path 7 Path 8 Path 9 Path 10 Path 11  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

5.2 6.1 6.9 7.8 9 6.6

Delay [ns]: 60 70 80 90 110 110

AoA: 158.9 158.9 158.9 158.9 158.9 320.2

AS (A): 27.7 27.7 27.7 27.7 27.7 31.4

AoD: 332.1 332.1 332.1 332.1 332.1 49.3

AS (D): 27.4 27.4 27.4 27.4 27.4 32.1

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 12  Path 13  Path 14  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

11.1 9.5 13.7 12.1 16.3 14.7

Delay [ns]: 140 140 170 170 200 200

AoA: 158.9 320.2 158.9 320.2 158.9 320.2

AS (A): 27.7 31.4 27.7 31.4 27.7 31.4

AoD: 332.1 49.3 332.1 49.3 332.1 49.3

AS (D): 27.4 32.1 27.4 32.1 27.4 32.1

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15   Path 16   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

19.3 17.4 18.8 23.2 21.9 23.2

Delay [ns]: 240 240 240 290 290 290

AoA: 158.9 320.2 276.1 158.9 320.2 276.1
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Tap: Path 15   Path 16   

AS (A): 27.7 31.4 37.4 27.7 31.4 37.4

AoD: 332.1 49.3 275.9 332.1 49.3 275.9

AS (D): 27.4 32.1 36.8 27.4 32.1 36.8

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 17  Path 18

Cluster 2 3  

Profil [Typ] Bell Shape tgn Indoor Bell Shape tgn Indoor Bell Shape tgn
Indoor

(Relative) Loss
[dB]:

25.5 25.2 26.7

Delay [ns]: 340 340 390

AoA: 320.2 276.1 276.1

AS (A): 31.4 37.4 37.4

AoD: 49.3 275.9 275.9

AS (D): 32.1 36.8 36.8

Speed [km/h] 1.2 1.2 1.2

Distribution Laplace Laplace Laplace

A.19.5 Model E

Tap: Path 1 Path 2 Path 3 Path 4 Path 5  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Moving
Vehicle

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

2.6 3 3.5 3.9 4.5 1.8

Delay [ns]: 0 10 20 30 50 50

AoA: 163.7 163.7 163.7 163.7 163.7 251.8

AS (A): 35.8 35.8 35.8 35.8 35.8 41.6

AoD: 105.6 105.6 105.6 105.6 105.6 293.1

AS (D): 36.1 36.1 36.1 36.1 36.1 42.5
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Tap: Path 1 Path 2 Path 3 Path 4 Path 5  

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 6  Path 7  Path 8  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

5.6 3.2 6.9 4.5 8.2 5.8

Delay [ns]: 80 80 110 110 140 140

AoA: 163.7 251.8 163.7 251.8 163.7 251.8

AS (A): 35.8 41.6 35.8 41.6 35.8 41.6

AoD: 105.6 293.1 105.6 293.1 105.6 293.1

AS (D): 36.1 42.5 36.1 42.5 36.1 42.5

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 9   Path 10   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

9.8 7.1 7.9 11.7 9.9 9.6

Delay [ns]: 180 180 180 230 230 230

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace
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Tap: Path 11   Path 12   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

13.9 10.3 14.2 16.1 14.3 13.8

Delay [ns]: 280 280 280 330 330 330

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 13   Path 14   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

18.3 14.7 18.6 20.5 18.7 18.1

Delay [ns]: 380 380 380 430 430 430

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15    Path 16  Path 17 Path 18

Cluster 1 2 3 4 2 4 4 4

Profil [Typ] Bell
Shape tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

(Relative)
Loss [dB]:

22.9 19.9 22.8 20.6 22.4 20.5 20.7 24.6

Delay [ns]: 490 490 490 490 560 560 640 730
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Tap: Path 15    Path 16  Path 17 Path 18

AoA: 163.7 251.8 80 182 251.8 182 182 182

AS (A): 35.8 41.6 37.4 40.3 41.6 40.3 40.3 40.3

AoD: 105.6 293.1 61.9 275.7 293.1 275.7 275.7 275.7

AS (D): 36.1 42.5 38 38.7 42.5 38.7 38.7 38.7

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2 1.2 1.2

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace Laplace Laplace

A.19.6 Model F

Tap: Path 1 Path 2 Path 3 Path 4 Path 5  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

3.3 3.6 3.9 4.2 4.6 1.8

Delay [ns]: 0 10 20 30 50 50

AoA: 315.1 315.1 315.1 315.1 315.1 180.4

AS (A): 48 48 48 48 48 55

AoD: 56.2 56.2 56.2 56.2 56.2 183.7

AS (D): 41.6 41.6 41.6 41.6 41.6 55.2

Speed
[km/h]

1.2 1.2 40 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 6  Path 7  Path 8  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

5.3 2.8 6.2 3.5 7.1 4.4

Delay [ns]: 80 80 110 110 140 140

AoA: 315.1 180.4 315.1 180.4 315.1 180.4

AS (A): 48 55 48 55 48 55

AoD: 56.2 183.7 56.2 183.7 56.2 183.7

AS (D): 41.6 55.2 41.6 55.2 41.6 55.2
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Tap: Path 6  Path 7  Path 8  

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 9   Path 10   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

8.2 5.3 5.7 9.5 7.4 6.7

Delay [ns]: 180 180 180 230 230 230

AoA: 315.1 180.4 74.7 315.1 180.4 74.7

AS (A): 48 55 42 48 55 42

AoD: 56.2 183.7 153 56.2 183.7 153

AS (D): 41.6 55.2 47.4 41.6 55.2 47.4

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 11   Path 12   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

(Relative)
Loss [dB]:

11 7 10.4 12.5 10.3 9.6

Delay [ns]: 280 280 280 330 330 330

AoA: 315.1 180.4 74.7 315.1 180.4 74.7

AS (A): 48 55 42 48 55 42

AoD: 56.2 183.7 153 56.2 183.7 153

AS (D): 41.6 55.2 47.4 41.6 55.2 47.4

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace
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Tap: Path 13    Path 14    

Cluster 1 2 3 4 1 2 3 4

Profil [Typ] Bell
Shape
tgn
Indoor

Bell
Shape tgn
Indoor

Bell
Shape
tgn Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

(Relative)
Loss [dB]:

14.3 10.4 14.1 8.8 16.7 13.8 12.7 13.3

Delay [ns]: 400 400 400 400 490 490 490 490

AoA: 315.1 180.4 74.7 251.5 315.1 180.4 74.7 251.5

AS (A): 48 55 42 28.6 48 55 42 28.6

AoD: 56.2 183.7 153 112.5 56.2 183.7 153 112.5

AS (D): 41.6 55.2 47.4 27.2 41.6 55.2 47.4 27.2

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2 1.2 1.2

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15     

Cluster 1 2 3 4 5

Profil [Typ] Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative) Loss [dB]: 19.9 15.7 18.5 18.7 12.9

Delay [ns]: 600 600 600 600 600

AoA: 315.1 180.4 74.7 251.5 68.5

AS (A): 48 55 42 28.6 30.7

AoD: 56.2 183.7 153 112.5 291

AS (D): 41.6 55.2 47.4 27.2 33

Speed [km/h] 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace

Tap: Path 16  Path 17 Path 18

Cluster 2 5 6 6

Profil [Typ] Bell Shape tgn
Indoor

Bell Shape tgn
Indoor

Bell Shape tgn
Indoor

Bell Shape tgn
Indoor

(Relative) Loss [dB]: 19.9 14.2 16.3 21.2

Delay [ns]: 730 730 880 1050

AoA: 180.4 68.5 246.2 246.2
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Tap: Path 16  Path 17 Path 18

AS (A): 55 30.7 38.2 38.2

AoD: 183.7 291 62.3 62.3

AS (D): 55.2 33 38 38

Speed [km/h] 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace

A.20 802.11ac-MIMO Standards

The 802.11ac-MIMO channel models are conform for channel bandwidth ≤ 40 MHz.

According to IEEE 801.11-03/940r4

Rx Antenna Distance = 1

Tx Antenna Distance = 0.5

Distribution = Laplace

Profile = Bell Shape tgn Indoor, exception Model F, Path 3 where the Profile = Bell
Shape tgn Moving Vehicle

Speed = 0.089 km/h, exception Model F, Path 3 where Speed = 40 km/h

A.20.1 Model A (≤ 40 MHz)

Tap: Path 1

Cluster  

Profil [Typ] Bell Shape tgn Indorr

Loss [dB] 0

Delay [ns] 0

AoA 45

AS (A) 40

AoD 45

AS (D) 40

Speed [km/h] 0.089
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A.20.2 Model B (≤ 40 MHz)

Tap: Path 1 Path 2 Path 3  Path 4  

Cluster   1 2 1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

0 5.4 10.8 3.2 16.2 6.3

Delay [ns]: 0 10 20 20 30 30

AoA: 4.3 4.3 4.3 118.4 4.3 118.4

AS (A): 14.4 14.4 14.4 25.2 14.4 25.2

AoD: 225.1 225.1 225.1 106.5 225.1 106.5

AS (D): 14.4 14.4 14.4 25.4 14.4 25.4

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 5  Path 6 Path 7 Path 8 Path 9

Cluster 1 2     

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

21.7 9.4 12.5 15.6 18.7 21.8

Delay [ns]: 40 40 50 60 70 80

AoA: 4.3 118.4 118.4 118.4 118.4 118.4

AS (A): 14.4 25.2 25.2 25.2 25.2 25.2

AoD: 225.1 106.5 106.5 106.5 106.5 106.5

AS (D): 14.4 25.4 25.4 25.4 25.4 25.4

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

A.20.3 Model C (≤ 40 MHz)

Tap: Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Cluster       

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr
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Tap: Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

(Relative)
Loss [dB]:

0 2.1 4.3 6.5 8.6 10.8

Delay [ns]: 0 10 20 30 40 50

AoA: 290.3 290.3 290.3 290.3 290.3 290.3

AS (A): 24.6 24.6 24.6 24.6 24.6 24.6

AoD: 13.5 13.5 13.5 13.5 13.5 13.5

AS (D): 24.7 24.7 24.7 24.7 24.7 24.7

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 7 Path 7 Path 8 Path 8 Path 9 Path 9

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

13 5 15.2 7.2 17.3 9.3

Delay [ns]: 60 60 70 70 80 80

AoA: 290.3 332.3 290.3 332.3 290.3 332.3

AS (A): 24.6 22.4 24.6 22.4 24.6 22.4

AoD: 13.5 56.4 13.5 56.4 13.5 56.4

AS (D): 24.7 22.5 24.7 22.5 24.7 22.5

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 10 Path 10 Path 11 Path 12 Path 13 Path 14

Cluster 1 2     

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

19.5 11.5 13.7 15.8 18 20.2

Delay [ns]: 90 90 110 140 170 200

AoA: 290.3 332.3 332.3 332.3 332.3 332.3

AS (A): 24.6 22.4 22.4 22.4 22.4 22.4

AoD: 13.5 56.4 56.4 56.4 56.4 56.4

AS (D): 24.7 22.5 22.5 22.5 22.5 22.5
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Tap: Path 10 Path 10 Path 11 Path 12 Path 13 Path 14

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

A.20.4 Model D (≤ 40 MHz)

Tap: Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Cluster       

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

0 0.9 1.7 2.6 3.5 4.3

Delay [ns]: 0 10 20 30 40 50

AoA: 158.9 158.9 158.9 158.9 158.9 158.9

AS (A): 27.7 27.7 27.7 27.7 27.7 27.7

AoD: 332.1 332.1 332.1 332.1 332.1 332.1

AS (D): 27.4 27.4 27.4 27.4 27.4 27.4

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 7 Path 8 Path 9 Path 10 Path 11  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

5.2 6.1 6.9 7.8 9 6.6

Delay [ns]: 60 70 80 90 110 110

AoA: 158.9 158.9 158.9 158.9 158.9 320.2

AS (A): 27.7 27.7 27.7 27.7 27.7 31.4

AoD: 332.1 332.1 332.1 332.1 332.1 49.3

AS (D): 27.4 27.4 27.4 27.4 27.4 32.1

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace
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Tap: Path 12  Path 13  Path 14  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

11.1 9.5 13.7 12.1 16.3 14.7

Delay [ns]: 140 140 170 170 200 200

AoA: 158.9 320.2 158.9 320.2 158.9 320.2

AS (A): 27.7 31.4 27.7 31.4 27.7 31.4

AoD: 332.1 49.3 332.1 49.3 332.1 49.3

AS (D): 27.4 32.1 27.4 32.1 27.4 32.1

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15   Path 16   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

19.3 17.4 18.8 23.2 21.9 23.2

Delay [ns]: 240 240 240 290 290 290

AoA: 158.9 320.2 276.1 158.9 320.2 276.1

AS (A): 27.7 31.4 37.4 27.7 31.4 37.4

AoD: 332.1 49.3 275.9 332.1 49.3 275.9

AS (D): 27.4 32.1 36.8 27.4 32.1 36.8

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 17  Path 18

Cluster 2 3  

Profil [Typ] Bell Shape tgn Indorr Bell Shape tgn Indorr Bell Shape tgn
Indorr

(Relative) Loss
[dB]:

25.5 25.2 26.7

Delay [ns]: 340 340 390

AoA: 320.2 276.1 276.1
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Tap: Path 17  Path 18

AS (A): 31.4 37.4 37.4

AoD: 49.3 275.9 275.9

AS (D): 32.1 36.8 36.8

Speed [km/h] 0.089 0.089 0.089

Distribution Laplace Laplace Laplace

A.20.5 Model E (≤ 40 MHz)

Tap: Path 1 Path 2 Path 3 Path 4 Path 5  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

2.6 3 3.5 3.9 4.5 1.8

Delay [ns]: 0 10 20 30 50 50

AoA: 163.7 163.7 163.7 163.7 163.7 251.8

AS (A): 35.8 35.8 35.8 35.8 35.8 41.6

AoD: 105.6 105.6 105.6 105.6 105.6 293.1

AS (D): 36.1 36.1 36.1 36.1 36.1 42.5

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 6  Path 7  Path 8  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

5.6 3.2 6.9 4.5 8.2 5.8

Delay [ns]: 80 80 110 110 140 140

AoA: 163.7 251.8 163.7 251.8 163.7 251.8

AS (A): 35.8 41.6 35.8 41.6 35.8 41.6

AoD: 105.6 293.1 105.6 293.1 105.6 293.1

AS (D): 36.1 42.5 36.1 42.5 36.1 42.5
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Tap: Path 6  Path 7  Path 8  

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 9   Path 10   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

9.8 7.1 7.9 11.7 9.9 9.6

Delay [ns]: 180 180 180 230 230 230

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 11   Path 12   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

13.9 10.3 14.2 16.1 14.3 13.8

Delay [ns]: 280 280 280 330 330 330

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

802.11ac-MIMO Standards



Predefined Fading SettingsR&S®SMW-B14/-K71/-K72/-K74/-K75

276User Manual 1175.6826.02 ─ 09

Tap: Path 13   Path 14   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

18.3 14.7 18.6 20.5 18.7 18.1

Delay [ns]: 380 380 380 430 430 430

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15    Path 16  Path 17 Path 18

Cluster 1 2 3 4 2 4 4 4

Profil [Typ] Bell
Shape tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn Indorr

Bell
Shape
tgn
Indorr

(Relative)
Loss [dB]:

22.9 19.9 22.8 20.6 22.4 20.5 20.7 24.6

Delay [ns]: 490 490 490 490 560 560 640 730

AoA: 163.7 251.8 80 182 251.8 182 182 182

AS (A): 35.8 41.6 37.4 40.3 41.6 40.3 40.3 40.3

AoD: 105.6 293.1 61.9 275.7 293.1 275.7 275.7 275.7

AS (D): 36.1 42.5 38 38.7 42.5 38.7 38.7 38.7

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089 0.089 0.089

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace Laplace Laplace
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A.20.6 Model F (≤ 40 MHz)

Tap: Path 1 Path 2 Path 3 Path 4 Path 5  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Moving
Vehicle

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

3.3 3.6 3.9 4.2 4.6 1.8

Delay [ns]: 0 10 20 30 50 50

AoA: 315.1 315.1 315.1 315.1 315.1 180.4

AS (A): 48 48 48 48 48 55

AoD: 56.2 56.2 56.2 56.2 56.2 183.7

AS (D): 41.6 41.6 41.6 41.6 41.6 55.2

Speed
[km/h]

0.089 0.089 40 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 6  Path 7  Path 8  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

5.3 2.8 6.2 3.5 7.1 4.4

Delay [ns]: 80 80 110 110 140 140

AoA: 315.1 180.4 315.1 180.4 315.1 180.4

AS (A): 48 55 48 55 48 55

AoD: 56.2 183.7 56.2 183.7 56.2 183.7

AS (D): 41.6 55.2 41.6 55.2 41.6 55.2

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 9   Path 10   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

8.2 5.3 5.7 9.5 7.4 6.7
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Tap: Path 9   Path 10   

Delay [ns]: 180 180 180 230 230 230

AoA: 315.1 180.4 74.7 315.1 180.4 74.7

AS (A): 48 55 42 48 55 42

AoD: 56.2 183.7 153 56.2 183.7 153

AS (D): 41.6 55.2 47.4 41.6 55.2 47.4

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 11   Path 12   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

(Relative)
Loss [dB]:

11 7 10.4 12.5 10.3 9.6

Delay [ns]: 280 280 280 330 330 330

AoA: 315.1 180.4 74.7 315.1 180.4 74.7

AS (A): 48 55 42 48 55 42

AoD: 56.2 183.7 153 56.2 183.7 153

AS (D): 41.6 55.2 47.4 41.6 55.2 47.4

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 13    Path 14    

Cluster 1 2 3 4 1 2 3 4

Profil [Typ] Bell
Shape
tgn Indorr

Bell
Shape tgn
Indorr

Bell
Shape
tgn Indorr

Bell
Shape
tgn Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn
Indorr

(Relative)
Loss [dB]:

14.3 10.4 14.1 8.8 16.7 13.8 12.7 13.3

Delay [ns]: 400 400 400 400 490 490 490 490

AoA: 315.1 180.4 74.7 251.5 315.1 180.4 74.7 251.5

AS (A): 48 55 42 28.6 48 55 42 28.6

AoD: 56.2 183.7 153 112.5 56.2 183.7 153 112.5

AS (D): 41.6 55.2 47.4 27.2 41.6 55.2 47.4 27.2
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Tap: Path 13    Path 14    

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089 0.089 0.089

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15     

Cluster 1 2 3 4 5

Profil [Typ] Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative) Loss [dB]: 19.9 15.7 18.5 18.7 12.9

Delay [ns]: 600 600 600 600 600

AoA: 315.1 180.4 74.7 251.5 68.5

AS (A): 48 55 42 28.6 30.7

AoD: 56.2 183.7 153 112.5 291

AS (D): 41.6 55.2 47.4 27.2 33

Speed [km/h] 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace

Tap: Path 16  Path 17 Path 18

Cluster 2 5 6 6

Profil [Typ] Bell Shape tgn
Indorr

Bell Shape tgn
Indorr

Bell Shape tgn
Indorr

Bell Shape tgn
Indorr

(Relative) Loss [dB]: 19.9 14.2 16.3 21.2

Delay [ns]: 730 730 880 1050

AoA: 180.4 68.5 246.2 246.2

AS (A): 55 30.7 38.2 38.2

AoD: 183.7 291 62.3 62.3

AS (D): 55.2 33 38 38

Speed [km/h] 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace

A.21 802.11ac-SISO Standards

These fading profiles are implemented as the IEEE 802.11ac-MIMO models, expect
that:
● Correlation Path = Off
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● Coefficient, % = 100
● Phase, deg = 0

See Chapter A.20, "802.11ac-MIMO Standards", on page 269.

A.22 802.11p Channel Models

According to C2C-CC TF Antennae & Wireless Performance – Whitepaper Vs 1.0

● Fading Profile = Custom
● Doppler Shape = Rayleigh
● Bandwidth = 2*abs(fd)

● Frequency Offset = 0 Hz
● for fd > 0:

– Lower Cutoff Frequency = 0
– Upper Cutoff Frequency = fd
for fd < 0:
– Lower CutOff Frequency = -fd
– Upper CutOff Frequency = 0

A.22.1 Rural LOS

This channel model is intended primarily as a reference result. It applies in very open
environments where other vehicles, buildings and large fences are absent.

 Path 1 Path 2 Path 3

Profile [Type] Static Custom Custom

(Relative) Loss
[dB]:

0 14 17

Delay [ns]: 0 83 183

fD [Hz] 0 492 -295

A.22.2 Urban Approaching LOS

Two vehicles approaching each other in an urban setting with buildings nearby.

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Static Custom Custom Custom

(Relative)
Loss [dB]:

0 8 10 15
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 Path 1 Path 2 Path 3 Path 4

Delay [ns]: 0 117 183 333

fD [Hz] 0 236 -157 492

A.22.3 Urban Crossing NLOS

Two vehicles approaching an Urban blind intersection with other traffic present. Build-
ings/fences present on all corners.

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Static Custom Custom Custom

(Relative)
Loss [dB]:

0 3 5 10

Delay [ns]: 0 267 400 533

fD [Hz] 0 295 -98 591

A.22.4 Highway LOS

Two cars following each other on Multi-lane inter-region roadways such as German
autobahns and USA Interstates. Signs, overpasses, hill-sides and other traffic present.

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Static Custom Custom Custom

(Relative)
Loss [dB]:

0 10 15 20

Delay [ns]: 0 100 167 500

fD [Hz] 0 689 -492 886

A.22.5 Highway NLOS

As for Highway LOS but with occluding trucks present between the vehicles.

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Static Custom Custom Custom

(Relative)
Loss [dB]:

0 2 5 7

Delay [ns]: 0 200 433 700

fD [Hz] 0 689 -492 886
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B Antenna Pattern File Format
Antenna pattern files are xml files in the Rohde&Schwarz proprietary antenna pattern
file format. These files use the predefined file extension *.ant_pat. They describe
the antenna pattern as an array with typical resolutions of 1 to 5 degree for both the
elevation and azimuth angels. Antenna pattern files contain the loss values for a given
azimuth and elevation pair.

For an isotropic antenna for instance, that radiates the energy equally in all directions,
the array elements are all 0 dB.

Example: Antenna with three sectors (3Sectors.ant_pat) - extract
The following is an examples of the file format. It shows an extract of the description of
an antenna pattern with three sectors, as this is specified by 3GPP TR 25.996.
According to this specification, the 3 sector antenna pattern should be used for each
sector. The antenna pattern is specified by the following equation:

A (Θ) = -min [12(Θ/Θ3dB)2, Am]

Where:
● - 180°≤Θ≤180° is the angle between the direction of interest and the boresight of

the antenna
● Θ3dB is the 3dB beamwidth in degrees

● Am is the maximum attenuation

For the 3 sector scenario Θ = 70 deg and Am = 40 dB.

Note: The antenna pattern files define the antenna power and not the antenna gain.
<?xml version="1.0" encoding="ISO-8859-1"?>
<antenna_pattern>
  <antenna_descr count="1">
    <antenna id="1" RollAxis_X_offset="0" PitchAxis_Y_offset="0" 
                    YawAxis_Z_offset="0" Yaw_offset="0" 
                    Pitch_offset="0" Roll_offset="0"/>    
 </antenna_descr>
    <az_res> 1.00000000e+000 </az_res>
    <elev_res> 1.00000000e+000 </elev_res>
 <data>
     -179.5,-178.5,-177.5,...   -89.5,   -88.5,   -87.5,   -86.5,...178.5,180.5
-89.5,   40,    40,    40,...3.92e+01,3.84e+01,3.75e+01,3.66e+01,...   40,40
  </data>
</antenna_pattern>

The Table B-1 describes the used tags and parameters.

Table B-1: Format of *.ant_pat file

Container Tag name Parameter Description

<antenna_pattern>   Defines antenna pattern File

<antenna_descr>   Contains the descriptions of the antennas
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Container Tag name Parameter Description

  <count> Number of antenna patterns; Value = 1 always

 <antenna>  Descriptions of the individual antenna

  <id> Antenna identification number

  <YawAxis_Z_offset>

<PitchAxis_Y_offset>

<RollAxis_X_offset>

(currently not used but reserved for future use)

Position shift of the antenna along the X/Y/Z axis with
respect to the center of gravity of the body

Value in meters

  <Yaw_offset>

<Pitch_offset>

<Roll_offset>

(currently not used but reserved for future use)

Angular shift of the antenna along the X/Y/Z axis of the
to the body

Value in degrees

<az_res>   Resolution of the columns in the data section

value in degrees integer divider of 360

<elev_res>   Resolution of the rows in the data section

value in degrees integer divider of 180

<data>   Represents the power response of the antenna; the
power loss values are in dB (between 0 and 40)
The file has to contain for every pattern:
● [1 + 360/<az_res>] columns
● [1 + 180/<elev_res>] rows
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